
Учреждение образования 
«Белорусский государственный университет культуры и искусств» 

 
Факультет культурологии и социально-культурной деятельности 

Кафедра информационных технологий в культуре 
 

 

СОГЛАСОВАНО СОГЛАСОВАНО 
Заведующий кафедрой 
 
_______________ Т.С. Жилинская 

Декан факультета 
 
_______________ Н.Е. Шелупенко 

«___»__________ 2022 г. «___»______________ 2022 г. 
 
 
 
 

УЧЕБНО-МЕТОДИЧЕСКИЙ КОМПЛЕКС  
ПО УЧЕБНОЙ ДИСЦИПЛИНЕ 

 
 

ДИЗАЙН И КОМПЬЮТЕРНЫЕ ТЕХНОЛОГИИ  
В ДЕКОРАТИВНО-ПРИКЛАДНОМ ИСКУССТВЕ 

 
для специальности 1-15 02 01 Декоративно-прикладное искусство (по 

направлениям), направлению специальности 1-15 02 01-07 Декоративно-
прикладное искусство (реставрация изделий) 

 
 
Составители: 
Н. Г. Гончарик, старший преподаватель кафедры информационных 
технологий в культуре; 
М. М. Чудук, преподаватель кафедры информационных технологий в 
культуре 
 
 
 
Рассмотрено и утверждено на заседании 
Совета университета 18.01.2022г. 
протокол № 6 
 
 

Минск 
2021  

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



СОСТАВИТЕЛЬ:  

Н. Г. Гончарик, старший преподаватель кафедры информационных 

технологий в культуре учреждения образования ―Белорусский 

государственный университет культуры и искусств‖; 

М. М. Чудук, преподаватель кафедры информационных технологий в 

культуре учреждения образования ―Белорусский государственный 

университет культуры и искусств‖. 

РЕЦЕНЗЕНТЫ: 

Г. Ф. Шауро, заведующий кафедрой народного декоративно-

прикладного искусства учреждения образования «Белорусский 

государственный университет культуры и искусств», доктор 

искусствоведения. 

В. С. Якимович, доцент кафедры высшей математики, БНТУ, кандидат 
пед.наук, доцент. 
 

Рекомендован к утверждению в качестве учебной: 

кафедрой информационных технологий в культуре учреждения 

образования «Белорусский государственный университет культуры и 

искусств» (протокол № 5 от 21.12.2021 г.) 

 

президиумом научно-методического совета учреждения образования 

―Белорусский государственный университет культуры и искусств― 

 (протокол №___ от ____________2021). 

  

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 

Учебно-методический комплекс по дисциплине «Дизайн и 

компьютерные технологии в декоративно-прикладном искусстве» 

представляет собой совокупность учебно-методических материалов, 

необходимых и достаточных для организации учебного процесса по 

дисциплине, предназначен для эффективного освоения студентами учебного 

материала, входящего в основную образовательную программу, выполнен на 

основе научного опыта по разработке УМК. Учебный материал 

систематизирован в удобной и приемлемой для усвоения форме. 

Методическими особенностями учебно-методического комплекса 

является комплексный подход к организации и внедрения информационных 

технологий в профессиональную область. 

Учебно-методический комплекс дисциплины «Дизайн и компьютерные 

технологии в декоративно-прикладном искусстве» ориентирован на 

понимание и решение студентами задач, связанных с проектной 

деятельностью, в результате которой студенты должны: 

− усвоить базовые знания в области информационных технологий и 

автоматизированных информационных систем, применяемых в дизайне 

графического продукта; 

− уметь применять компьютерные программы при разработке модели 

декоративного изделия. 

УМК включает теоретический, практический разделы, раздел контроля 

знаний и вспомогательный раздел. Теоретический раздел состоит из 

конспектов лекционного материала по темам программы. Практический 

раздел содержит задания и методику выполнения лабораторных работ, 

задания к семинарским занятиям. В разделе контроля знаний находятся 

задания для самостоятельной контролируемой работы, вопросы к итоговому 

контролю. Вспомогательный раздел включает содержание учебного 

материала образовательной программы, учебно-методические карты 

дисциплины.  
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1 ТЕОРЕТИЧЕСКИЙ РАЗДЕЛ 

Лекция 1 

Тема 1 . Дизайн как художественно-проектная деятельность. 

Дизайн − относительно молодой и быстро развивающийся 

синтетический вид творческой формообразующей деятельности, а также 

сфера проектного мышления, все более востребованного современной 

культурой. Границы дизайна все больше уходят от проектирования 

предметного мира, распространяют свои приемы в ландшафтное 

проектирование, вебдизайн, рекламные, имиджевые проекты [15]. 

Теория дизайна на основе идеи художественного конструирования, 

сближающая дизайн с искусством (в его классической интерпретации), не 

оправдывает себя в новых социокультурных и экономических условиях. 

Дизайн не сводится к конструированию предметных форм, не отражает 

действительность в художественных образах, не является разновидностью 

общественного сознания и не классифицируется через принадлежность к 

материальному или идеальному. Классическая эстетика, сформировавшаяся в 

Новое время, основанная на ценностной оппозиции «прекрасное − 

безобразное» и сопоставляющая тот или иной продукт с идеалом, уходит в 

прошлое и тоже не может служить необходимой методологической базой для 

технической эстетики в случае оценки продуктов дизайна. Классические 

стилевые практики, задававшие более-менее жесткую систему формальных 

требований, уходят в прошлое. Во главу угла ставятся оригинальность, 

распознаваемость, инновационность, критерии зачастую субъективны либо 

размыты, а также экономическая и пользовательская эффективность, 

позволяющие в ряде случаев целенаправленно использовать художественные 

и внехудожественные приемы. К примеру, непозволительный для высокого 

искусства китч, будучи использованным в графическом или костюмном 

дизайне, может оказать сильное эмоциональное воздействие и привлечь 

внимание потребителя; при этом степень отклонения от психологических и 

эстетических норм дизайнер, как правило, находит интуитивно, порой даже 
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не рефлексируя по поводу выбранного хода. Прагматичность дизайнерского 

мышления порождает целый ряд нравственно-этических проблем − 

манипуляции, организации восприятия, моделирования сценариев поведения 

потребителей, эксплуатации эстетических ценностей для достижения 

коммерческих целей [3]. 

В широком смысле дизайн можно характеризовать:  

− как продукт конкретной культуры модернизма, характеризующейся 

технологичностью, высоким уровнем индустриализации и урбанизации, 

ориентацией дизайна на создание принципиально новой, рациональной 

среды обитания, формирующей новый образ жизни и стиль мышления 

людей;  

− социокультурную систему, включающую в себя не только творцов и 

потребителей, но и институты экспертизы, выставок, музеев дизайна, а также 

инфраструктуру по его воспроизведению и обслуживанию;  

− особый вид творческой предметной деятельности, происходящей в 

жестких рамках технического задания, бюджета, ожиданий заказчика и 

потребителя. Сказанное обусловило рациональный характер проектирования 

в дизайне и сблизило его с практиками технэ в античном мире;  

− особую профессиональную и образовательную сферу;  

− особый тип проектного мышления, ориентированного на 

удовлетворение предметных и духовных потребностей другого 

человека/людей в гармоничном предметном окружении;  

− особый метод (или методы) проектирования и создания вещей, 

который может быть использован и в других сферах, например, в рекламе, 

имиджмейкинге, предполагающих наличие проектности и моделирования. 

Дизайн в узком смысле − это сам процесс проектирования, в его 

специфическом варианте, основанном на использовании языка форм. 

Отдельные элементы дизайна могли проявляться в предметной деятельности 

с древнейших времен, будучи синкретически смешанными с элементами 

других видов эстетической, художественной, проектной, коммуникативной 
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деятельности. Специфический автономный дизайн-дискурс сформировался 

на протяжении второй половины XIX–нач. XX вв. 

Инновационный компонент дизайна состоит в способности 

всесторонне системно рассмотреть проектную задачу; создать модель 

проектируемого объекта (пространства, процесса, отношения, 

коммуникации, имиджа), включающую в себя учет восприятия потребителя и 

его реакцию на объект; предложить принципиально новое концептуальное 

решение или подход к дизайну; выбрать или предложить метод (методы) 

проектирования, при необходимости стратегии реализации проекта; дать 

экспертную оценку места и роли реализованного проекта в пространстве 

культуры (города, системы, учреждения). 

Формулировки типа «сегодня можно всѐ», «сегодня время китча», «а 

мне нравится» и т. п. нуждаются в дополнительной проверке и уточнении 

терминов, поскольку создаются для целей брендинга и рекламы, а вовсе не 

поиска сути [2].  

Дизайн − вид проектно-художественной деятельности, связанный с 

разработкой предметного окружения человека, систем визуальной 

коммуникации и информации, организацией жизни и деятельности человека 

на функциональных, рациональных началах. В своей работе дизайнер 

пользуется всем арсеналом проектных средств: от технического 

конструирования, компоновки − до композиционного формообразования, 

стилеобразования; от функционального анализа − до организационных, 

концептуальных моделей предметной среды. Однако все эти средства 

подчинены выявлению общекультурного, художественно-образного 

понимания дизайнером всего комплекса проблем предметного мира и мира 

коммуникации. Разработка этой «второй природы» базируется на ряде 

принципиальных методов − функциональном анализе, компоновке, создании 

пространственной или графической композиционной структуры, стилизации 

и т.д. Цель дизайна − удовлетворение разнообразных потребностей человека, 

включая потребность в культурной идентификации, эффективная 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



организация предметной и информационной среды жизни и деятельности на 

основе художественно-образных моделей. Это работа художника с формой, и 

потому процессы формообразования здесь принципиальны. Форма 

интегрирует понимание дизайнером всего круга стоящих перед ним задач: и 

утилитарных, и социокультурных, и художественных, и технологических. 

Через форму дизайнер общается с потребителем (понимая под формой не 

только оболочку или конструкцию материальных предметов, но и структуры, 

сценарии действия, те или иные правила и условия) [6]. 

В современных условиях дизайн, как многие профессии и сферы 

культуры, трансформируется, создавая виртуальное пространство, становясь 

инструментом маркетинга и рекламы, обслуживая экономические процессы, 

делаясь все более массовым, порой теряя качество в силу нехватки 

компетентных специалистов и промышленных мощностей. Есть ряд 

неизменных существенных черт, без которых феномен не сможет оставаться 

самим собой. К ним относится проектное дизайнерское мышление и такие 

его свойства, как диалогичность и системность. Существуют поверхностные 

характеристики, отождествляемые в обыденном сознании со сферой дизайна: 

навыки владения компьютерными программами, знание композиции, 

шрифтов и основ цветоведения, информация о модных тенденциях и т. п. 

Они подвержены наибольшему давлению со стороны современной культуры. 

Есть другие пути и способы создания предметности, нежели дизайн. 

Это ремесленные и арт-практики, хэнд мейд, декоративно-прикладное 

искусство, инжиниринг. Сельская культура, связанная с природными 

ритмами, традиционные культуры, опирающиеся на миф и ритуал − в том 

числе при изготовлении предметов, отдельные субкультуры города 

обходятся минимумом дизайна или вовсе без него. 

Человек в дизайне − проектировщик и адресат. Он имеет единую 

телесно-духовную природу, удовлетворяет потребность в гармоничном 

предметном окружении и создает выразительные (эстетические) формы, 

воздействующие на эмоции и чувства, влияющие на состояние души. 
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Модусами существования этого человека являются целостность, активность в 

освоении мира (не исключающая усталости или потребности в экономии сил) 

и свобода, что неизбежно сказывается на характере проектирования дизайна 

и пользования им. Экзистенциалами жизни этого человека являются самость, 

сотворчество и свобода, обеспечивающие личный характер взаимодействия с 

предметным миром. 

С 1919 г. образцы, исполняемые промышленным способом, получили 

название industrial design. Этот термин сначала утвердился в США, а затем в 

других странах и был принят для обозначения новой области творчества для 

промышленного производства. На первом конгрессе Международного совета 

организаций по художественному конструированию в 1958 г. этот термин 

был принят для обозначения области деятельности, связанной с 

художественным конструированием промышленной продукции. В нашей 

стране в значении industrial design стал применяться термин «дизайн». 

Зарождение дизайна как самостоятельной профессиональной 

деятельности связано с развитием массового производства, технологий, 

прикладных наук. Хотя его история многогранна и включает факты из 

области архитектуры, техники, изобразительного искусства, теории знаковых 

систем, социологии, культурологии, проблем коммуникации, рекламы и 

маркетинга, функционального анализа и эргономики, тем не менее XX век 

дал ряд фундаментальных исторических исследований, посвященных именно 

этой профессии. Первая книга в этом ряду - «Пионеры современного 

движения. От Морриса до Гропиуса» Николауса Певзнера - была издана  

в 1936 г. История дизайна представлена в ней как история современности − 

стилей, мышления, как история актуальных направлений и идей в культуре. 

Модернизм, художественный авангард первой трети XX в. надолго стал 

ассоциироваться с дизайном. 

В истории дизайна чаще обращаются к конкретным личностям, 

поскольку проектная культура развивается благодаря авторским творческим 

концепциям. До сих пор жива традиция, заложенная Певзнером, 
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представлять историю как движение к модернизму, показывая в 

художественной эволюции дизайна роль тех или иных концепций 

формообразования, идущих от искусства. Искусство для дизайна играло роль 

своеобразного разведывательного отряда, осваивающего новые творческие 

технологии и приемы выразительности. 

Есть и другой подход. Объектом изучения становится анонимный 

дизайн, впервые рассмотренный исследователем дизайна и архитектором 

Зигфридом Гидеоном в книге «Механизация слушается»1. Другая его книга 

была целиком посвящена анонимным проектам стульев, находившихся в 

одном из американских патентных бюро. Повседневная, банальная часть 

предметного мира часто поражает нас своей непривычной красотой. Это то, 

что можно назвать техническим, проектным, дизайнерским фольклором. 

Фольклор, наряду с вершинами искусства, всегда питал культуру, в том 

числе предметно-художественную. 

История дизайна как вида проектно-художественной деятельности 

разворачивается во взаимодействии с научно-технической и визуальной, 

художественной культурой, поэтому она обязательно отражает влияние 

новаций и изобретений в технике, инженерном и художественном 

творчестве. Дизайн — это одновременно и продукт культуры, инструмент 

культурного строительства, и фактор, активно формирующий культуру. 

Дизайн (от англ. design – замысел, проект, конструкция, рисунок, 

композиция) − художественно-конструкторская деятельность в 

промышленности, охватывающая творчество художника-конструктора 

(дизайнера), методы и результаты его труда, условия их реализации в 

производстве. Цель дизайна – создание новых видов и типов изделий, 

отвечающих требованиям общественной пользы, удобства эксплуатации и 

красоты. Теория дизайна получила название технической эстетики. 

Техническая эстетика – научная дисциплина, изучающая социально 

культурные, технические и эстетические проблемы формировании 

гармоничной предметной среды, создаваемой средствами промышленного 
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производства для жизни н деятельности человека. Составляя теоретическую 

основу дизайна, техническая эстетика изучает его общественную природу и 

закономерности развития, принципы и методы художественного 

конструирования, проблемы профессионального творчества и мастерства 

художника-конструктора. Главная цель технической эстетики обеспечить на 

основе достижений теории и практики художественного конструирования 

наилучшие условия труда, быта и отдыха людей в создаваемом ими 

предметном мире. Техническая эстетика играет важную роль в воспитании 

гармонически развитого человека, в формировании у него эстетического 

вкуса. 

Художественное конструирование не подменяет конструирование 

инженерное, а вместе с ним составляет взаимно дополняющие стороны 

единого процесса создания новых изделий. Польза и красота утилитарных 

предметов связаны неразрывно, и поиск их конструкции и формы должен 

вестись с учетом обоих факторов. При этом инженер и художник-

конструктор должны правильно оценивать соотношение технического и 

эстетического, материального и духовного в предметном мире. 

Художественное конструирование – творческий процесс и метод 

проектирования промышленных изделий, осуществляемые в соответствии с 

требованиями технической эстетики. Оно является неотъемлемой составной 

частью общего процесса проектирования промышленных изделий и ведется 

совместно с инженерным конструированием, решающим конструктивно 

технические и экономические задачи. 

Художник-конструктор – это специалист, занимающийся 

художественным конструированием промышленных изделий. 

Принципом художественного конструирования является единство 

полезного и прекрасного, утилитарного и эстетического. 

Дизайн – это творческий процесс создания вещи, в котором эстетика 

определяет содержимое (суть), а технологии форму вещи. 
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Художественно-проектная деятельность дизайнера уникальна по 

своему характеру, так как в ней неразрывно связаны между собой три вида 

творческой деятельности: художественная, научная и техническая, поэтому 

визуальный язык дизайнерской формы формируется и развивается в процессе 

художественного и научно-технического творчества. Профессиональную 

деятельность специалиста в области дизайна следует рассматривать в 

идеологическом и культурном аспекте, так как продукт труда – это не только 

промышленные образцы, но и концептуальные модели и объекты, которые не 

тиражируются, предназначенные для индивидуального пользования. 

Чтобы определить понятие «художественно-проектная деятельность» 

необходимо рассмотреть значение слов «проект» и «проектирование». 

Проект – замысел, план, прообраз какого-либо изделия. 

Проектирование – это процесс создания проекта, прототипа, прообраза 

предполагаемого или возможного объекта или состояния.[23, С.18]. Под 

проектированием понимается разработка основных деталей предстоящей 

деятельности по решению поставленной учебной задачи или задания. Это 

сложная многоступенчатая деятельность, которая совершается как ряд 

последовательно следующих друг за другом этапов, приближающих 

разработку предстоящей деятельности от общей идеи к точно описанным 

конкретным действиям. 

Проектная деятельность является интегративным видом деятельности, 

синтезирующим в себе элементы игровой, познавательной, ценностно-

ориентирующей, преобразовательной, профессионально-трудовой, 

теоретической и практической деятельности.[24, С.24]. 

Исторически сложилось три вида проектирования: 

− технологическое, процесс копирования ремесленного образца с 

учетом новой технологии промышленного производства; 

− морфологическое, создание новой материальной формы предмета на 

базе новой технологии; 
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− функциональное, моделирование и опредмечивание новых функций 

вещи в соответствии с возникающими потребностями в обществе, 

осуществляется на базе технологического и морфологического 

проектирования. 

Выделяют три подхода к проектированию: 

− техническое конструирование относят к инженерному дизайну; 

− художественное формообразование относят к арт-дизайну, 

связанному с созданием уникальных произведений, с проектированием 

образно-пластической, художественной формы вещи; это направление 

дизайна сближается с декоративно-художественным творчеством и с 

современным искусством; 

− художественное конструирование относят к дизайну утилитарно-

художественному, когда дизайнерская деятельность, связанна с 

«художественным освоением утилитарной основы предмета». 

Наряду с вышеуказанными подходами существует художественное 

проектирование – это процесс создания описания, изображения или 

концептуальной модели несуществующего объекта с заданными 

функциональными, эргономическими и эстетическими свойствами. 

Дизайн, как вид художественного проектирования, объединяет научно-

технический подход с художественно-образным подходом к построению 

модели будущего объекта, созданию его структуры и способам описания. 

Исходя из этого, отличительной особенностью проектирования как сложной 

деятельности является то, что оно проявляется в создании и преобразовании 

пространственных представлений и образов, следовательно, требует 

надлежащего уровня развития образного, понятийного и наглядно-

действенного мышления в их единстве и взаимодействии. Особое значение 

приобретает в данном виде деятельности развитие инициативы, 

самостоятельности, способности учащегося к длительным волевым усилиям 

и сосредоточенности внимания. 
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Проектирование – понятие более широкое, чем художественно-

проектная деятельность. Проектирование – феномен культуры модернизма. 

Именно в модернизме сформировалось понимание проектирования как 

моделирующей реальность деятельности, активно опережающей 

предметно-пространственное развитие. В контексте модернистской 

культуры проектирования сформировался дизайн, инкорпорировав в себя 

спектр его смыслов. Художественно-проектная деятельность использует 

результаты научных исследований в различных областях науки и техники, 

искусства, технологии, экономики, социологии, психологии, эргономики, 

семиотики, системотехники, эстетически, знания современного 

промышленного производства, его технологии и экономики. Направлена на 

создание средствами промышленного производства совершенных и 

высококачественных серийных и штучных изделий для удовлетворения 

потребностей человека и общества. 

Метод художественно-проектной деятельности складывается из 

художественно-конструкторского анализа (исследование исходной ситуации 

и построение объекта проектирования, функционально-эргономический и 

конструктивно-технологический анализ, композиционный анализ) и 

художественно-конструкторского синтеза (в процессе которого ведется 

функционально-эргономический поиск, работа над композицией изделия). 

Для проектной деятельности характерно моделирование объекта на всех 

этапах его разработки (в соответствующем масштабе и нередко в 

натуральную величину), позволяющее проверять и отбирать оптимальные 

варианты композиционных, цветографических, эргономических и других 

решений; при этом модель служит не иллюстрацией к проекту, а как бы 

инструментом проектирования и, постоянно модифицируясь в ходе работы, 

становится эталоном опытного образца изделия. Специфическим для 

проектного метода является рассмотрение проектируемого изделия как 

элемента целого комплекса изделий, окружающих человека в конкретной 

предметной среде, которая должна максимально удовлетворять утилитарные 
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и эстетические потребности и способствовать повышению эффективности 

его деятельности. 

Этапы художественно-проектной деятельности: 

1. Анализ проектной ситуации, определение объекта проектирования. 

2. Выявление проблемы (отсутствие среды или средств, организующих 

деятельность, несоответствие, противоречие и др.). Выявление задач. 

3. Определение потребителя (возраст, характер, модель поведения в 

данной проектной ситуации и др.). 

4. Разработка проектной концепции – проектного решения. 

5. Оценка конструктивных возможностей предмета проектирования. 

Создание функциональной схемы объекта проектирования. 

6. Определение требований к предмету проектирования 

(функциональные, эргономические, эстетические и др.). 

7. Анализ аналогов (согласно требованиям). 

8. Этап формообразования. Разработка вариантов (композиционно-

пластических решений), удовлетворяющих требованиям через проектный 

образ, анализ аналогов (эскизирование, объемное проектирование). 

9. Выбор оптимального варианта проектного решения и его подачи 

(выбор ракурса, количества необходимых изображений). Обоснование 

выбора оптимального варианта проектного решения и идеи подачи проекта. 

10. Подача проекта. Изготовление макета. 

11. Критика и оценка проекта. 

Корни дизайна уходят к началу XIX века, в эпоху появления массового 

машинного производства и разделения труда. До промышленной революции 

в труде ремесленника дизайн непосредственно сочетался с изготовлением 

изделия. 

История развития художественного проектирования берет начало с 

середины XIX в. 

Исторические этапы формообразования 
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Кустарное, ремесленное производство – предтеча дизайна от начала 

человеческой цивилизации до конца XVIII века. 

Индустриальное машинное производство – конец XVIII века начало 

XX века. 

Этап Дизайна – начало XX века – наше время. 

Кустарное производство – ручной труд, примитивные орудия труда, 

примитивная технология, малосерийное производство + учитывались все 

потребности человека к вещи: полезность, функциональное совершенство, 

удобство, красота, экономическая целесообразность. Производством 

бытовых вещей издавна занимались ремесленники. Понятно, что 

ремесленник – не дизайнер. Ремесленник делает одну и ту же вещь из одного 

и того же материала. Вещи получались индивидуальные, эксклюзивные и 

дорогие. Шесть принципов работы кустаря: социологический, инженерный, 

эргономический, эстетический, экономический, экологический. 

Индустриальное производство – «нечеловечные, холодные предметы». 

С приходом века индустриализации дизайнер стал создавать прототипы 

изделий, которые с помощью машин производили другие люди. Практика 

раннего дизайна была весьма примитивной. Функциональностью и 

экономичностью производимой продукции занимались инженеры, а 

дизайнеры отвечали лишь за ее эстетический вид. Оказалось, что дизайнеры 

должны создавать прототипы массового машинного производства, 

предварительно изучив технологию современного производства и свойства 

материалов. Назначению изделий и простоте обращения с ними придавали 

столь же важное значение, как и их внешнему виду. В скором времени 

дизайнерские фирмы стали набирать в штат чертежников, модельщиков, 

инженеров, архитекторов и специалистов по изучению рынка. 1785 г. в 

Англии начинает развиваться индустриальное машинное производство – 

специализация, узкопрофессиональный подход, разделение труда, 

потоковость. 
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Этап дизайна соединил достоинства предыдущих двух этапов: 

дизайнер работает на промышленном производстве, использует различные 

материалы и технологии. Дизайн связан с массовым производством и с его 

уровнем и возможностями. Оформители и бутафоры украшают свои вещи, но 

дизайнер обязан мыслить масштабно и разнопланово, он обязан наперед 

представлять, как поведет себя его будущее творение в своей среде обитания, 

как оно повлияет на среду и как среда уживется с вещью. Дизайнер должен 

придать вещи максимальную симпатию к человеку, к тому, для кого вещь 

будет предназначена, кому она будет служить. Дизайнер обязан сохранить 

чистоту идеи − функциональную обоснованность для формы, материала, т.е. 

всех составляющих.  

Дизайнер (художник-конструктор), создавая вещь должен знать быт, 

этнографию, демографическую ситуацию, социологию быта (понимая кто, 

когда, как и до каких пор будет пользоваться вещью, рождающейся сегодня), 

психологию, физиологию, медицину, эргономику, технологию изготовления 

вещи, свойства материалов, возможные инженерные и конструкторские 

решения. 

Три основных этапа становления и формирования дизайна. 

1 этап – начало и первое 30-летие XX века. Революционный взрыв идей 

в Европе и США. Эксперименты и поиски средств выразительности, 

материалов и форм, адекватных массовому способу индустриальному 

способу созидания материальных и художественных ценностей. 

Главная задача – не украшать мир вещей и пространства, а строить по 

внутренним законам. Функции, конструкции, технологии производства. 

2 этап – до 60 годов ХХ века (исключая годы войны). Распространение 

географии дизайна на все континенты. Становление авангардных форм 

дизайна «международным стилем» − признаком 20 века. Организационные и 

«рыночные» проблемы дизайнерского творчества. Развитие дизайнерских 

фирм, рекламных компаний. Появление «стайлинга» (оформление вещи 

модными приѐмами). 
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3 этап – использование общих тенденций прошлого в дизайне. Охват 

новых регионов. Развитие разнообразных стилевых концепций – одна из 

главных черт современного периода дизайнерского движения. Проявление 

различных направлений: постмодернизм, фристайл, ретро, хай-тек, практика 

«мусорной моды» − спектр выбора человека своих эстетических 

предпочтений. 

Формирование системы эстетических ценностей в «региональных 

дизайнах» − здоровым началом современной проектной культуры. Опора на 

синтез местных, национальных установок и новаторских достижений 

мирового опыта: артистичность итальянской школы, символы «простоты» 

японского стиля, функциональная старомодность английского, грубоватая 

практичность немецкого дизайна. 

Применение сверхсовременных технологий и науки в дизайне на 

современном этапе развития дизайнерского формотворчества; электронные 

средства решения бытовых задач; природно-экологические подходы в новых 

областях и сферах общества. 

Основные направления дизайна 

Принято выделять два основных направления в становлении дизайна. 

Советское (ВХУТЕМАС) и Германское (БАУХАУЗ). 

В основе всех мировых школ дизайна лежат образовательные 

концепции, так или иначе восходящие к опыту ВХУТЕМАС-БАУХАУЗ. 

Базовыми знаниями мирового дизайнерского образования весь ХХ век 

являлась пропедевтика: элементарные вводные курсы, учившие видеть 

простое в сложном, расщеплять любую форму – на геометрические 

первоэлементы, жизнь – на функциональные процессы. Сама по себе 

модернистская парадигма есть по сути как бы система художественного 

образования. Школа приѐмов, с помощью которых можно анализировать всю 

предшествующую культуру, переконструировать существующую и строить 

новый мир – целесообразный, технологичный, функциональный и социально 

справедливый. 
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Советское направление развития дизайна 

В СССР в Москве в 1918 г. был создан Художественно Технический 

Совет. В 1919 г. создается Художественно Технический Совет в составе 

Совнаркома Труда и Обороны. В 1920 г. В. И. Ленин подписал декрет о 

создании Государственных Высших Художественно-технических 

Мастерских с факультетами: архитектурный, живописи, скульптуры, 

текстильный, керамический, дерева и железо обработки. Создан Совет по 

промышленному искусству в составе ВСНХ. 

Тогда же в 1920 г. были организованы Высшие Художественно-

Технические Мастерские ВХУТЕМАС (директор А. Родченко), которые 

просуществовали до 1932 г. 

ВХУТЕМАС, первоначально (до 1921 г.) – Свободные художественные 

мастерские, основанные в 1918 г. в Москве на базе Московского училища 

живописи, ваяния и зодчества и Строгановского художественно-

промышленного училища. Родченко Александр Михайлович (1891-1956гг.), 

российский дизайнер, график, мастер фотоискусства, художник театра и 

кино. Один из основоположников конструктивизма, родоначальник нового 

вида искусства – дизайна. 

Организация ВХУТЕМАС имела целью создание и развитие советской 

художественной культуры. Однако формалисты в руководстве применяли 

уродливые методы обучения, препятствовавшие развитию творчества 

молодежи в духе реализма и национальных традиций (пропаганда 

формализма под видом пролетарского искусства, создание мастерских по 

вульгарному ремесленно-технологическому принципу). Деятельность 

формалистов вела к развалу и ликвидации художественного образования. В 

1926-1927 гг. ВХУТЕМАС был реорганизован во ВХУТЕИН. 

ВХУТЕИН – Высший государственный художественно-технический 

институт. Учрежден в Москве в 1926-1927 гг. на базе ВХУТЕМАСа. В 1930 

ВХУТЕИН был закрыт. Вместо него были созданы Московский 
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архитектурный институт и Московский художественный институт (которому 

позднее было присвоено имя В. И. Сурикова). 

В 1930 году на базе полиграфического факультета ВХУТЕИНа был 

создан Московский художественно-полиграфический институт (МХПИ), 

ныне – Московский государственный университет печати. Выпускники 

ВХУТЕМАСа-ВХУТЕИНа-МГУПа, станковисты и иллюстраторы, во многом 

определили лицо российского искусства ХХ века. 

Белорусское направление развития дизайна 

Конец 1980-х–настоящее время – быстро развивается технология 

компьютерного дизайна. Теперь один дизайнер может решать такие задачи, 

какие решить раньше было по силам лишь конструкторскому бюро. В связи с 

появлением персональных компьютеров быстро развивается Промышленный 

Дизайн и некоторые направления дизайна: 

дизайн интерьера; 

веб-дизайн; 

ландшафтный дизайн; 

полиграфический дизайн. 

Протодизайн и технология. 

Протодизайн − этап становления дизайна (М. Э. Гизе). Его эпоха 

ограничена, с одной стороны, началом XVIII века (распад традиционного 

ремесленного производства, появление в России первых 

металлообрабатывающих заводов и горнорудных предприятий), а с другой — 

серединой XX века (начало эры крупной индустрии). Хотя эпоха включает в 

себя и ремесленное, и мануфактурное производства, но в это время уже идет 

активный процесс смены технологий, что и порождает особую ситуацию в 

промышленности. В «протодизайне» М. Э. Гизе выделяет два направления, 

связанных с созданием двух, по существу различных, групп 

изделий:·изделия, обслуживающие непроизводственную, домашнюю работу 

(традиционно женский труд). Их создание основано на синтезе 

изобразительного искусства, приемов художественного конструирования 
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(подобие элементов конструкции, их контрастность и т. п.), что в 

дальнейшем нашло развитие в кустарной и художественной 

промышленности. Изделия, обслуживающие производственную деятельность 

(традиционно мужской труд). Их создание опирается на принцип 

информативности формы, использование конструктивных, функциональных, 

пластических свойств материалов и изделий, что легло в основу 

классического понимания промышленного искусства. Подлинный 

промышленный дизайн (то явление, которое традиционно понималось под 

этим термином и которое предпочтительно называть «художественным 

конструированием») развился именно из мужской линии «протопрофессии», 

тогда как женская линия дала развитие прикладному искусству. 

Определить область дизайна не всегда просто. Дизайн трудно отделить 

от архитектуры (когда речь идет о проектировании интерьеров), от 

скульптуры (когда проектируются, например, детские площадки или 

аттракционы), от прикладного искусства (создании новых видов посуды и 

мебели). 

Если говорить о нашем времени, то и сейчас дизайнер ищет 

вдохновение (прототип) в культуре и искусстве древнего мира, 

средневековья, нового времени, современного искусства и т.д. Он 

перерабатывает старые вещи, в новой форме, и на их основе рождаются 

новые интересные идеи, дизайнерские решения. 

Исторически о возникновении проектного мышления в более узком 

смысле, как процессе предвосхищения конечного результата эстетически и 

технологически обусловленного через волю конкретного творца, можно 

говорить, начиная с эпохи Возрождения. Ренессанс способствовал 

расширению сознания, сформировав антропоцентрическую картину мира − 

культ человека и созданной им культуры. 

Одним из первых документально оформленных проявлений проектного 

мышления считают исследование английского инженера-механика 

Джона Смитона [21]. Смитон сконструировал уменьшенные копии двух 
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механизмов водяной мельницы, которую ему было поручено построить, и в 

течение семи лет проводил кропотливые исследования того, какой из них при 

прочих равных условиях более эффективен. Впервые в истории проект был 

действительно предвосхищен: не будучи реализованным, он уже был 

всесторонне-детально проработан, вписан в среду, была четко просчитана 

конечная выгода от объекта. 

XVIII в. стал началом больших перемен в жизни общества. Человек 

впервые в истории получает относительную независимость от сил природы. 

Протодизайн, в основе которого лежит особый стиль мышления − проектное 

мышление − уже активно преобразует, комбинирует и модифицирует 

наработки человечества. Не только среда обитания и объектный мир, но и 

социобиологическая природа и поведение человека начинают 

трансформироваться и определяться с помощью культуры предвосхищения. 

Взаимообусловленное феноменальное развитие промышленности и 

социальной сферы вело к росту числа горожан и, в свою очередь, 

стимулировало уровень жизни и потребностей. Вещественный мир обычного 

человека вплоть до XIX в. был сравнительно небольшим. Формирующееся 

массовое общество неизбежно вело к массовому потреблению: впервые в 

истории всего стало нужно действительно много. Справиться с актуальными 

аппетитами масс могло только серийное производство.  Тиражирование стало 

самой характерной чертой массового производства, изменив вековые 

традиции ремесленного, ручного труда. В ремесленном производстве каждый 

объект уникален, мастер всякий раз выполняет полный цикл операций по 

производству, вкладывая в каждый объект свое время и душу, на 

соотношении затрат этих ресурсов и материалов формируется стоимость 

изделия. Серийное производство отражает совсем другой подход, оно 

изначально подразумевает производство не единичных объектов, а сотен 

тысяч полностью идентичных товаров. 

XIX в. закрепил и продолжил все ключевые достижения проектного 

мышления прошлого. Тогда окончательно оформилась полноценная и 
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эффективная искусственная среда. Человек XIX в. уже не упорядочивал 

природу, он давно преодолел ее, в его распоряжении был богатый мир 

культуры. Отныне уже не природа, а культура становится пластичным 

материалом для упорядочивания, проектирования и создания порядка вещей. 

Конец XIX в. стал закатом «многостаночников» прошлого. На начальных 

этапах отсутствие упорядоченного знания и традиции возмещалось 

спонтанным творчеством и неожиданными открытиями, теперь этот процесс 

получает все более упорядоченный, структурный, институцианализованный 

вид. 

Исследование истоков дизайна делает заманчивым преувеличение в 

нем творческой составляющей, романтизацию практики дизайна. Однако 

история свидетельствует об обратном: генезис дизайна связан с проектным 

мышлением, целенаправленно и сознательно преодолевающим природное и 

создающее рукотворное, имея ввиду в первую очередь прагматические цели. 

Ремесло и функциональные факторы. 

В системе рождения изделий как ритуала посвященных мастеров, 

абсолютно одинаковые предметы практически невозможны. Все изделия 

чуть-чуть отличаются друг от друга в цепи непрерывного совершенствования 

подобно тому, как обтачивается морем галька. 

В дизайне такой тип предметного воспроизводства называют 

каноническим. 

«Канон − это система правил, принципов, норм, приемов работы, 

символических ценностей и социально-культурных значений данного 

общества, овеществляемых, в частности, в предметной форме ремесленного 

продукта» [20]. Канон − это и есть проект, зафиксированный в культуре. 

Из поколения в поколение ремесленники, объединенные в цехи, 

передавали навыки и профессиональные секреты в процессе работы. В этом 

причина сложности возрождения распространенных когда-то народных 

промыслов. Мастера прекрасно знали своих заказчиков, их вкусы, желания. 

У каждого перед глазами были реальные образцы-эталоны, которым нужно 
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следовать. Не было необходимости в каком-то особом этапе — 

проектировании. 

С началом промышленной революции ремесленный тип производства 

не исчез полностью. Он видоизменился, став одной из разведывательных 

областей производства. 

При всей своей технической и научной оснащенности дизайнер многое 

сохраняет от этой древней кустарной технологии, особенно в части, 

касающейся его авторской лаборатории формообразования. Для одного все 

сводится к рисункам и эскизам на бумаге, для другого − к макетам из 

подручного материала, третий пробует имитировать законченную 

промышленную технологию на действующем макете. Качество ремесленной 

технологии в прошлом определялось навыком и точностью движения рук. 

Дизайнеру, проектирующему в расчете на тот или иной вид промышленной 

технологии, все равно необходимо вживаться в технологии, часто 

представляя эти процессы опосредованно, моделируя их мысленно или при 

помощи материалов-заменителей. 

Дизайн, родившись в XIX в., черпал вдохновение в одной ключевой 

научно-технической идее века предыдущего: мир есть гигантский механизм. 

Отсюда возник миф о том, что все в мире можно вычислить и измерить, 

понять и спроектировать. 

Промышленная революция. 

Зарождение дизайна всегда связывают с индустриализацией и 

механизацией производства, обусловленными промышленной революцией в 

Британии в середине XVIII − первой трети XIX в. Промышленная 

революция – это внедрение в процесс производства станков, замена 

уникальных движений ремесленника воспроизводимыми, повторяющимися 

движениями машины. 

Первыми машинами, заменившими ручные операции, были ткацкие 

станки на мануфактурах. В движение все эти механизмы приводились либо 

животными, либо водяными колесами. В начале XIX в. был изобретен 
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механизм для автоматизации ткацкого процесса, возникли перфорированные 

карты, на которых информация об узоре, выполняемом на жаккардовом 

станке, записывалась пробивкой отверстий. 

Индустриализация привела к появлению двух концепций в мире 

дизайна. Первая, разделяемая большинством, заключалась в идее возврата к 

ремесленному производству, к целостности продукта, создаваемого одним 

мастером. Джон Рескин и Уильям Моррис − предшественники современных 

движений − по-своему пытались преодолеть разрыв между эстетичной 

формой и функцией, порожденной промышленной революцией, реформируя 

искусства и ремесла. 

Еще одна особенность промышленной революции − развитие 

массового производства, требовавшего механизации и упрощения 

технологий. В дальнейшем фабрики развивались в сторону все большей 

оптимизации, рационализации процессов, разделения технологических 

операций, применения паровых машин для приведения в действие все более 

совершенных обрабатывающих станков. 

Традиционно наиболее точными областями производства были 

ювелирное дело, изготовление часов, механических и оптических приборов, 

измерительной техники. После изобретения печатного станка и наборного 

металлического шрифта к ним присоединилась и полиграфическая техника. 

Причем по степени массовости изготовления изделий − литер, по степени 

стандартизации — увязки и соблюдения размеров, по степени сложности 

самого процесса книгопечатания, распадавшегося на множество 

взаимосвязанных процессов и операций, этот вид производства вошел в 

число лидеров. Не случайно с середины XV в., со времен Гутенберга, лучших 

результатов в создании шрифта и всего комплекса печатной техники 

добивались люди, знакомые с тайнами металла, высокоточными и тонкими 

способами его обработки. 

Само появление книгопечатания и тиражирования изображений также 

повлияло на вычленение дизайна в самостоятельную профессиональную 
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сферу. Уже с XVI в. известны книги и папки с листами, на которых 

изображены орнаментальные мотивы. Тонко исполненные гравированные 

увражи были необходимы мебельщикам, ткачам, ремесленникам, 

занимавшимся оформлением интерьеров. Художник не задумывался о том, в 

каком конкретном материале, в каком изделии его рисунки будут 

использованы. Так проектирование, рисование образцов начинает выделяться 

в самостоятельную профессию. 

В период промышленной революции техника превращается в 

непосредственный источник чисто дизайнерских методов проектирования. 

Использование металла, стандартизация форм и элементов требовали 

применения комбинаторных систем. Так были созданы знаменитый 

Хрустальный дворец в Лондоне (1851) и Эйфелева башня в Париже (1889). 

Говоря об эпохе промышленной революции, мы впервые сталкиваемся 

не просто с дизайном как видом компоновочной и изобретательской 

деятельности. Мы отмечаем появление проекта как промежуточного 

продукта деятельности проектировщика. Проекта как некоего документа, 

модели, изображения внешнего вида будущего сооружения и записи 

алгоритма его создания. Лучше всего это иллюстрирует история создания 

Хрустального дворца. 

Авангардное искусство ХХ века. 

Авангард − категория, означающая в современной эстетике и 

искусствознании совокупность всех пестрых и многообразных новаторских, 

революционных, бунтарских движений и направлений в искусстве первой 

половины ХХ века, завершение многовекового периода существования 

классической европейско-средиземноморской художественной культуры и 

начало ее глобального перехода в иное качество. В России его впервые 

употребил А. Бенуа в 1910 г. в негативно-ироническом смысле для 

характеристики ряда «авангардистов» на выставке «Союза русских 

художников». 
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Авангардизм, или авангард − это не единый живописный стиль, как 

иногда представляется, а совокупность множества художественных 

направлений, появившихся на рубеже XIX-XX столетий. Этот термин 

объединил все те дерзкие и новаторские течения, которые шокировали 

публику и отрицали классическую традицию. Представители авангардизма 

стали тем передовым отрядом, который шѐл впереди основной массы 

деятелей культуры, открывая и разведывая новые пути творческого 

самовыражения. 

В сфере научной мысли косвенными побудителями авангарда (как 

позитивными, так и негативными) явились основные достижения в сферах 

научного знания, начиная с конца XIX века. Открытия первой половины 

ХХ века в областях ядерной физики, химии, математики, психологии и 

технико-технологические реализации на их основе. В философии − основные 

учения постклассической философии от Шопенгауэра и Киркегора до 

Ницше, Бергсона, Хайдеггера; в психологии-психиатрии − прежде всего, 

фрейдизм и возникший на его основе психоанализ. В гуманитарных науках 

отход от европоцентризма и как его следствие возросший интерес к 

восточным культурам, религиям, культам; возникновение теософии, 

антропософии, новых эзотерических учений и, как реакция на них и на 

засилье позитивистско-сциентистского миропонимания, всплеск 

неохристианских учений (неотомизма, неоправославия). В социальных 

науках − социалистические, коммунистические, анархистские теории, 

утопически, но с революционно-бунтарским пафосом отразившие реальные 

острые проблемы социальной действительности того времени. 

Художественное мышление, как самый чуткий барометр духовно-

культурных процессов, отреагировать на всю эту калейдоскопическую бурю 

новаций. 

К характерным и общим чертам большинства авангардных феноменов 

относятся их осознанный заостренно экспериментальный характер. 

Революционно-разрушительный пафос относительно традиционного 
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искусства (особенно его последнего этапа − новоевропейского) и 

традиционных ценностей культуры (истины, блага, святости, прекрасного). 

Резкий протест против всего, что представлялось их создателям и участникам 

ретроградным, консервативным, обывательским, буржуазным, 

академическим. В визуальных искусствах и литературе − демонстративный 

отказ от утвердившегося в XIX в. «прямого» (реалистически-

натуралистического) изображения видимой действительности. Безудержное 

стремление к созданию принципиально нового во всем и, прежде всего, в 

формах, приемах и средствах художественного выражения; а отсюда и часто 

декларативно-манифестарный и эпатажно-скандальный характер 

презентации представителями авангарда самих себя и своих произведений, 

направлений, движений и т. п.; стремление к стиранию границ между 

традиционными для новоевропейской культуры видами искусства, 

тенденции к синтезу отдельных искусств (в частности, на основе синестезии), 

их взаимопроникновению. 

Этот процесс начался на рубеже столетий с появлением символизма, 

импрессионизма, постимпрессионизма, модерна (ар нуво) и активно 

продолжился во всех основных направлениях и движениях искусства первой 

половины ХХ века. К основным направлениям и фигурам авангарда 

относятся фовизм, кубизм, абстрактное искусство, супрематизм, футуризм, 

дадаизм, экспрессионизм, конструктивизм, метафизическая живопись, 

сюрреализм, наивное искусство; додекафония и алеаторика в музыке, 

конкретная поэзия, конкретная музыка, кинетическое искусство, а также 

такие крупные фигуры, не принадлежавшие в целом ни одному из указанных 

направлений, как Пикассо, Шагал, Филонов, Клее, Матисс, Модильяни, 

Ле Корбюзье, Джойс, Пруст, Кафка и некоторые другие. 

Возможна лишь условная классификация, притом только по отдельным 

параметрам, пестрого множества самых разных во многих отношениях 

феноменов авангарда. 
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Материалистическая, резко отрицательная позиция: кубизм, 

конструктивизм, «аналитическое искусство», кинетизм и некоторые др. 

Напротив, интенсивные (осознанные или неосознаваемые) поиски Духа и 

духовного, как спасения от культуроразрушающего засилья материализма и 

сциентизма: в абстрактном искусстве (Кандинский и ориентирующиеся на 

него, Мондриан), в супрематизме Малевича, в метафизической живописи, в 

сюрреализме. Ряд направлений и персоналий авангарда безразличны к этой 

проблеме. 

Одни под влиянием сциентизма утверждали исключительно 

рациональные основания искусства − опирающиеся на дивизионизм 

представители в абстрактном искусстве с их поисками научных законов 

воздействия цвета (и формы) на человека, «аналитическое» искусство с его 

принципом «сделанности» произведения, конструктивизм, додекафония (и 

сериальные техники) в музыке. Большая же часть и направлений, и 

отдельных представителей авангарда ориентировалась на принципиальный 

иррационализм художественного творчества, чему активно способствовала 

вся пестрая бурлящая духовная атмосфера первой половины века, 

получившая еще апокалиптическую окраску в результате кровопролитных 

войн, революций и неудержимого стремления человечества к созданию 

средств массового уничтожения. Отсюда активное использование приемов 

алогизма, парадокса, абсурда в творчестве (дадаизм, сюрреализм, литература 

«потока сознания», алеаторика с ее абсолютизацией принципа случайности в 

создании и исполнении музыки, конкретная поэзия и конкретная музыка, 

театр абсурда с его утверждением безысходности и трагизма человеческого 

существования, абсурдности жизни, апокалиптическими настроениями). 

Конструктивизм (образовано от латинского слова: constructio – 

построение). Это общеметодологическая концепция, которая фиксирует 

конструктивную деятельность человеческого мышления, осуществляемую с 

определѐнными целями по определѐнным правилам с жѐстко 
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установленными границами и точно выраженную в определѐнном 

естественном или искусственном языке. 

Апелляция к конструктивности может быть обнаружена в самых 

разных областях человеческого познания и деятельности, хотя изначально 

понятие о конструктивности зарождается в античных дискуссиях о 

математическом методе и способе бытия математических объектов. 

конструктивизм представляет собой общее обозначение множества 

направлений и подходов в науке, искусстве и философии, в которых понятия 

конструкта и конструкции играют главную роль в изображении процессов 

порождения предметов и знаний, а иногда и абсолютизируются. В рамках 

конструктивистской философии науки термин «конструктивный» относится 

к методическому введению конструктов, которые формируются без помощи 

научных аксиом, и естественного языка. Перенос конструкционистских 

методов в философию науки осуществляется также в операционализме, 

согласно которым объекты научного знания конституируются с помощью 

специфических для науки методов. 

Всякий предмет восприятия рассматривается как продукт 

перцептивной конструкции и интерпретации, в который входят как 

логические, так и эстетические компоненты. На другом уровне могут быть 

расположены мышление и теоретическое конструирование, специфика 

которых определяется сенсорным дефицитом. Замена восприятия концептом 

имеет в то же время прагматический характер и ориентируется на критерии 

когерентности, последовательности и эмпирической истинности. Согласно 

интерпретативной философии Абеля, отдельный уровень соответствует 

пространственно-временной локализации, категоризации и классификации, 

то есть деление на роды и виды также является формированием 

интерпретативных конструктов с точки зрения определѐнных целей. Они, в 

свою очередь, покоятся на глубоко лежащей интерпретативной практике 

жизненного мира. Конкретные типы реальности являются, таким образом, 

продуктами интерпретативных конструктов на различных уровнях 
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человеческого мира. Реальность оказывается зависимой от функций систем 

описания, обозначения и интерпретации. В целом, для конструктивизма 

ключевыми являются три основных понятия − целеполагание, обоснование и 

творчество, если под конструктивизмом понимать всѐ противоречивое 

многообразие его программ. 

Конструктивизм в искусстве отличался узнаваемыми особенностями: 

геометризмом, лаконичностью, простотой, четкостью, монолитностью, 

практицизмом. 

Стилистически конструктивизм характеризуется присущими ему 

особенностями. 

− Организация абстрактных геометрических элементов, которые 

позволяют в комплексе сделать динамические или визуально устойчивые 

формы. 

− Фотография и фотомонтаж – часть полотна, вид передачи замысла 

художника. 

− Комбинации различных шрифтов для передачи их символического 

или буквального значения. 

− Простые, плоские, символические цвета, передача изображения без 

объема, перспективы. 

− Обширное белое пространство как часть дизайна. Известны плакаты, 

выполненные в этом стиле – вид выражения конструктивистского 

творчества. 

Главной целью конструктивизма было желание выразить опыт 

современной жизни – ее динамизм, новые и дезориентирующие качества 

пространства и времени через полотна и плакаты. Но также важным было 

желание разработать новую форму искусства более подходящим 

демократическим способом, и модернизируя ее, соответственно целям 

русской революции. Конструктивисты должны были быть строителями 

нового общества – работники культуры наравне с учеными в поиске решений 

современных проблем. 
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Модернизм пришел на смену реализму и дал писателям ощущение 

свободы.  

Модернизм (итал. modernismo − «современное течение»; от лат. 

modernus − «современный, недавний») − направление в искусстве XX века, 

характеризующееся разрывом с предшествующим историческим опытом 

художественного творчества, стремлением утвердить новые нетрадиционные 

начала в искусстве, непрерывным обновлением художественных форм, а 

также условностью (схематизацией, отвлечѐнностью) стиля. Модернизм − 

достаточно условное обозначение периода культуры конца ХIХ − середины 

ХХ в., то есть от импрессионизма до нового романа и театра абсурда. Вообще 

понятие модернизма тесно связано не только с искусством, но и с наукой и 

философией. Модернистская парадигма была одной из лидирующих в 

западной цивилизации первой половины XX века; во второй половине века 

она была подвергнута развѐрнутой критике. 

Культурная ситуация первой половины XX века складывалась под 

знаком модернизма. Его искусствоведы понимают двояко − в широком и 

узком смысле. В первом он обозначает всю совокупность художественных 

течений, школ и направлений начала XX века, выразивших отход от 

культурных ценностей XVIII—XIX веков и провозгласивших новые подходы 

и ценности. Фовизм, экспрессионизм, кубизм, футуризм, абстракционизм, 

дадаизм, сюрреализм − таков далеко неполный список направлений 

художественного поиска в начале XX века. 

Главное различие между модернизм и авангардом заключается в том, 

что хотя оба направления стремятся создать нечто принципиально новое, но 

модернизм рождает это новое исключительно в сфере художественной 

формы. Авангард невозможен без активного «художественного 

антиповедения», без скандала, эпатажа. Типичными искусствами модернизма 

являются символизм, экспрессионизм и акмеизм. Типичными искусствами 

авангарда являются футуризм, сюрреализм, дадаизм. 
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Модернизм, как комплексное движение в культуре ХХ века, 

отталкивался прежде всего от «реалистического», позитивистского 

мировосприятия ХIХ века. Позитивизм стремился к описанию 

существующей реальности, модернизм стремился моделировать свою 

реальность. У позитивизма ХIХ века была отчетливо заостренная 

материалистическая установка − реальность первична. Для модернизма 

скорее характерна противоположная установка: идеалистическая − 

первичным является сознание или агностическая − мы не знаем, что 

первично и что вторично, и нам это не важно. 

Для позитивистов ХIХ века наиболее фундаментальным было понятие 

реальности. Для модернизма понятие реальности растворялось в аллюзиях, 

реминисценциях, в зеркальных отображениях одного в другом, и 

фундаментальным становилось понятие текста, который, обрастая цитатами, 

аллюзиями и реминисценциями, превращался в интертекст, а потом уже, в 

эпоху постмодернизма, в гипертекст. 

Модернизм стремится к приукрашенному, мистическому, 

акцентированному отражению мира, а реализм отражает действительность во 

всех ее проявлениях без искажений. 

В ежегоднике 2003 г., составленном участником выставок группы 

«Мемфис» Каримом Рашидом (Лондон), снова представлен веер стилей и 

направлений. На сей раз предложены такие «этикетки»: «Футуретро», 

«Неокич», «Феномены», «Органика», «Приукрашивание», 

«Многосложность», «Минимум», «Техно». 

Ежегодник насыщен довольно странными вещами, само назначение 

которых нередко можно прояснить, только прочитав подпись. Пластиковая 

объемная форма, что-то вроде подлокотника, – для более удобного лежания 

на траве. Белый угловатый объект размером с квадратный диван, но 

треугольной формы с тремя углублениями – своеобразный шезлонг для 

троих. К многим предельно простым креслам или сиденьям пристроены 
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небольшие столики для портативного компьютера. Появилось гораздо 

больше вещей самодостаточных, самостоятельных, вещей-технологий. 

Англичанин Том Диксон экспериментирует с нитями расплавленного 

пластика. В зависимости от цвета и толщины пластикового шнура получается 

то блюдо для фруктов, то стул. Подвесной светильник над обеденным столом 

Карла Отто Платца из Германии совсем не похож на люстру. Фактически это 

горизонтально подвешенный лист толстого прозрачного пластика с 

впаянными внутрь маленькими светодиодами. Динамики стереосистемы, 

придуманные японским дизайнером Хироюки Мацусима, раскачиваются, как 

травинки на тонких ножках, прикрепленные к полусферической подставке. 

Появились предметы, облик которых напоминает коллаж, комбинацию из 

уже готовых технических элементов-заготовок. В них нет ни корпуса, ни 

начинки, иногда отсутствуют даже органы управления − лишь 

дистанционный пульт с кнопками. 

Дизайн начала 3-го тысячелетия опирается на художественное 

творчество, на опыт современного искусства, на развитие эмоционально-

образной составляющей. Современным технологиям доступно практически 

все. Ткань превращается в экран для меняющегося орнамента или 

информационных сообщений; объем и вес вещи исчезают, и остаются лишь 

полезные эффекты; вслед за модой, которая стала уже частью того или иного 

стиля жизни, а не только одеждой, дизайн активно вторгается в манеры и 

формы поведения людей. Поворот современного искусства в сторону 

видеоарта и видеоинсталляций сказывается на интересе дизайнеров к 

соединению вещественного, предметного и виртуального. 
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Лекция 2 

Тема 2 Стиль. Историческая база стилевой классификации 

Стиль в дизайне − художественно-пластическая однородность 

предметно-пространственной среды и ее элементов, выделяемая в процессе 

восприятия материальной и художественной культуры как единого целого. 

Характерный признак стиля − его сравнительное постоянство. Важной 

для дизайна является тесная связь его проявлений с общественными и 

эстетическими нормами эпохи, а также ценностный характер этих 

проявлений. В дизайне стилевое решение часто носит концептуальный 

характер и выражает творческую платформу (например, «хай-тек», «ретро», 

«Мемфис» и пр.). 

Стиль означает характерные для этого художника (группы) приемы 

визуального отображения его творческой концепции. 

Слово «стиль» (лат. stilus, stylus, rp. stylos) происходит от названия 

древнего инструмента для письма — «стиль», или «стило», — заостренного 

стержня из кости, металла, дерева, которым писали, процарапывая текст на 

восковой дощечке или на бересте. 

Стиль − это исторически сложившаяся, относительно устойчивая 

общность признаков образной системы, средств и приемов художественного 

выражения, обусловленная единством идейного содержания искусства. Эта 

общность проявляется одновременно во всех видах искусства (архитектуре, 

литературе, живописи и др.), а также в костюме, предметах труда и быта и 

вытекает из экономической, политической и психологической жизни 

общества. 

Жизнь стиля продолжалась иногда три − пять веков (античный, 

готический). В развитии каждого стиля выделяют три стадии: вначале ему 

присуще нечто демократичное, конструктивное, затем стиль начинает 

приобретать черты декоративности и, наконец, предельной орнаментации 

предмета, которая разрушает конструктивные основы стиля и приводит его к 

гибели. Стиль не создается сознательно, но зависит от закономерного 
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движения диалектического развития созидания и разрушения. В начале 

развития и сложения стиля царствует прикладное искусство, затем на равных 

правах становятся, а иногда получают и предпочтение все другие виды 

искусства, в том числе архитектура, живопись, скульптура. Следует, однако, 

отметить, что в одну и ту же историческую эпоху могут существовать 

несколько художественных направлений, идейные установки которых прямо 

противоположны. 

История стилей констатирует, что существовал стиль «высший» и 

стиль «плебейский». До XIX в., с одной стороны, существовал стиль 

дворянский, придворный, аристократический, а с другой − народный. В этом 

проявляются элементы диалектики стиля, например, труд создавал свою 

одежду и предметы быта и был в противоречии с придворным костюмом. 

Стилевое единство обусловливается научными и техническими 

возможностями эпохи, образом жизни, спиральным развитием общества и 

возвращением к былым ценностям, новым переосмыслениям старого. 

Условно всю историю европейского искусства делят на несколько этапов 

развития, отмечаемых рождением или расцветом стилей: 

античный − Греция (VI в. до н.э. − II в. н.э. условно) и Рим (до V в. 

н.э.); 

византийский (IV − X вв.); 

романский с элементами римско-античной культуры (950 − 1250 гг.); 

готика (1250 − 1520 гг.); 

ренессанс − эпоха Возрождения с одновременным возвращением к 

античным римским формам (1520 − 1650 гг.); 

барокко (1650 − 1770 гг.); 

рококо (первая половина XVIII в.); 

классицизм, или классика (1770 − 1840 гг.), − художественный стиль, 

обращавшийся к античному искусству как к норме и идеальному образцу; 

ампир (начало XIX в.); 

романтизм (1840-е гг.); 
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позже (1840 − 1918 гг.) добавилось понятие «историзм», которое 

объединяет несколько стилей: необарокко, модерн (фр. moderne − новейший, 

современный), рационализм (лат. rationalis − разумный) и постмодернизм (с 

1918 г.); 

эклектика (конец XIX в.); 

модерн (конец XIX − начало XX в.); 

конструктивизм (на рубеже XIX − XX вв.); 

функционализм (начало XX в.). 

Немецкий историк искусства И.Винкельман (1717 − 1768) писал, что 

все прекрасное заимствовано из культуры прошлого. Этим неисчерпаемым 

источником являлась античность (лат. antiquus − древний). Античные 

образцы на протяжении всей истории искусства вдохновляли художников 

многих эпох и питали своими образами различные художественные стили. 

Греческое искусство носило реалистический характер, отражало ценность и 

красоту человеческой личности простым и ясным художественным языком. 

Греки глубоко понимали красоту, которая должна вытекать из 

целесообразности и конструктивной логики. Во всех произведениях 

греческого искусства присутствуют ясность композиции, строгость линий, 

вымеренность пропорциональных соотношений, предельная функциональная 

целесообразность. Греция, прежде всего в искусстве архитектуры и 

скульптуры, заложила основы будущей европейской культуры, ее 

рациональности и, в частности, рационального художественного мышления, 

ставшего, в свою очередь, основой классицизма в искусстве. 

История Древней Греции и соответственно греческого искусства 

прошла следующие периоды развития: 

Гомеровская Греция (XI —VIII вв. до н.э.); 

архаика (гр. archaikos − древний) − период образования 

рабовладельческих городов-государств (VII − VI вв. до н.э.); 

классика − период расцвета греческих городов-государств (ранняя, 

высокая, поздняя). 
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Культура Византийской империи держалась на незыблемых основах 

античной культуры, хотя многое взяла у Востока: пышность в архитектуре, 

богатство декора. Коренное отличие византийской эстетики от античной 

заключалось в следующем: древние греки считали, что боги были сотворены 

поэтами и художниками во всем похожими на человека, а для первых 

христиан сам Бог представлялся великим художником, творящим мир по 

своему плану. 

Становление Византии тесно связано с развитием новой религии − 

христианства. Значительное место в византийском искусстве было уделено 

оформлению церковных интерьеров. Планировка церквей исключительно 

рациональна и основана на сочетании квадратов и кругов, что сообщает их 

внутреннему пространству спокойствие и устойчивость. В Византии впервые 

появляются аркады (фр. arcade − ряд одинаковых по форме и размеру арок) с 

открытой колоннадой (фр. colonnade − ряд колонн). Этот элемент был 

заимствован итальянскими архитекторами Возрождения. Византийцы 

покрывали стены мрамором, дополняя его мозаикой (итал. mosaico, лат. 

musivum − посвященное музам − изображение или узор, выполненные из 

однородных или различных материалов − камня, смальты и др.), росписями и 

витражами (фр. vitrage, лат. vitrum − стекло, орнамент из стекла). Крест стал 

главным изобразительным символом. 

По мысли основоположника византийской эстетики Плотина (ок. 

204/205 − 269/270 гг.), живопись должна избегать кажущихся перспективных 

сокращений размеров и формы предметов, так как это свидетельствует 

только о несовершенстве человеческого зрения. Художник должен 

изображать их такими, какими мы видим их вблизи при ярком освещении 

локальным светом, без светотени, потому что свет есть духовная категория, 

так же как тень − символ зла. 

Эпоха Возрождения (соответствует французскому слову 

«ренессанс») − переломная эпоха в развитии мирового искусства. Художники 

того времени возрождали античные формы, но вкладывали в них новое 
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содержание. Эта эпоха в противовес мрачному католическому 

миропониманию средних веков создала новое жизнеутверждающее 

мировоззрение, ознаменовалась великими открытиями, замечательными 

образцами реалистического искусства. В эпоху Возрождения жили и творили 

Франческо Петрарка (1304 − 1374), Леонардо да Винчи (1452 − 1519), 

Николай Коперник (1473 − 1543), Микеланджело Буонарроти (1475 − 1564), 

Рафаэль Санти (1483 − 1520), Джордано Бруно (1548 − 1600). Живопись 

освободилась от абстрактной духовности, свойственной ей в Средневековье 

двухмерности. Стало развиваться учение о перспективе и объеме. 

Художники эпохи Возрождения благодаря античной классике начинали 

осознавать, что самой прекрасной формой в природе является человеческое 

тело. Соединение христианской идеологии с чувственностью в 

изобразительном искусстве отразилось в образах Мадонны. Появились 

новые, лишенные средневековой мрачности, соразмерные человеку формы 

архитектурной и предметной среды, связанные главным образом с 

возрождением античных ордеров. Характерным элементом орнамента эпохи 

ренессанса является раковина. 

Барокко (итал. barocco − вычурный) − главенствующий стиль в 

европейском искусстве XVII − XVIII вв. Это динамичный, аффектированный 

стиль, которому свойственны театральность, фееричность, иллюзорность. Он 

утвердился в эпоху расцвета мануфактурного производства и 

одновременного усиления феодально-католической реакции. В то же время 

он отразил новые представления о единстве, безграничности, многообразии 

мира. Для барокко характерно стремление к взаимодействию различных 

видов искусства, образованию монументально-декоративного единства − 

ансамбля (фр. ensemble − совокупность, стройное целое). Этому стилю 

присуще исчезновение конкретной формы, т.е. состояние неустойчивости. 

Каждая деталь в художественных произведениях так подчинялась целому, 

что терялась не только ее самостоятельность, но и индивидуальность. Одним 

из выразительных средств стиля барокко было неправдоподобие масштабов, 
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чрезмерно увеличенные детали. Основополагающий принцип классики − 

соразмерность человеку − был заменен прямо противоположным − 

несоответствием, иррациональностью, фантастичностью. В изобразительном 

искусстве преобладали декоративные композиции религиозного, 

мифологического и аллегорического характера, отличающиеся особой 

театральностью и блеском. 

В орнаментальном искусстве художники стиля барокко использовали 

элементы ренессанса: раковины, ионические киматии (криволинейные 

детали), акант (стилизованное изображение листьев), усложняя и наполняя 

эти формы внутренним напряжением, экспрессией. В орнаментах 

присутствуют бандельверки (прихотливые мотивы ленточного плетения), 

картуш и (изображения полуразвернутого рулона). 

Важной составной частью стиля барокко является мебель, 

отличающаяся укрупненностью и утяжеленностью форм, пышностью и 

сочностью резного декора. В эпоху Возрождения мебель делали из дуба, в 

стиле барокко − из ореха, более пригодного для резьбы и полирования. 

Мебель постепенно приобретает все более сложные криволинейные 

очертания, роль резного декора берут на себя бронзовые накладки. В 

качестве обивочного материала использовали глазет, гобелены с бахромой и 

кистями. Вкусам стиля барокко в полной мере отвечают толстостенные 

изделия из богемского хрусталя: кубки, вазы, стаканы с алмазной гранью и 

гравировкой. 

Соборы XVIII в. с обилием многоцветных архитектурных украшений, 

роскошные дворцы с зеркальными стенами и потолками-сводами, тяжелой 

величественной мебелью из черного и красного дерева, инкрустированной 

серебром и бронзой, создавали единое целое с обликом человека, его 

костюмом и манерой поведения. В костюме исчезла линия, подчеркивающая 

пропорции человеческого тела, на смену одежде пришли женские 

металлические корсеты и плоеные воротники испанских костюмов. Новый 

костюм стал многослойным, вычурным, ненатуральным.  
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Рококо (фр. rococo, rocaill − раковины) часто называют галантным 

стилем. В какой-то мере рококо явился продолжением стиля барокко, но 

приобрел и свои собственные черты. Общим для всех европейских стран в 

этот период является формирование нового класса − буржуазии, новой 

общественной идеологии. Вместе с тем это была эпоха просвещения. Стиль 

рококо утверждался в архитектуре интерьеров, живописи, прикладном 

искусстве. Для него характерно отсутствие глубокого идейного содержания, 

стремление к уходу от действительности в мир легких иллюзий, эротики, 

изысканных, утонченных переживаний, прихотливая орнаментальность 

формы, отличающаяся асимметричностью и сложностью извилистых линий. 

Раковина, от которой произошел стиль рококо, трансформировалась со 

времени эпохи ренессанса в причудливый завиток с двойным С-образным 

изгибом. Обломки скал, покрытые морскими раковинами, лилии, рокайли, 

амуры − главные мотивы декора. Для внутреннего убранства зданий широко 

применяли живописные панно в сложных обрамлениях раковин, 

многочисленные зеркала, люстры, изящную мягкую мебель с мелкими 

лепными украшениями. Очень популярны были безделушки: фарфоровые 

статуэтки, вазы, шкатулки, которые являлись неотъемлемой частью 

интерьера, мода на все экзотическое, необычное, главным образом на 

восточное китайское искусство.  

В период перехода от феодального строя к буржуазному формируется 

стиль классицизм (лат. classicus − первоклассный, образцовый). 

Отличительная черта стиля − новое обращение к античному искусству как к 

норме и идеальному образцу. Внимание архитекторов привлекли строгость и 

спокойствие античной, главным образом ордерной, архитектуры: простота 

общего решения основных объемов и планов, конструктивность и 

благородство пропорций, обилие горизонтальных и вертикальных членений. 

19-е столетие вошло в историю как время быстро меняющихся 

художественных стилей. Начало века характеризуется появлением в 

искусстве стиля ампир (фр. empire − империя) − поздний классицизм. За 
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основу на этот раз были взяты формы искусства Древнего Рима. Ампир 

выражал эстетические вкусы крупной буржуазии и прославлял военные 

победы Наполеона. Ведущая роль в формировании нового стиля 

принадлежала французскому живописцу Жак Луи Давиду (1748 − 1825). 

Характерными элементами орнамента были древнеримские лавровые венки, 

луки, стрелы, пальмовые ветви, львы. Наряду с древнеримскими можно 

заметить и мотивы египетского искусства. Плотными симметричными 

рядами располагались орнаментальные рельефы, росписи на дворцовых 

стенах и мебели. Стиль ампир был строго выдержан в прикладном искусстве, 

массивной, хорошо отделанной мебели с подчеркнуто геометрическими 

линиями и формами. 

В 1840-х гг. появился новый стиль − романтизм (фр. romantisme), 

который во Франции называли стилем Людовика Филиппа, а в Германии − 

бидермайер (ок. 1815 − 1848). 

Искусство бидермайера провинциально. В противовес пышности и 

величественности столичного ампира оно выдвинуло идею простоты и 

практичности, стремления к уюту и комфорту. В оформлении интерьера 

особенно ценились тщательность отделки, естественная фактура и свойства 

материала. На первом плане в живописных и графических произведениях 

художники бидермайера показывали «незначительные» бытовые 

подробности юмористического или сентиментального характера (семейные 

сцены, портреты на фоне интерьера, сцены с детьми). В бидермайере 

соединились элементы ампира, английского классицизма, лиричность 

романтизма и привычный уклад жизни немецкого бюргерства. 

В Петербурге направление бидермайер появилось во времена Пушкина. 

Большим спросом пользовались небольшие письменные столы, секретеры, 

бюро, уютные мягкие диваны, кресла, маленькие угловые шкафчики, 

этажерки и т.д. Античность перестала быть образцом для людей. Идеалом 

человеческой красоты стали большие глаза, маленькие ручки и ножки, 

большие бедра.  
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В конце XIX в. в Европе и России процветала эклектика 

(гр. eklektikos − способный выбирать, выбирающий) − искусственное 

соединение разнообразных стилей. В Англии это был так называемый 

викторианский стиль (по имени королевы Виктории). В наиболее типичных, 

массовых проявлениях искусство этого стиля отражало мещанские вкусы 

представителей нового «среднего» класса, которые в поисках быстрой 

прибыли и атрибутов роскошной жизни примеряли на себя все подряд − 

неоготику, ампир, неорококо, необарокко. Из относительно дешевых 

материалов создавали суррогат, иллюзию роскоши, декорации из мешанины 

византийского, мавританского, китайского и других стилей. Негативную 

роль в формировании и распространении эклектизма сыграло машинное 

производство, наводнившее рынок дешевыми подделками под старину 

(«роскошная резьба» из папье-маше, «бронзовые» светильники из крашеного 

гипса). 

На смену эклектизму XIX в. пришел стиль, получивший в России 

название модерн (фр. moderne − новый, современный), ар нуво − во Франции 

и в Англии, югендстиль − в Германии (от названия мюнхенского журнала 

«Югенд»), Хронологические рамки этого стиля − 30 лет. На искусство 

модерна современниками возлагались большие надежды. Все новое в нем 

формировалось в области архитектуры и декоративно-прикладного искусства 

не столько самими архитекторами, сколько живописцами и графиками. 

Основные черты стиля: тенденция к комплексному решению архитектурно-

планировочных и декоративных задач − особое внимание уделялось 

оформлению интерьера, изысканным живописным эффектам, увлечению 

текучими формами, как бы воспроизводящими формы живой природы, 

преобладанию растительных орнаментов (стилизованные лилии, ирисы, 

орхидеи). 

За советской архитектурой и оформлением интерьеров сталинского 

периода 1930 − 1950-х гг. закрепилось название «советский ампир», 

отражавшее имперский характер идеологии и политики в искусстве. В этом 
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стиле были оформлены станции московского и ленинградского 

метрополитена, поражавшие невиданной по тем временам роскошью 

отделки, мозаичными панно, скульптурой и декоративными решетками, на 

которых эмблемы легионеров Древнего Рима чередовались с пятиконечными 

звездами, серпом и молотом, дубовыми листьями. Однако архитектура 

«сталинских» домов до сих пор привлекает прочностью, добротностью, 

широтой и комфортабельностью планировок, духом искренней радости и 

бодрости. Как и любая эклектика, «советский ампир» не является 

действительно художественным стилем. 

Романтизм − это мощное художественное направление, в основе 

которого лежал творческий метод, провозглашавший своим главным 

принципом абсолютную и безграничную свободу личности. Сутью 

романтического мировосприятия является признание драматически 

неразрешимого противоречия между низменной действительностью и 

высоким идеалом, несовместимым с нею, а подчас и вообще нереализуемым. 

В романтизме главное − не показ индивидуализма, а героика - патетическое 

прославление одиночества. 

Для романтизма как художественного стиля характерно 

противопоставление классицистскому «подражанию природе» творческой 

активности художника, с его правом на преображение реального мира. 

Романтизм стимулирует отрицание нормативности в создании произведений 

искусства и выступает за обновление художественных форм. Художник 

создает именно свой особый мир, более прекрасный, чем реальный. Понимая 

искусство как высшую реальность, романтизм стимулирует ассоциативность 

художественного мышления и взаимопроникновение различных видов и 

жанров искусства. Произведения романтиков наполнены чувствами восторга 

и разочарования, воодушевления и отчаяния. Эти душевные колебания 

создавали ощущение непостижимости действительности, вечной загадки 

мира, признание невозможности его полного духовного познания. 
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Гетерогенность романтического стиля породила неустойчивость всей 

художественной системы в целом. 

Романтическая эпоха − это время небывалого расцвета музыки (Ф. 

Шопен, Г. Берлиоз, Ф. Шуберт, Ф. Лист), живописи (Э. Делакруа, Т. Жерико, 

Д. Констебл, О. Кипренский) и литературы (В. Скотт, А. Дюма, Э. Гофман, Г. 

X. Андерсен, Ф. Купер). В романтическую эпоху люди почувствовали 

движение времени, общественные перемены, что сопровождалось 

небывалым интересом к народной культуре, ее истокам и к росту 

национального самосознания во многих европейских странах. 

Классическими странами романтизма являлись Германия, Франция, Англия. 

Крушение иллюзий переживалось мучительно. Это и было идейной 

почвой романтизма, в основе которого лежит резкое недовольство 

окружающей действительностью. 

Параллельно с романтизмом и в тесном взаимодействии с ним в 30 – 

40-е годы XIX века складывается и утверждается особая разновидность 

реалистического искусства – критический реализм (от позднелатинского 

слова realis – вещественный, действительный). Его общественно-

политическим фоном явилось обострение социальных противоречий в 

капиталистическом обществе. 

Наиболее значительными были достижения реализма в литературе, 

прежде всего в прозе. Критическая литература выдвинула в качестве 

основного жанра социальный роман, главный пафос которого состоит в 

обличении нравов современного буржуазного общества. Излюбленной темой 

искусства становится тема социальной несправедливости, сломанная 

несправедливым общественным устройством человеческая судьба. 

В отличие от писателя-романтика, реалист не «бежит» от окружающей 

действительности, а напротив, прослеживает влияние общества на жизнь 

человека. Главный вопрос, на который он ищет ответ – «кто виноват?». 

Понимание реализма как правды жизни имеет давнюю культурную 

традицию и проходит ряд исторических этапов. Первой попыткой 
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теоретического осмысления понятия «реализм» можно считать античный 

мимесис («подражание природе» в трактовке Аристотеля), затем эта 

проблема стала ключевой в теоретическом наследии мыслителей 

Возрождения. Особое истолкование реалистическое «свободное подражание» 

получает в трудах Г. Лессинга и Д. Дидро. Однако целостное понимание и 

сам термин «реализм» возникает в 20-е годы XIX в. и его значение 

усиливается к середине столетия. 

Реализм XIX в. принято называть критическим реализмом. Ему 

свойственно: 

- глубинное постижение жизни; 

- широкий охват действительности; 

- художественное осмысление всех ее противоречий. 

Художник-реалист показывает взаимоотношения и взаимовлияния 

человека и среды, проявляя подлинно энциклопедические познания. Не 

случайно многие сочинения приобретают характер социального 

исследования: («Красное и черное» Ф. Стендаля). В реалистическом 

искусстве характер человека трактуется как противоречивое и 

развивающееся единство. Проявление характера обусловлено средой 

обитания и обстоятельствами жизни. Характер может меняться от 

содержания этих условий, в зависимости от переживаемого момента. 

Натурализм (франц. naturalisme, от латин. Nature – природа) –

художественный метод, сложившийся в западноевропейской и американской 

культуре последней трети XIX века под влиянием философии позитивизма 

О. Конта, Г. Спенсера, И. Тэна и др. 

В соответствии с методологией позитивизма, природа искусства 

объяснялась посредством представлений, заимствованных у естествознания. 

В своих произведениях художник-натуралист должен абсолютизировать 

первооснову бытия, стремиться к внешнему правдоподобию деталей, 

протокольному описанию, изображению единичных явлений. При этом 

влияние социального фактора явно преуменьшается. Первостепенное 
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значение натуралисты придавали точному описанию фактов 

действительности, «кусков жизни», усматривая в подобном описании 

непременное условие правдивости искусства. Таким образом, натурализм 

ставил перед художником две задачи: 

- достигнуть правдивого, а точнее жизнеподобного изображения 

современной жизни; 

- дать в художественном произведении ее правдивую интерпретацию, 

основанную на методе и достижениях естественных наук. 

Натурализм возник и оформился, прежде всего, во Франции. 

Своеобразным манифестом натурализма стала работа И. Тэна «Введение в 

историю английской литературы» (1864), в которой автор выдвинул триаду - 

«раса», «среда», «момент» как единственно возможные и реальные причины 

эволюции индивида в области культуры. Причем, своеобразие «расы» 

сводилось к воздействию на человека как на биологическую особь - среды, 

климата, питания, характера местности и т. д. Приверженцы натурализма в 

искусстве рассматривали человека как пассивный результат неотвратимого 

воздействия наследственности и материальной среды. Следует заметить, что 

в этот период натурализм начинает тяготеть к документальности, достаточно 

широко вводит документ в искусство. В 70-80-е годы XIX века натурализм 

поднимал очень важные темы: 

- детально показывал жизнь обездоленных и угнетенных; 

- исследовал механизмы взаимодействия человека и среды с целью ее 

разумной организации; 

- активизировал внимание на роль бессознательных моментов в 

человеческой психике. 

На рубеже XIX-XX веков художественные приемы натурализма будут 

востребованы в отдельных направлениях модернизма. Среди писателей 

наиболее известными приверженцами натурализма являются французы − 

братья Э. и Ж. Гонкуры, Э. Золя, Г. де Мопассан; немцы – А. Хольц и 

Г. Гауптман; англичанин – Дж. Мур.  
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Импрессионизм (от фр. impression – впечатление) – художественное 

направление, возникшее во Франции в 60-70-х годах XIX века и получившее 

наиболее яркое воплощение в изобразительном искусстве, художественной 

литературе, музыке, скульптуре. Импрессионизм предстает как последнее 

цельное художественное течение во Франции XIX века, отмеченное общими 

стойкими стилистическими признаками. Среди художников следующего 

поколения такого единства уже не было. 

Признаками импрессионистического стиля является: 

- отказ от замкнутости и стабильности изображения объектов; 

- фрагментарность композиций, фиксирующих мгновенные, как бы 

случайные ситуации; 

- неожиданные ракурсы, срезы фигур и предметов. 

Импрессионизм особенно ярко заявил о себе в живописи. Художники-

импрессионисты (О. Ренуар, Э. Мане, Э. Дега, К. Моне, К. Писсаро) с 

помощью новых живописных приемов стремились передать красоту 

мимолетных состояний природы, подвижность и изменчивость человеческой 

жизни. Пейзаж, воспроизводящий динамичную и красочную жизнь природы, 

стал ведущими жанром импрессионизма. Свои пейзажные работы художники 

писали на открытом воздухе (пленэре), передавая с помощью чистой, светлой 

живописи ощущение сверкающего солнечного света. Следует отметить, что 

работа на пленэре, творческий контакт с природой вызвали к жизни и новую 

живописную технику, которая особенно проявилась в цветовом решении 

полотен. Пленэр развил у импрессионистов не только обостренное 

восприятие локального цвета, но и тончайшее ощущение цветовой гаммы, 

которая видоизменялась в зависимости от освещения и состояния воздушной 

среды. В своем творчестве импрессионисты исходили из доверия к природе 

как объективной данности. Они были убеждены, что мир природы 

невозможно отделить от его восприятия. А себя они осознавали как 

своеобразных посредников между миром природы и людьми, которые 

призваны раскрывать людям красоту этого мира. 
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Постмодернизм (фр. postmodernisme — после модернизма) — термин, 

обозначающий структурно сходные явления в мировой общественной жизни 

и культуре второй половины XX века и XXI века: он употребляется как для 

характеристики постнеклассического типа философствования, так и для 

комплекса стилей в художественном искусстве. Постмодерн — состояние 

современной культуры, включающее в себя своеобразную философскую 

позицию, постмодернистское искусство, а также массовую культуру этой 

эпохи. 

Постмодернизм – самостоятельное направление в искусстве 

(художественный стиль), означающее радикальный разрыв с парадигмой 

модернизма (Г. Хоффман, Р. Кунов). По мнению же X. Летена и 

С. Сулеймена, постмодернизма как целостного художественного явления не 

существует. Можно говорить о нѐм как о переоценке постулатов модернизма, 

но сама постмодернистская реакция рассматривается ими как миф. 

В трактовке Умберто Эко постмодернизм в широком понимании – это 

механизм смены одной культурной эпохи другой, который всякий раз 

приходит на смену авангардизму (модернизму) («Постмодернизм – это ответ 

модернизму: раз уж прошлое невозможно уничтожить, ибо его уничтожение 

ведет к немоте, его нужно переосмыслить, иронично, без наивности»). 

Объявленным «началом» постмодернизма считают статью Лесли 

Фидлера, 1969, «Пересекайте границу, засыпайте рвы», демонстративно 

опубликованную в журнале Playboy. Американский теолог Харви Кокс в 

своих работах начала 70-х годов, посвящѐнных проблемам религии в 

Латинской Америке, широко пользуется понятием «постмодернистская 

теология». Однако популярность термин «постмодернизм» обрѐл благодаря 

Чарльзу Дженксу. В книге «Язык архитектуры постмодернизма» он отмечал, 

что хотя само это слово и применялось в американской литературной 

критике 60—70-х годов для обозначения ультрамодернистских литературных 

экспериментов, автор придал ему принципиально иной смысл. 
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Постмодернизм означал отход от экстремизма и нигилизма 

неоавангарда, частичный возврат к традициям, акцент на коммуникативной 

роли архитектуры. Обосновывая свой антирационализм, антифункционализм 

и антиконструктивизм в подходе к архитектуре, Ч. Дженкс настаивал на 

первичности в ней создания эстетизированного артефакта. Впоследствии 

происходит расширение содержания этого понятия с первоначально узкого 

определения новых тенденций в американской архитектуре и нового течения 

во французской философии (Жак Лакан, Луи Альтюссер, Ж. Деррида,  

Ж.-Ф. Лиотар, Мишель Фуко) до определения, охватывающего начавшиеся в  

60 − 70 годы процессы во всех областях культуры, включая феминистское и 

антирасистское движения. 

Постмодернистское искусство отказалось от попыток создания 

универсального канона со строгой иерархией эстетических ценностей и 

норм. Единственной непререкаемой ценностью считается ничем не 

ограниченная свобода самовыражения художника, основывающегося на 

принципе «всѐ разрешено». Все остальные эстетические ценности 

относительны и условны, необязательны для создания художественного 

произведения, что делает возможным потенциальную универсальность 

постмодернистского искусства, его способность включить в себя всю 

палитру жизненных явлений, но также зачастую приводит к нигилизму, 

своеволию и абсурдности, подстраиванию критериев искусства к творческой 

фантазии художника, стиранию границ между искусством и другими 

сферами жизни. 

Отличие постмодернизма от модернизма. Возникший как антитеза 

модернизму, открытому для понимания лишь немногим, постмодернизм, 

облекая всѐ в игровую форму, нивелирует расстояние между массовым и 

элитарным потребителем, низводя элиту в массы (гламур). Модернизм − это 

экстремистское отрицание мира Модерна (с его позитивизмом и 

сциентизмом), а постмодернизм − это неэкстремистское отрицание все того 

же Модерна (таблица 1). 
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Таблица 1 Сравнительная таблица по Брайнину-Пассеку 

Модернизм Постмодернизм 

Скандальность Конформизм 

Антимещанский пафос Отсутствие пафоса 

Эмоциональное отрицание 
предшествущего Деловое использование предшествующего 

Первичность как позиция Вторичность как позиция 

Оценочность в самоназвании: «Мы — 
новое» Безоценочность в самоназвании: «Мы — всѐ» 

Декларируемая элитарность Недекларируемая демократичность 

Преобладание идеального над 
материальным Коммерческий успех 

Вера в высокое искусство Антиутопичность 

Фактическая культурная 
преемственность Отказ от предыдущей культурной парадигмы 

Отчетливость границы искусство-
неискусство Всѐ может называться искусством 

Характерные особенности стилей (таблица 2). 
Таблица 2 Характерные особенности стилей 

Стиль Преобладающие 

модные цвета 

Линии Форма 

Романский Коричневый, 

красный, зеленый, 

белый 

Бочарные, 

полуциркульные, 

прямые, 

горизонтальные, 

вертикальные 

Прямоугольная, 

цилиндрическая 

Готика Желтый, красный, 

синий 

Стрельчатые, 

ребристо-

повторяющиеся 

Прямоугольная в 

плане, удлиненная по 

вертикали 

Ренессанс 

(Возрождение) 

Пурпурный, синий, 

желтый, 

коричневый 

Полуциркульные, 

геометрические 

(круговые, 

Арки, колоннады, 

круглые купола 
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квадратные, 

крестовые, 

восьмиугольные) 

Барокко (рококо) Приглушенные 

пастельные, 

красный, розовый, 

белый, голубой с 

желтым акцентом 

Причудливые 

выпукло-вогнутые 

асимметричные, 

вертикальные и 

горизонтальные 

Сводчатая, 

куполообразная, 

овальная 

Классицизм 

(ампир) 

Насыщенные, 

зеленый, розовый, 

пурпурный с 

золотым акцентом, 

небесно-голубой 

Строго 

повторяющиеся 

вертикальные и 

горизонтальные 

Четкая 

геометрическая, 

монументальная 

Историзм 

(необарокко, 

модерн, 

рационализм) 

Неяркие светлые, 

лиловый, светло-

зеленый, 

коричневый 

Сочетание тонких и 

толстых, 

вертикальные, 

горизонтальные, 

плавно текучие, 

изменяющиеся по 

толщине 

Лаконичная, 

прямоугольная, 

шарообразная, 

цилиндрическая 

Постмодернизм Бежевые, 

серебристый, 

«металлик», 

перламутровый, 

флюоресцентный 

Динамичные, 

свободные 

Рациональная и 

свободная, 

симметричная и 

асимметричная, 

трансформа 
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Лекция 3 

Тема 3 Приемы получения изображений в графическом дизайне 

Графический дизайн − художественно-проектная деятельность по 

созданию гармоничной и эффективной визуально-коммуникационной среды. 

Можно выделить три основных элемента, которые стоят у истока 

любого произведения, будь то живопись, графика, дизайн или архитектура. 

Это точка, линия и пятно. 

Точка – простейший элемент визуального дизайна. Она не имеет 

направления по вертикали и горизонтали. Среди других изобразительных 

средств точка статична. Она служит в качестве фокуса изображения, выделяя 

важную информацию или притягивая к ней внимание. Даже если на чистом 

листе бумаги присутствует только одна точка, одна метка, наш мозг 

непременно старается придать этому какое-то значение, пытается найти 

какую-нибудь связь или закономерность, либо использовать эту точку в 

качестве отправной. Если точек две, глаз немедленно пытается их 

«соединить» и создает воображаемую линию между ними. Если точек три, 

неизбежно наше сознание рисует треугольник; сознание достраивает то, чего 

нет. Это невольное соединение точек называется группировкой или 

гештальтом (gestalt). Множество точек способно воспроизвести качество 

тона, цвета, его переходы и смешения (например картины пуантилистов 

Синьяка и Сѐра). 

Увеличиваясь в размерах, точка становится пятном, обладающим своей 

площадью и границами. С использованием пятна значительно расширяется 

палитра средств построения графической композиции. Пятна могут быть 

геометрическими или аморфными. Основные формы пятна это квадрат, 

треугольник, круг и «амѐба» (бесформенное пятно) (рис.1). 
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Рисунок 1 – Точка, пятно 

 

Точки или пятна можно эффективно использовать в изображениях: 

Подчеркнуть ключевую идею. Привлечь внимание. Представить более 

сложный объект или идею, но при этом сохранить чистоту и упрощенность 

изображения. 

Размер точки имеет свои изобразительные возможности. Зрительно 

объекты разделяются по размеру на большие, средние и малые. Располагая 

рядом точки разного размера, можно создать иллюзию глубины 

пространства. Работая с плоским листом бумаги, можно изменять не только 

размер точки, но и ее тон. Расстояние между точками – еще одна 

изобразительная возможность формирования различных пространственных и 

временных характеристик изображения. Статичное расположение точек дает 

ощущение покоя, в то время как перераспределение объектов за счет 

изменения расстояний создает динамическое напряжение, иллюзию 

движения. Форма точки, гладкая или колючая, насыщает изображение 

своими эмоциональными импульсами. Также форма имеет значение для 

«фактора сходства», по которому группируются элементы, кажущиеся 

похожими. Перечисленные возможности изобразительных средств точек 

обладают значительным диапазоном графического разнообразия. Офорт, 

гравюра, литография – печатные техники, в основе которых лежат точечные 

изображения. Иллюзии объема, глубины, движения достигаются за счет 

изменения параметров точки, ее размера, формы, тона, расстояния, в 
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результате чего получается технически уникальное изображение. По 

отношению к точке и ее применению определяется основное отличие техник 

печати. Точка – это первооснова графики. Перемещаясь по плоскости, точка 

оставляет за собой след – линию. 

Линия, в отличие от замкнутых и статичных точки и пятна, является 

изображением движения. В этом смысле она – антипод точке, но и 

порождение еѐ: ведь линия – это след движения точки. Линии по-разному 

динамичны. Прямая – равномерна и императивна, кривая – свободна и гибка. 

Благодаря изменениям своей толщины, линия создаѐт волнообразные 

движения плоскости, на которой она начертана. Линия может то погружаться 

вглубь, то выйти наружу, то подчиниться фону, то победить его. Она 

обладает эмоциональным воздействием, может быть жесткой и однозначной, 

прерывистой и трепетной. Предполагают, что изобразительное искусство 

началось с линии, очерчивающей силуэты теней, падавших от света очага на 

стены жилища. Линия – праматерь искусства, еѐ исконное назначение – 

абрис контура формы. И это главное конструктивное качество линии. Она 

может быть использована и иначе: линии, перечеркивающие друг друга, 

получают способность передавать цветотональные характеристики или, 

сопровождая собой направления формы, «лепят» объем. Линии можно 

сочетать с другими линиями и создавать текстуры и узоры (рис.2). 

 
Рисунок 2 – Линия 
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Изменяющаяся толщина линии (нажим – дополнительный импульс 

выражения силы) придает выразительный и энергичный характер линии. 

Активная линия, выраженная в своей динамике, благодаря приложенной 

автором энергии, самодостаточна. Таким образом, линия может быть: 

плавной и спокойной, вертикальной и горизонтальной, сплошной и 

прерывистой, волнистой, прямой и изогнутой, легкой и тяжелой, жирной, 

тонкой и разнотолщинной, фактурной, тоновой, разноцветной, и т.д. 

При создании композиций на компьютере в графических редакторах 

используют готовые типы линий, которые подбирают в соответствии с 

композиционной задачей, или создают новые типы линий в электронном 

формате. 

Линия условна, являясь лишь границей различных форм. 

Трансформируя линию, можно создавать разнообразные формы, простые и 

сложные. 

Линия обладает следующими свойствами: пластичностью, упругостью, 

определенным направлением, способностью связывать и разделять элементы. 

Линейно-графически формируются условные графические символы, 

стрелочные указатели и цифро-буквенные обозначения, схематически 

моделируются связи, визуально-динамически выражается движение, 

направление и расстояние, т.е. линия как выразительное средство не только 

экономна, но и универсальна. В линейной графике адекватно 

воспроизводится зрительный образ любого объекта, благодаря уникальности 

линейной структуры его формы. 

Характер линии, ее пластика заключают в себе информационную 

основу создания знаковых систем. 

Выделяют несколько типов линий, выражающих различные 

характеристики линейной графики. 

Ровная линия – это граница, черта, раздел, система членения. Данная 

линия может быть спокойной, она может не нести никакой эмоциональной 

окраски, ее главная функция – ограничение. Подобные линии встречаются в 
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чертежах, схемах, таблицах. Это часть информационного обеспечения 

любого процесса. Графика может быть выполнена инструментами, дающими 

линию ровной толщины. 

Напряжение в таком случае создается за счет группировки линий, из 

ритмики их изгибов, изломов. 

Горизонтальные линии ассоциируются с основательностью, 

спокойствием, тишиной. 

Вертикальные линии передают движение вверх, рост, подъем, 

торжественность. 

Наклонные восходящие линии (активные) вызывают ассоциации, 

связанные с ростом, надеждой, подъемом, взлетом. Наклонные нисходящие 

(пассивные) ассоциируются с падением, спадом, нестабильностью, 

бессилием, грустью. 

Пунктирная линия несет в себе иную знаковую сущность. Такая линия 

встречается в построениях аксонометрии, в проектных схемах. Разрывы 

линейной структуры не мешают ее восприятию, но вводят ее в разряд 

нереальной. Эта линия как бы невидима, она предполагается проектом, 

системой, общим ощущением. Пунктирная линия в графике создает 

интервал, «воздух», соподчиняется основному, более выразительному 

движению. Пульсирующая линия более динамична по своим 

характеристикам, обладает бóльшей графической выразительностью. 

Характер элементов, расположенных на линии, будь то точки, зигзаги или 

иные преобразования, их частота и размер задают линейной структуре ту или 

иную степень пульсации, беспокойства, нервозности. Данная линия передает 

эмоции автора, его переживания, определяет характеристики объекта, его 

состояние 

Ломаная линия (зигзаг) ‒ линия, состоящая из системы острых углов. 

Она ассоциируется с агрессивностью и неуравновешенностью. Чем острее 

углы зигзага, тем напряженнее, агрессивнее и динамичнее состояние 
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графики. Тупой угол, формирующий зигзаг, внешне схож с волной, а потому 

передает более спокойное состояние, лишенное внешней агрессии. 

Волнообразная линия, в основе которой плавная, округлая пластика, 

придает изображению особую лиричность, мягкость, умиротворение или 

ускоряющееся движение. 

Форма спирали передает состояние движения, скорость. Закрученная 

спираль символизирует развитие, жизнь. 

Различие в восприятии этих систем обусловлено особенностями 

пластики, углов наклона, диапазоном линейных разрывов. Дополнительную 

энергию во всех перечисленных случаях задает выраженное изменение 

толщины линии.  

Изменение толщины линии ‒ особый способ придания 

выразительности графике. Кандинский писал: «Помимо разницы 

характеров... первоначальный источник каждой линии неизменно один – 

сила. Нажим – дополнительный импульс выражения силы»[14]. 

Повороты и наклоны линий прорывают плоскость листа, уводя зрителя 

в глубину пространства. На основе линейной перспективы мы можем 

моделировать любое глубинно-пространственное изображение, пользуясь 

только линиями, даже не изменяя их толщину. 

Расположение линии на формате листа, ее направление формирует 

отдельные особенности зрительного восприятия. Например, вертикальная 

линия задает движение глаза снизу-вверх или наоборот. Горизонтальная 

линия выражает равномерное или бесконечное движение. Если мы хотим 

остановить это движение, то вычленим часть линии. По отношению к 

вертикали горизонтальная линия более весома, значительна. 

Диагональные линии задают особую динамику графической 

композиции. Движение линий в противоположных направлениях создает 

ощущение тревоги, противоречия. Линейное движение слева-направо более 

привычно для нашего зрения: мы так читаем. Соответственно, движение 

линий из левого нижнего угла в правый верхний угол оставляет позитивное 
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ощущение. Направление из правого нижнего угла в левый верхний угол 

задает напряжение, появляется ситуация преодоления. Движение линий 

сверху вниз сродни состоянию падения. 

Группировка линий имеет свои изобразительные возможности. Данный 

способ формирует плоскость за счет изменения расстояния между линиями 

по «фактору близости» или за счет изменения размера линий. Полосы на 

плоскости могут быть спокойными, монотонными или динамически 

организованными системами. 

Изменение толщины линий и расстояний между ними ‒ способ 

формирования иллюзии объема, глубины пространства. Эти возможности 

группировок линий используются в тональном и штриховом рисовании. 

Линия ‒ форма мышления художника. Она используется в набросках, 

эскизах, плакатах, чертежах и рисунках, в архитектуре и живописи, и т.д. 

Линия ‒ основа проектирования в дизайне. Первые эскизы конструкций, 

поиски объемов появляются в линейном виде и только потом преобразуются 

в проекционную проектную графику, в которой чертежная линия 

стандартизирована. Жесткая, четкая и однообразная, она непригодна для 

художественных целей в случае выполнения рабочих чертежей. Вместе с тем, 

в архитектурной графике группировка чертежных линий разной толщины 

может создавать художественный эффект. 

Выразительные свойства линии. Определенные расположения линий 

несут в себе определенное значение. Например, каллиграфия – это искусство 

представления слов. Каллиграфические изображения часто используются 

современными художниками только просто потому, что они содержат в себе 

некие таинственные послания на неизвестном языке (рис.3).  
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Линии на картах четко распознаются как символические обозначения 

места. Местом может быть как окружение по соседству, так и весь мир. Это 

может быть либо тщательная схема-план, либо стилизованная диаграмма, как 

например, схема метро. В других случая, линии выступают как средство, 

позволяющее определить взаимоотношение/связь между местами; например, 

на схеме «как пройти отсюда туда». 

Планы помещений – это специфические карты, которые повсеместно 

используются для описания зданий. Этот язык линий понятен даже в тех 

случаях, когда строение само по себе необычно. Графики – еще один 

распространенный метод использования линий. Они широко используются 

для передачи числовой информации и визуального отображения различных 

связей. Графики используются повсюду, мы знаем о них с первых уроков 

алгебры, и встречаем их в каждом номере газеты. С помощью толщины и 

направления линий можно передавать настроение и состояние эмоций. 

Смысл, который несут различные линии, во многом зависит от нашего 

жизненного опыта − что чувствует наше тело в связи с различными 

направлениями. 

 
Рисунок 3 – Каллиграфия 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



Горизонтальные линии создают ощущение покоя или отдыха. Объекты, 

которые расположены параллельно земле, покоятся относительно линии 

силы притяжения. Следовательно, композиции, где доминируют 

горизонтальные линии, несут в себе заряд спокойствия. Вертикальные линии 

создают ощущение высоты, полета и воздушности. Они кажутся 

устремленными бесконечно в небо, за пределы сознания человека. Их часто 

используют в общественных зданиях, от соборов до офисов корпораций. 

Вытянутые перпендикулярные линии подразумевают подавляющее 

богатство, пышность, непостижимое простым человеческим сознанием.  

Диагональные линии создают ощущение движения или 

направленности, оживляют изображение. Поскольку объекты, 

расположенные диагонально, для человека кажутся нестабильными по 

отношению к линии силы притяжения (так как не расположены ни 

вертикально ни горизонтально), они как бы стремятся упасть, или уже 

находятся в движении падения. В двухмерных композициях диагонали часто 

используются для создания глубины, иллюзии перспективы, которая затем 

вызывает у смотрящего иллюзию пространства, в котором можно двигаться. 

Таким образом, если необходимо создать ощущение движения, скорости, или 

активности, следует использовать диагональные линии. Сочетание 

горизонтальных и вертикальных линий передает ощущение стабильности и 

прочности. Прямоугольные формы кажутся стабильными по отношению к 

силе притяжения, и не «стремятся» перевернуться. Эта стабильность создает 

чувство постоянности, надежности и безопасности.  Глубокие, острые 

кривые, с другой стороны, предполагают смятение, волнение, и даже 

безумие. Мы их встречаем в волнах шторма, в запутанных нитях клубка, в 

беспорядочных потоках людской толпы. Кривые линии имею и другие 

значения. Мягкие, неглубокие кривые предполагают комфорт, безопасность, 

понятность, расслабление. Они напоминают кривые линии человеческого 

тела, и, следовательно, приятны для глаз. 
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Качество линии само по себе тоже является визуальным языком. 

Использование качества линии настолько распространенный прием, что мы 

все очень тонко это чувствуем. Даже не имея художественного образования, 

мы можем почерпнуть многое по тому, какие линии используются в рисунке. 

Качество линии само по себе свидетельствует о собственно духе 

произведения. А для настоящего художника-мастера, качество линии – это 

средство выражения его стиля. 

Штрихом называется группа взаимодействующих линий в графике. : 

«Линия – это протяженное движение пера по бумаге, штрих – короткое. 

Линия может иметь самостоятельное значение, штрих ‒ лишь в совокупности 

с другими штрихами»[27]. 

Замыкая линию, мы получаем пятно как отдельный графический 

элемент. Пятно, в отличие от точки и линии, заполняет значительную часть 

графической плоскости. Форма пятна может быть разной: прямоугольной, 

квадратной, круглой, овальной, правильной и неправильной, произвольной, и 

т.д. Фактурное заполнение пятна разнообразно: разряженное или плотное, 

крупно-фактурное или мелко-фактурное, одноцветное или разноцветное, 

светлое или темное. 

Используя графические средства по отдельности или совместно, можно 

создавать различные гармоничные плоскостные композиции, а также 

включать графику в объемную композицию. В основном, пятно бывает двух 

видов: аморфное пятно и силуэт – четкое пятно. В характеристике пятна 

важны: тон – развитие градаций черного, белого, – и цвет. По цвету и тону 

пятно может быть локальным или градиентным. Благодаря различным 

свойствам материала, пятно может быть: прозрачное, густое, растекающееся, 

распыленное, растушеванное, штриховое, мягкое, жесткое, однородное или 

неоднородное, равномерное или неравномерное, фактурное, векторное или 

растровое. 

Пятновая графика более активно воздействует на зрителя, чем 

линейная. 
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Пятно может плоско располагаться на бумаге, быть абсолютно черным, 

двухмерным, и в этом случае особая эмоциональная роль отводится силуэту 

и пластике пятна. 

Внутри пятна возможны тональные градации, тогда оно становится 

структурным, глубоким, материальным, осязаемым. «Пятновая» графика 

часто применяется в плакатах и рекламе. 

Форма пятна очень важна для восприятия. Иттен утвеждал, что 

существуют всего три основные формы: «Квадрат, треугольник и круг 

создаются при помощи четырех различных пространственных построений. 

Квадрат основан на горизонталях и вертикалях, отличительным признаком 

треугольника является диагональ, круг определяется циркульным 

движением» [4]. Каждая форма имеет свои особенности восприятия. 

Квадрат, в основе построения которого лежит прямой угол, считается 

формой стабильной. Это устойчивая, тяжелая, «надежная» фигура. 

Прямоугольник воспринимается в зависимости от его расположения 

относительно горизонта. Ориентированный по горизонтали вытянутый 

прямоугольник ассоциируется с повышенной устойчивостью, придает 

стабильность композиции. Вертикально расположенный прямоугольник 

устремляется вверх и выглядит более легким. 

Треугольник более активен и воспринимается в зависимости от формы 

и направления. В основе равностороннего треугольника лежат острые углы. 

Эта форма тяготеет к движению. Равнобедренный высокий треугольник 

выглядит устремленным вверх, динамичным, может казаться агрессивным. 

Развернутый основанием вниз воспринимается как устойчивая форма, 

перевернутый на вершину – максимально неустойчивая. 

Форма круга, в основе которого лежит концентрическое движение, 

воспринимается в основном позитивно. Круг – солярный знак, он несет в 

себе понятия добра, тепла, жизни. 
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Существуют закономерности, влияющие на визуальный вес объектов 

(фигур) композиции: 

1. Объекты, находящиеся в верхней части композиции, имеют бóльший 

визуальный вес. 

2. Объекты, находящиеся в центре композиции или близко к центру, а 

также на центральной вертикальной оси формата, визуально имеют меньший 

вес. 

3. Объекты, расположенные вертикально, имеют бóльший визуальный 

вес, чем аналогичные, расположенные наклонно или неустойчиво. 

4. Объекты на правой стороне композиции имеют бóльший визуальный 

вес, чем аналогичные объекты на левой стороне. 

5. Объекты правильной геометрической формы выглядят более 

тяжелыми, чем объекты произвольной формы. 

Любая форма, располагаясь на плоскости, вступает с этой плоскостью 

во взаимодействие. Особенно это касается локальных пятен в черно-белой 

графике. 

Благодаря тону моделируется объем формы, глубина пространства, 

передается фактурное, материальное состояние объекта. Изображение может 

быть светлым, нюансным, контрастным. Чем контрастнее отношения фона и 

изображаемого объекта, тем более выразительно воспринимается 

изображение, тем бóльшее значение отводится силуэту. 

Белая форма на темном фоне более выразительна и лучше 

запоминается, но количество мелких деталей в этом случае должно быть 

небольшим, меньше, чем черных мелких фигур на светлом фоне. 

Это необходимо учитывать, например, при разработке знаков, которые 

будут использоваться как в прямом, так и в инвертированном варианте. Если 

в композиции используются черный, белый и светло-серый цвета, подобную 

композицию называют композицией с полным свето-тоновым диапазоном. 

В случае, когда серый цвет в трехтоновой композиции сдвинут в 

строну белого или черного, композиция приобретает экспрессивность и 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



контрастность. Особенно активным белый цвет становится, если серый цвет 

сближается с черным. Композиции светло-серого диапазона воздушны, 

легки, они нейтральны и эмоционально спокойны. В них наиболее полно 

выражена идея статики [16]. 

Средства гармонизации композиции. 

Композиционное построение отличает наличие частей, связанных друг 

с другом системой гармоничных отношений. 

Ритм – основа композиционных построений, греческое слово, 

обозначающее движение, такт. Ритм – универсальное природное свойство, 

одна из главных закономерностей организации живой и неживой природы, 

биологические часы организма человека. 

Ритм действует на наши чувства. Мы воспринимаем его зрительно, на 

слух: например, стук колес паровоза, музыку танца, и т.д.. Однако ритм 

свойственен не только движению, но и статичному предмету. Например, в 

архитектурных сооружениях мы видим ритмичное расположение окон по 

вертикали и горизонтали. Ритм можно наблюдать и в плоскостных 

изображениях: орнаменты на обоях, тканях и коврах также являются 

примерами ритмических композиций. Ритмические закономерности 

прослеживаются в элементах формообразования растительного и животного 

мира. 

Ритм отображается в равновесии чередования размерных элементов, 

порядке сочетания линий, объектов и плоскостей. 

Ритм на плоскости всегда подразумевает движение, и может быть 

создан: 

− вертикальными линиями; 

− горизонтальными линиями; 

− наклонными линиями. 

Вертикали и горизонтали работают как организующие линии, однако 

всегда вертикаль является доминантой. Членение по горизонтали зрительно 
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снижает высоту предметов, а вертикальное членение, напротив, делает их 

выше (рис. 4). 

 

 
Рисунок 4 – членение квадрата на вертикали и горизонтали 

Ритмизация – один из способов гармонизации объема и формы. 

Статический (простой) ритм − чередование какого-либо элемента 

формы через равные промежутки:  

1. Чередование одинаковых элементов с нулевым интервалом между 

ними (интервалом является граница раздела между элементами);  

2. Чередование одинаковых элементов с интервалом одинаковой 

величины;  

3. Повторение одинаковых элементов и интервалов при их радиальном 

расположении. Статический ритм обеспечивает композиции покой, 

уравновешенность, но, с другой стороны, придает статичность и некоторую 

монотонность. Чрезмерная повторяемость, одинаковость элементов 

оказывает негативное воздействие на восприятие и вызывает неприятные 

эмоции. 

Динамический ритм может соответствовать следующим схемам: 

- чередование равных элементов формы при изменении интервалов 

между ними (возрастание или убывание); 

- чередование изменяющихся элементов формы (возрастание или 

убывание) при неизменных интервалах между ними; 

- чередование изменяющихся элементов формы (возрастание или 

убывание) при изменении интервалов между ними (возрастание или 

убывание); 
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- чередование изменяющихся элементов формы и интервалов между 

ними(возрастание или убывание) при их радиальном расположении. 

Динамический ритм может развиваться по арифметической, 

гармонической и геометрической прогрессии. 

Модульность – возможность формообразования на основе 

повторяющихся элементов, кратность размеров по всем координатам. Весьма 

распространенный прием применения модульного принципа в композиции − 

комбинаторика элементов, или особый вид гибкого формообразования, суть 

которого – изменение формы на основе различных сочетаний одних и тех же 

элементов. При таком подходе образуются новые комбинации элементов и, 

соответственно, новые формы. 

Одна из характерных черт комбинаторики − открытость в плане 

свободного развития формы в пространстве. Выделяют следующие приемы 

построения гибких композиций: 

− установление «клеточного» порядка на основе складывания 

одинаковых по форме элементов (эффект «кирпичиков»); 

− сборка разных элементов по единым стыковочным узлам (эффект 

«конструктора»); 

− образование замкнутых, но изменяющихся внутри себя систем 

(эффект «матрешки»); 

− изменение положения формы с изменением функций (эффект 

«перевертыша»); 

− изменение внешнего вида формы в прямой связи с выполнением ее 

динамичной функции (эффект «трансформации» − складывания, опускания, 

задвижки, надувания и т. п.).  

Все эти приемы допускают применение разных композиционно-

динамических средств − меняющейся графики и пластики (цвета, 

расположения элементов, их пластической обработки и др.). В результате 

такого применения выявляется определенный характер гибкой формы. Он 

четко раскрывается, например, в так называемых раппортных системах, 
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состоящих из одинаковых повторяющихся элементов. Весьма эффективно и 

выразительно комбинирование форм на основе модульных элементов. Эти 

элементы подвержены изменению в рамках модульных сеток. Разделяются 

такие сетки на пять основных геометрических видов: квадратные, 

прямоугольные, треугольные, ромбовидные и шестигранные. Из них 

создаются разнообразные сетчатые и решетчатые (плоскостные и объемные) 

композиционные структуры, которые могут свободно развиваться в разных 

координатных направлениях. 

Модульная система − один из самых популярных методов 

конструирования полиграфической продукции. Печатное издание, созданное 

по модульной системе (то есть на базе модульной сетки) легче 

воспринимается человеком, так как его дизайн основывается на законах 

пропорциональных отношений. Использование модульной сетки позволяет 

упорядочить различные элементы страницы, придавая ее оформлению 

целостность и ясность.  

Модуль (с англ. «module» − часть, единица чего либо) – то есть, это 

какая-либо часть, единица, выраженная в слове, форме, линии, событии и 

т.д., и т.п.. Например, в изобразительном искусстве это элементы 

формальной композиции, композиции в живописном или графическом 

изображении, в дизайне – в композиции объектов дизайна. Источником 

вдохновения для художников и/или дизайнеров всегда была природа, 

человек, эмоции восприятия окружающего мира, внутренний мир человека, 

история цивилизации, события, авторы и их работы в различных видах и 

жанрах искусства и культуры: и этот источник неиссякаем, как неиссякаема 

природа и человек в своем развитии и проявлениях. Каждый раз при 

проектировании чего-либо необходима идея, а идеи, как известно «витают» в 

воздухе. Самое важное уметь их «увидеть».  Возможно, анализируя всѐ выше 

изложенное, можно предложить новый способ, метод проектирования в 

дизайне, новый метод создания  композиции в объектах изобразительного 

искусства [24]. 
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Абстрактная композиция на модульной основе состоит из одинаковых 

ритмически повторяющихся модулей. 

Восприятие формы и размера изображения зависит от его цвета и 

геометрических параметров. Изображение может точно соответствовать 

реальности, однако может и искажать ее. В последнем случае речь идет о 

создании оптических иллюзий как особом свойстве графических 

композиций.  

Оптические иллюзии в композиции создаются путем комплексного 

применения различных графических средств, изменения начертания и 

движения объектов внутри плоскости формата, смещения композиционных 

центров и искаженного изображения составляющих элементов. Композиции 

данного рода достаточно широко применяются в графическом дизайне, 

оказывая влияние на формирование дизайна среды (рис.5). 

  
Рисунок 5 – Оптическая иллюзия 

 

 

Замечательным мастером иллюзий был знаменитый нидерландский 

график Морис Корнелиус Эшер (Maurits Cornelis Escher), изучавший 

особенности симметрии, переход одной исходной формы в другую, 

отображение трехмерного пространства на плоскости листа и т.д. (рис. 6,7). 
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Рисунок 6 – Эшер. День и ночь 
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Рисунок 7 – Эшер. Бесконечные ступеньки. 

 

Отдельной областью реализации оптических иллюзий становится 

искусство оп-арта, примером которого могут служить работы Виктора 

Вазарели (Victor Vasarely) (рис.8). 
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Рисунок 8 – Визарелли 

Иллюзии восприятия объектов. Иллюзии восприятия линий. 

Иллюзии восприятия величины. Иллюзии восприятия плоскости. Иллюзии 

восприятия движения. Иллюзии восприятия формы. Иллюзии восприятия 

ракурса. Иллюзии восприятия пространства. Иллюзии искривления 

пространства. Иллюзии восприятия фона. Иллюзии восприятия цвета 

Целостность композиции – это связь различных частей в единое 

целое, которое порождает гармонию. Независимо от того, является ли 

субъект восприятия профессионалом или дилетантом в композиции, 

нарушение важнейших законов композиции вызывает у него чувство 

неудовлетворенности, сигнал о нарушении целостности. В законе единства и 

целостности композиции получили отражение и воплощение природные 

принципы организации объектов окружающего мира. Анализ творений 

природы, как и подлинно прекрасных творений рук человеческих, постоянно 

подтверждает наличие объективных закономерностей. Примеры взаимного 

целесообразного согласования элементов формы человек видит постоянно: в 

формах живой и неживой природы. Части природных форм группируются и 

объединяются за счет равновесия, сбалансированности, симметрии, ритма, 

пропорций. Эти композиционные начала получили эстетическое освоение и 

закрепились в опыте искусства и в ходе социально-исторической практики 
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человечества. Ставя задачу организации гармоничной композиции из 

нескольких элементов, необходимо объединить эти элементы единством 

пластического формообразующего решения, а также единством 

колористического и фактурного решения, путем соподчинения элементов 

композиционному центру.  

Композиционный центр − это главное место, доминанта, он служит 

для фокусировки внимания зрителя. В композиционном центре находится 

основной сюжет произведения. Композиционный центр является 

кульминацией художественного образа. Задача композиционного центра – 

привлечь внимание, выделить достоинства и раскрыть содержание всей 

композиции. Второстепенные элементы при этом видятся боковым зрением и 

подчиняются композиционному центру. При организации композиционного 

центра следует учитывать законы визуального восприятия плоскости. Как 

правило, он располагается в активной центральной части квадратной или 

круглой композиции. В прямоугольной форме композиционный центр 

необходимо немного смещать вверх относительно геометрического центра. 

Если же композиционный центр расположить на месте геометрического, то 

будет создаваться ощущение его падения. Композиция может быть 

организована и без композиционного центра, без выделения доминирующего 

элемента, при этом все детали подчиняются целому и утрачивают свою 

самостоятельность. В такой композиции нет ни главного, ни 

второстепенного – это единый ансамбль. Композиционным центром может 

также быть и свободное пространство – композиционная пауза. 

К средствам гармонизации композиции также относятся следующие 

понятия: контраст, нюанс, пропорции, масштаб. 

К средствам гармонизации композиции, обладающим специфическими 

свойствами, может быть отнесена модульность и образуемые с ее помощью 

комбинаторные модульные системы. Контрастные отношения означают 

резко выраженное различие свойств предметов. При использовании 

контрастных отношений элементы композиции необходимо объединять 
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другими характеристиками. Например, если предметы разные по форме, то 

они должны объединяться цветовой гаммой и характером внутренних линий. 

Если предметы сильно отличаются размером, пропорциями, то они должны 

объединяться формой. 

Средства гармонизации – тождество, контраст, нюанс, подобие – 

подсказывает художнику природа. В ней сосуществуют все эти 

художественные проявления. В одинаковости форм листьев цветка 

проявляется тождество, в небольшом различии их окрашенности – нюанс, в 

противопоставлении цвета цветка цвету листьев – контраст. Если контраст и 

подобие определяют основную структуру формы, то нюанс – это некоторое 

переходное состояние между ними, обладающее мягким дополняющим 

эффектом и предусматривающее слабо выраженное расхождение между 

однородными характеристиками элементов. Само слово «нюанс» означает 

отклонение, едва заметный переход. Нюанс разнообразит монотонность и 

сглаживает жесткость элементов композиции. 

Объемно-пространственного изображения.  

Плоскостная композиция. Композиция на плоскости, не передающая 

иллюзию объема. К ним относятся в основном рекламные плакаты и 

декоративные панно. 

Объемная композиция. Это развитие формы по 2-м, 3-м координатам в 

ограниченном пространстве. К ней относятся различные виды скульптур, 

керамика, костюм, мебель. На выразительность скульптурной композиции 

сильное влияние оказывает освещение. 

Пространственная композиция. Состоит из объемных 

композиционных элементов. Развивается по трем координатам в открытом 

пространстве: городская среда, архитектурная среда, ландшафтный дизайн, 

сценография. 

Цвет в композиции. Ахроматические цвета – черный, белый и все 

оттенки серого (более трехсот). 
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Ахроматические цвета не имеют цветового тона и отличаются один от 

другого только светлотой, которая характеризует степень отличия данного 

цвета от белого или черного. Ахроматический ряд может состоять из 

различного количества частей, начиная от трех. 

Для получения зрительного впечатления равноступенности 

ахроматического ряда надо, чтобы средний цвет содержал белого не 50 %, а 

значительно меньше. Средний цвет должен находиться посередине, разделяя 

все цвета на две группы: светлые и темные. Этот средний серый цвет 

является самым спокойным, нейтральным (соответствующую 

эмоциональную окраску приобретает композиция, где он участвует). 

Светлотная контрастность является главным средством построения 

композиции. Двух-тоновые композиции всегда плоскостны. Небольшой 

глубиной обладают трехтоновые композиции в связи со способностью 

светлых тонов «выступать», а темных «отступать», но это свойство не 

нарушает принцип плокостности. Введение в композицию третьего тона 

повышает выразительные возможности светлотных отношений. Трех-

тоновость обеспечивает ясную читаемость произведения искусства, его 

конструктивность. В композиции возможно присутствие и большего 

количества тонов, чем три, но добавочные тона должны приближаться к трем 

основным, иначе изображение теряет читаемость и художественные 

качества. Лучшее взаимодействие площадей трех тонов наступает тогда, 

когда они связаны математическими пропорциями. 

1. Площади светлых, средних и темных тонов равны (примерно по 

33%) – возникает композиция спокойная, статичная. 

2. Большая площадь светлого (50%), средний тон приближен по 

светлоте к светлому (31%), мало черного (19%) – композиция светлая, 

тонально динамичная. 

3. Много темного (50%) и сближенного с ним по светлоте среднего 

(31%), мало светлого (19%) – композиция темная, тонально динамичная. 
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4. Много среднего (60%), мало светлого и темного тона (по 20%) – 

композиция графична. 

Основные характеристики цвета. Цветовой тон – название цвета, 

например, синий, зеленый, коричневый. Название цветового тона может быть 

связано с явлением или предметом природы, например, цвет ночного неба, 

фисташковый, марсала. Светлота – степень отличия цветового тона от 

черного и белого. В спектральных цветах как самый светлый воспринимается 

желтый цвет, а самый темный – фиолетовый. Насыщенность, яркость – это 

количество чистого цвета. В насыщенном цвете находится максимальное его 

количество. Например, красный – насыщенный цвет, цвет цветущей яблони 

(розовый) – малонасыщенный. Приглушенность цвета – наличие в нем 

черного. Деловые и элегантные цвета имеют большое количество примеси 

черного цвета. Разбеленность цвета – наличие в нем белого. Это пастельные 

тона, мягкие и неяркие. Хроматические цвета отличаются один от другого 

тоном, который характеризует степень присутствия в нем белого или 

черного. 

В цветовом круге В. М. Шугаева четыре основных цвета: красный, 

желтый, синий, зеленый; зеленому цвету отводится равное с остальными 

цветами место – четверть круга, в которой каждый основной цвет убывает 

через три градации: 3/4, 2/4, 1/4. В круге Шугаева четко определяются 

противоположные (контрастные) цвета (рис.8). 
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Рисунок 8 – Цветовой круг В. М. Шугаева 

 

По теории Гете основных цветов три: красный, желтый, синий; еще три 

образуются при смешении: зеленый, оранжевый и фиолетовый (рис.9). 

Цветовой круг Иттена тоже построен на 3-х основных цветах – красном, 

желтом, синем. Теория Иттена о 12-ти частном цветовом круге лежит в 

основе многих художественных и дизайнерских школ (рис.10). Согласно 

теории Иттена, самый светлый из них − жѐлтый, а самый тѐмный − фиолетовый: 

 

 
Рисунок 9 – Цветовой круг Гете 
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Рисунок 10 – Цветовой круг Иттена 

Фотомонтаж и коллажирование 

Не всегда можно воплотить художественную задумку в фотоснимке, 

для того чтобы создать интересную композицию и оригинальный сюжет 

фотографии часто необходимо добавить новые элементы или же наоборот их 

убрать. Изменить фон, добавить на фото экзотическое животное или 

татуировку на тело, а также различные надписи и подписи – все это 

фотомонтаж. 

Фотомонтаж включает: 

− Добавление, удаление или монтаж объектов, людей; 

− Монтаж нескольких фотографий в одну; 

− Замена одежды, прически, лица; 

− Спецэффекты, смена фона, добавление текстовых элементов; 

− Перемещение объектов композиции снимка; 

− Создание рамки для фото, удаление даты со снимка. 

Коллаж – это специальный технический прием изобразительного 

искусства, соединение нескольких элементов на единой основе, объединение 

несовместимых элементов в единую композицию. 
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Коллажирование – один из методов получения качественной и 

оригинальной фотографии. Коллажирование в программе компьютерной 

графики подразумевает соединение в единую композицию различных по 

художественному стилю иллюстраций, фотографий или картинок. 

Выделяют следующие виды коллажей: 

Декупаж – приемы декорирования, состоящие из применения 

различных видов материалов на одном полотне – бумага, кожа, ткань и др. 

Из выбранных материалов вырезают различные фрагменты рисунков и затем 

накладывают их на поверхности различных объектов коллажа, к примеру – 

мебель, посуду, украшения. 

Ассамбляж – декорирование при помощи нанесения на основу 

коллажа разных деталей и предметов, из которых затем получают целостный 

сюжет. 

Аппликация – создание необычного орнамента или узора на холсте 

методом наложения на него различных видов материалов, часто 

несовместимых между собой. 

Аккумуляция – соединение совершенно идентичных предметов в 

единую композицию, с целью создания особого эстетического эффекта. 

Киноколлаж – объединение в коллаже фрагментов кинофильмов 

различных жанров – документального, игрового, мультипликационного и др. 

Основными приемами в процессе создания коллажа являются: 

ретушь, замена фонового изображения, стилизация фотографий, работа с 

яркостью и контрастностью изображения, добавление спецэффектов и новых 

предметов. 

Приемы коллажирования могут быть использованы для всего 

изображения целиком или же применяются лишь к отдельным частям 

коллажа. 

Процесс создания коллажа включает: 

− Разработка идеи и художественной концепции коллажа; 

− Изменение фона или же его удаление; 
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− Добавление лишних или удаление новых элементов; 

− Использование спецэффектов; 

− Прорисовка деталей. 

Коллажи оказывают сильное воздействие на эмоции человека и 

колоссальный эстетический эффект. Совершенно любой предмет можно 

поместить на абсолютно любой фон, создать невероятный фантастический 

сюжет, несуществующие в реальности предметы, построить реальный объект 

из различных отрывков изображений других предметов. При помощи 

коллажирования легко можно изменить размеры объекта, его форму и 

очертание, цветовую гамму (рис.11). 

 

 
Рисунок 11 – Фотоколлаж 

 

Широко применяется коллажирование в рекламе, так как позволяет 

создать неповторимый и неординарный рекламный образ. Коллажи могут 

отображать как красивые реалистичные сюжеты, так и фантастические. 
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Ограничиваются возможности коллажирования только фантазией 

фотохудожника. 

Орнамент (от латинского ornamentum − «украшение») − это 

разновидность декоративного оформления предметов или объектов 

посредством чередования и сочетания различных узоров. Орнамент широко 

используется в архитектуре и вышивке, монументальной скульптуре и 

гончарном деле, книжной графике и производстве текстильных изделий, 

ювелирном деле и кузнечном ремесле. 

Мотивы орнаментальных изображений у разных народов могут сильно 

различаться, они имеют глубокий символический смысл и яркую 

декоративную выразительность. 

К числу формальных особенностей орнамента относится декоративная 

стилизация, плоскостность, органическая связь с несущей орнамент 

поверхностью, которую он всегда организует, нередко выявляя при этом 

конструктивную логику предмета. Не всякий узор можно считать 

орнаментом. Так, узорная ткань с бесконечно повторяющимся раппортом, не 

является орнаментальной.  

По характеру композиции, орнамент может быть ленточным, 

центрическим, окаймляющим, геральдическим, заполняющим поверхность 

или же сочетающим некоторые из этих типов в более сложных комбинациях. 

Это связано с обусловленной формой декорируемого предмета. 

По используемым мотивам орнамент делят на виды. 

Геометрический орнамент состоит из абстрактных форм (точки, 

прямые, ломаные, кривые, сетчато-пересекающиеся линии; круги, ромбы, 

многогранники, звѐзды, кресты, спирали. Более сложные специфические 

орнаментальные мотивы − меандр. 

Растительный орнамент стилизуется под листья, цветы, плоды и пр. 

(лотос, папирус, пальметта, акант и т. д.); зооморфный, или животный, 

стилизующий фигуры или части фигур реальных или фантастических 

животных.  
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В качестве мотивов используются также человеческие фигуры, 

архитектурные фрагменты, оружие, различные знаки и эмблемы (гербы). 

Особый род орнамента представляют стилизованные надписи на 

архитектурных сооружениях (например, на среднеазиатских средневековых 

мечетях) или в книгах (т. н. вязь). Нередки сложные комбинации различных 

мотивов (геометрических и звериных форм — т. н. тератология, 

геометрических и растительных — арабески). Среди самых известных 

разновидностей орнамента особо выделяют три уникальных типа узоров.  

Меандр − классический пример геометрического орнамента с 

характерными спиральными завитками. Первые его образцы датируются еще 

эпохой палеолита, но особой популярностью меандр пользовался среди 

античных художников. До наших дней сохранились многочисленные 

меандры в виде мозаик и ваз, элементов фризов и колонн времен Древней 

Греции, Рима и Византийской империи. 

Арабеска − изящный арабский орнамент с геометрическими, 

растительными и каллиграфическими мотивами. Изначально арабеска была 

неотъемлемой частью арабской исламской культуры, но в эпоху 

Возрождения приобрела огромную популярность и в христианских 

европейских странах.  

Ранголи − уникальная древняя индийская традиция создания 

прекрасных узоров из сухих и свежих цветов по самым разным поводам. 

Ранголи и в наши дни выкладывают на площадях перед храмами и в дворах 

индийских домов для выражения радости и благодарности богам, а также 

отпугивания злых духов. 

Любой творческий процесс всегда связан с определенными 

художественными обобщениями, абстрагированием, выявлением общих 

признаков, свойств предметов. Художественное обобщение, в свою очередь, 

может идти по пути изобразительному и неизобразительному, 

опосредованному, через эмоциональные ассоциации. Изобразительный путь 

обобщения характерен для тех случаев, когда конкретно-предметный образ 
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природного мотива сохраняется в натурной зарисовке несмотря на большую 

или меньшую условность изображения. Неизобразительный путь 

художественного обобщения требует от художника способности к 

абстрагированию и ассоциативному мышлению. 

Стилизация − это видоизменение, переработка природного мотива, 

что достигается художественным обобщением, отбрасыванием 

подробностей, «выпрямлением» линий контура, цель которой − сделать 

мотив более понятным для зрителя, а иногда облегчить его выполнение для 

художника. 

Принципы стилизации 

− превращение объѐмной формы в плоскостную и упрощение 

конструкции; 

− обобщение формы с изменением абриса; 

− обобщение формы в еѐ границах; 

− обобщение формы и усложнение, добавление деталей, отсутствующих в 

натуре. 

Границы стилизации находятся в пределах между точным 

воспроизведением формы и крайней степенью ее упрощения. Например, 

товарные знаки, знаки дорожные, имеют, как правило, очень лаконичную 

форму, что позволяет их острее воспринимать и надолго запоминать, не 

очень привлекательный образ новым, в котором акцентируются главные, 

характерные и узнаваемые черты, основные пропорции и силуэт. 

В процессе стилизации важно: отобрать существенные характеристики; 

использовать прием гиперболизации (т.е. преувеличение, выделение какого-

то одного, но индивидуального качества объекта) отдельных элементов; 

отказаться от второстепенных, маловыразительных деталей; создать 

органическое единство орнамента и пластической формы. 

Цвет несет определенную информацию и провоцирует эмоции, поэтому 

цвет является одним из элементов символизма в различных ситуациях 

(государственная атрибутика, религиозный обряд). С физической точки 
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зрения цвет, это впечатление, которое оказывают на орган зрения лучи света 

разной длины волны (самые длинные - красный спектр, короткие - 

фиолетовый). 

Цвет непрозрачного объекта зависит от спектрального состава 

падающего на него света и отражающей способности поверхности объекта 

(материала или краски). Цвет определяется тем, волны какой длины способна 

отразить поверхность объекта. Черный цвет мы видим тогда, когда 

поверхность поглощает все падающие на нее лучи. 

Согласно результатам, полученным в ходе многочисленных 

психологических экспериментов, учеными был сделан вывод, что цвет 

определенным образом влияет на восприятие человеком веса тела, 

температуры помещения и оценку удаленности объекта. Так, красный, 

желтый, оранжевый цвета визуально приближают предмет, увеличивая его 

объем и как бы «подогревая» его. Голубой, синий, фиолетовый, черный цвет 

визуально отдаляют объект, уменьшают и «охлаждают» его. 

Отношение к цвету в каждой стране свое, и существует даже своя 

национально-культурная специфика, которую необходимо учитывать. В 

России излюбленным цветом всегда был красный, который ассоциировался с 

богатством и любовью. Ключевыми цветами, украсившими российский флаг, 

остаются красный, белый и синий (символ чистоты и духовного 

совершенствования). Восприятие цвета и эмоциональное к нему отношение 

зависит главным образом от эмоционального состояния человека. Оказалось, 

что определенным эмоциональным состояниям человека соответствуют его 

устойчивые отношения к цвету, цветосочетаниям: одному цвету отдается 

предпочтение, другой не вызывает особых эмоций, третий вовсе отвергается. 

Сочетания отдельных цветов. 

Белый: сочетается со всеми. Наилучшее сочетание с синим, красным и 

черным.  

Бежевый: с голубым, коричневым, изумрудным, черным, красным, 

белым.  
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Серый: с цветом фуксии, красным, фиолетовым, розовым, синим.  

Розовый: с коричневым, белым, цветом зеленой мяты, оливковым, 

серым, бирюзовым, нежно-голубым.  

Фуксия (темно-розовый): с серым, желто-коричневым, цветом лайма, 

зеленой мяты, коричневым.  

Красный: с желтым, белым, бурым, зеленым, синим и черным.  

Томатно-красный: голубой, цвет зеленой мяты, песчаный, 

сливочнобелый, серый.  

Вишнево-красный: лазурный, серый, светло-оранжевый, песчаный, 

бледно-желтый, бежевый.  

Малиново-красный: белый, черный, цвет дамасской розы.  

Коричневый: ярко-голубой, кремовый, розовый, палевый, зеленый, 

бежевый.  

Светло-коричневый: бледно-желтый, кремово-белый, синий, зеленый, 

пурпурный, красный. 

Темно-коричневый: лимонно-желтый, голубой, цвет зеленой мяты, 

пурпурно-розовый, цветом лайма.  

Рыжевато-коричневый: розовый, темно-коричневый, синий, зеленый, 

пурпурный.  

Оранжевый: голубой, синий, лиловый, фиолетовый, белый, черный.  

Светло-оранжевый: серый, коричневый, оливковый.  

Темно-оранжевый: бледно-желтый, оливковый, коричневый, 

вишневый.  

Желтый: синий, лиловый, светло-голубой, фиолетовый, серый, черный.  

Лимонно-желтый: вишнево-красный, коричневый, синий, серый.  

Бледно-желтый: цвет фуксии, серый, коричневый, оттенки красного, 

желтовато-коричневый, синий, пурпурный.  

Золотисто-желтый: серый, коричневый, лазурный, красный, черный.  

Оливковый: апельсиновый, светло-коричневый, коричневый.  
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Зеленый: золотисто-коричневый, оранжевый, салатный, желтый, 

коричневый, серый, кремовый, черный, сливочно-белый.  

Салатный цвет: коричневый, желтовато-коричневый, палевый, серый, 

темно-синий, красный, серый.  

Бирюзовый: цвет фуксии, вишнево-красный, желтый, коричневый, 

кремовый, темно-фиолетовый.  

Электрик красив в сочетании с золотисто-желтым, коричневым, светло-

коричневым, серым или серебряным.  

Голубой: красный, серый, коричневый, оранжевый, розовый, белый, 

желтый.  

Темно-синий: светло-лиловый, голубой, желтовато-зеленый, 

коричневый, серый, бледно-желтый, оранжевый, зеленый, красный, белый.  

Лиловый: оранжевый, розовый, темно-фиолетовый, оливковый, серый, 

желтый, белый.  

Темно-фиолетовый: золотисто-коричневый, бледно-желтый, серый, 

бирюзовый, цвет зеленой мяты, светло-оранжевый.  

Черный универсален, элегантен, смотрится во всех сочетаниях, лучше 

всего с оранжевым, розовым, салатным, белым, красным, сиреневатым или 

желтым. 

Плоскостная форма – это такой вид пластической формы, который 

характеризуется одновременным развитием по горизонтали и вертикали при 

незначительном развитии в глубину. Плоская форма является лишь 

первоначальным состоянием плоскостной. Промежуточные состояния 

плоскостной формы чрезвычайно разнообразны по своим пластическим 

свойствам. Проявляются эти свойства в текстуре, фактуре и рельефе 

поверхности. 

Текстура характеризуется декоративно-художественными свойствами, 

вытекающими из внутреннего строения формы. Наиболее ярко выявляется 

при гладкой поверхности. Отличается крайним разнообразием рисунка – от 

мелких вкраплений, представляющих собой однородную массу до 
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выразительных узоров, образованных внутренним «рисунком» формы. 

Чѐткое выявление текстуры в плоскостных формах предопределяет 

эффективное с художественной точки зрения их использование в построении 

пластических композиций (рис.12).  

 

Фактура занимает промежуточное место между такими состояниями 

плоскостной формы, как гладкая поверхность и рельеф. В зависимости от 

количества и величины составляющих еѐ пластических элементов 

(выступов), фактурная поверхность приближается либо к первой, либо ко 

второй. Фактурная поверхность может отличаться большим разнообразием. 

Важно учитывать, что еѐ пластический характер тем сильнее, чем она 

сильнее «выступает» и ближе к зрителю. С дальних точек фактура может 

выглядеть просто гладкой поверхностью. При разнодалѐких точках зрения 

целесообразно применение в плоскостных формах как мелкой, так и крупной 

фактуры, близкой к рельефу (рис.13). 

 

 
Рисунок 12 – Текстура 
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Рисунок 13 – Фактура 

 

Рельеф характеризуется ещѐ более крупным, чем фактура 

пластическим строением плоскостной формы. Различие видов рельефов, так 

же как и фактур, выражается в крупности – количестве и величине 

элементов, образующих рельефную поверхность. В дизайне, как и в 

скульптуре, широко распространено деление рельефа на: контр 

(заглубленный), низкий, высокий и горельеф. В таком делении чѐтко 

проявляется разный пластический характер рельефной поверхности. Важным 

признаком плоскостной формы является еѐ расположение в пространстве по 

отношению к фоновой плоскости, с которой она связана физически и 

зрительно. Эта форма может располагаться к ней фронтально или профильно. 

При фронтальном расположении она смотрится с одной стороны, при 

профильном – с двух. Большое значение при выявления характера 

плоскостной формы имеет цвет, точнее цветовая моделировка. За счѐт такой 

моделировки можно выделить главные элементы рельефной композиции. В 

то же время цвет может подчѐркивать характер или обогащать композицию, 

зрительно нарушая принятый в ней пластический строй (рис.14). 
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Рисунок 13 – Рельеф 

Визуальная коммуникация − важная составляющая дизайна 

коммуникаций. В основном она оперирует двухмерными изображениями − 

плакатами, видеорядом, знаками, графикой. Цель визуальной коммуникации 

обычно состоит в поддержании текстового сообщения, а не в 

самостоятельном влиянии. 

Цвет может задать точную эмоцию, когда это сложно выразить 

словами. 

Цвет как элемент визуализации воспринимается человеком, прежде 

чем начинается осознание. Это простое средство коммуникации, которое 

движет миром и помогает установить статус всего на свете − от 

Олимпийских игр до пирога, и позволяет компании выделиться. 

Цвет вызывает физическую и эмоциональную реакцию. Это мощный 

элемент визуальной коммуникации. 

- Ускорение визуального поиска 

- Улучшение распознавания объектов 

- Усиление значения 

- Передача структуры 

- Установление личности 

- Символика 

- Улучшение удобства и простоты использования 

- Передача настроения 
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- Выделение ассоциаций 

- Усиление метафор 

Первобытные общества выделяли три основных цвета: красный (кровь, 

огонь), белый (молоко, день), черный (земля, ночь). Чем сложнее общество, 

тем более широкая цветовая гамма присутствует в его культуре. 

У каждой нации существует собственный спектр цветового восприятия, 

исторически сформировавшийся за счет традиций, обычаев и особенностей 

жизненного уклада. На постсоветском пространстве, например, зеленый 

символизирует природную чистоту и здоровый образ жизни, синий – 

госструктуры, красный – экстренные службы, желтый – такси и т.д. 

Разные культуры имеют разные представления о «значении» цвета. 

Так, например, красный в большинстве стран Азии символизирует 

благополучие, счастье и удачу, а в Южной Африке − это цвет траура. 

Позиционирование продукта должно иметь соответствующее цветовое 

решение. Если, например, вы производите бытовую технику и 

позиционируете свою продукцию как отвечающую самым современным 

технологиям, то имеет смысл использовать серые и стальные тона. Такое 

сочетание цветов имеет шансы на успех в нашей стране и в США, а вот в 

Китае и Японии − это проигрышный вариант, поскольку серый цвет здесь 

воспринимается как характеристика недорогого товара. Если компания 

выводит на рынок в каком-либо смысле революционный (новая категория, 

новая технология, уникальное качество и пр.) продукт, то подойдут 

«революционные» цвета: оранжевый и красный. 

Еще один возможный параметр оценки − социальный потрет целевой 

аудитории. Для молодежи подходят яркие и даже агрессивные цвета; для 

обеспеченных, солидных людей − спокойные, вызывающие уважения 

оттенки: черный, золотой, фиолетовый. 

Если используются хотя бы несколько цветов, следует четко 

представлять, насколько гармонично будет смотреться то или иное решение. 

Здесь также есть набор механизмов, позволяющих усилить эффект: 
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-контрастность усиливает цвет; 

-насыщенные цвета создают «живое» впечатление; 

-сочетание смежных по цветовой гамме и оттенкам цветов дает 

ощущение покоя; 

-цветовой диссонанс привлекает внимание, но может вызвать 

негативную реакцию. 
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Лекция 4 

Тема 4 Теоретические основы компьютерной графики и 

геометрического моделирования 

Разновидностью создания композиций из упомянутых выше базовых 

элементов графики являются работы дизайнеров, созданные с помощью 

компьютерных программ 3d-max, Adobe Illustrator, Photoshop и других. Здесь 

элементы изобразительной и знаковой информации преобразуются 

компьютерными программами в более сложные проекции и визуально 

воспринимаемые формы. 

Визуальная культура − совокупность материальных и 

интеллектуальных ценностей, созданных и накопленных человечеством за 

период многих тысячелетий своего существования, и доступных для 

визуального восприятия современниками и потомками мастеров, живущими 

много позже создателей тех или иных художественных творений. Начиная с 

ХХ века, визуальная культура пополнилась произведениями компьютерного 

мультимедийного творчества, и стала одной из важных областей визуальной 

культуры «медиа». Визуальная культура этого типа, генерируемая и 

воспроизводимая средствами электронной информатики, заняла своѐ 

исторически определенное место в современном социуме. Она выработала 

свою определѐнную систему функционирования, одним их достоинств 

которой стал гибкий, ускоренный способ обмена информацией. 

Геометрическое моделирование изучает методы построения 

математической модели, описывающей геометрические свойства предметов 

окружающего мира. 

Теоретической основой геометрического моделирования являются 

дифференциальная и аналитическая геометрия, вариационное исчисление, 

топология и разделы вычислительной математики. Геометрическое 

моделирование изучает методы построения кривых линий, поверхностей и 

твердых тел, методы выполнения над ними различных операций и методы 

управления численными моделями. Инструментом для геометрического 
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моделирования служат математические методы решения задач. 

Предметом геометрического моделирования являются не только объекты, но 

и явления и процессы (отображаемыми графиками, диаграммами). 

Геометрическое моделирование на ЭВМ базируется на использовании 

возможностей компьютерной графики. 

Компьютерная (машинная) графика - область деятельности, в которой 

компьютеры используются как инструмент для синтеза (создания) 

изображений, так и для обработки визуальной информации, полученной из 

реального мира. Также компьютерной графикой называют результат такой 

деятельности. 

К основным сферам применения технологий компьютерной графики 

относятся: 

-Графический интерфейс пользователя; 

-Спецэффекты, Визуальные эффекты (VFX), цифровая 

кинематография; 

-Цифровое телевидение, видеоконференции; 

-Цифровая фотография; 

-Визуализация научных и деловых данных; 

-Компьютерные игры, системы виртуальной реальности ; 

-Системы автоматизированного проектирования; 

-Компьютерная томография. 

По способам задания изображений графику можно разделить на 

категории: 

Двухмерная графика 

А. Векторная графика 

Векторная графика представляет изображение как набор 

геометрических примитивов. Обычно в качестве них выбираются точки, 

прямые, окружности, прямоугольники, а также как общий случай, некоторого 

порядка. Объектам присваиваются некоторые атрибуты, например, толщина 

линий, цвет заполнения. Рисунок хранится как набор координат, векторов и 
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других чисел, характеризующих набор примитивов. При воспроизведении 

перекрывающихся объектов имеет значение их порядок. 

Изображение в векторном формате даѐт простор для редактирования. 

Изображение может без потерь масштабироваться, поворачиваться, 

деформироваться. Имитация трѐхмерности в векторной графике проще, чем в 

растровой. При преобразовании старое изображение (или фрагмент) 

стирается, и вместо него строится новое. 

Б. Растровая графика 

Растровая графика всегда оперирует двумерным массивом (матрицей) 

пикселей. Каждому пикселю сопоставляется значение — яркости, цвета, 

прозрачности — или комбинация этих значений. Растровый образ имеет 

некоторое число строк и столбцов. 

В растровом виде представимо любое изображение, однако этот способ 

хранения имеет свои недостатки: больший объѐм памяти, необходимый для 

работы с изображениями, потери при редактировании. 

В. Фрактальная графика 

Фрактал — объект, отдельные элементы которого наследуют свойства 

родительских структур. Поскольку более детальное описание элементов 

меньшего масштаба происходит по простому алгоритму, описать такой 

объект можно всего лишь несколькими математическими уравнениями. 

Фракталы позволяют описывать целые классы изображений, для 

детального описания которых требуется относительно мало памяти. С другой 

стороны, фракталы слабо применимы к изображениям вне этих классов. 

Трѐхмерная графика 

Трѐхмерная графика (3D) оперирует с объектами в трѐхмерном 

пространстве. Обычно результаты представляют собой плоскую картинку, 

проекцию. Трѐхмерная компьютерная графика широко используется в кино, 

компьютерных играх. 

В трѐхмерной компьютерной графике все объекты обычно 

представляются как набор поверхностей или частиц. Минимальную 
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поверхность называют полигоном. В качестве полигона обычно выбирают 

треугольники. 

Всеми визуальными преобразованиями в 3D-графике управляют 

матрицы. В компьютерной графике используется три вида матриц: матрица 

поворота, матрица сдвига, матрица масштабирования. 

Любой полигон можно представить в виде набора из координат его 

вершин. Так, у треугольника будет 3 вершины. Координаты каждой вершины 

представляют собой вектор (x, y, z). Умножив вектор на соответствующую 

матрицу, мы получим новый вектор. Сделав такое преобразование со всеми 

вершинами полигона, получим новый полигон, а преобразовав все полигоны, 

получим новый объект, повѐрнутый/сдвинутый/масштабированный 

относительно исходного. 

Шаги для получения трехмерного изображения: 

− моделирование – создание математической модели сцены и объектов 

в ней. 

− Рендеринг (визуализация) – построение проекции в соответствии с 

выбранной физической модель. 

Графические примитивы позволяют путем ряда нехитрых манипуляций 

создавать абстрактные объекты и реальные модели. Еще большие 

перспективы открываются при использовании в качестве исходных объектов 

форм (Shapes), которые представляют собой набор двумерных или 

трехмерных кривых. Формы объединяют два типа объектов − Splines 

(Сплайны) и NURBS Curves (Кривые NURBS). 

Сплайны (Spline − кусочно-полиномиальная функция) − это 

двумерные геометрические объекты, которые совершенно самостоятельны и 

могут служить основой для построения более сложных двух и трехмерных 

тел. Внешне сплайны представляют собой разнообразные линии, форма 

линии определяется типом вершин, через которые она проходит. Сплайнами 

могут быть как простейшие геометрические фигуры: прямоугольники, 
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звезды, эллипсы и пр., так и сложные ломаные или кривые, а также контуры 

текстовых символов. 

Основными элементами сплайнов являются вершины (Vertex) и 

сегменты (Segment). Вершинами называют точки, расположенные на 

сплайне, при этом первая вершина, обозначающая начало сплайна, 

отмечается квадратиком белого цвета. Под сегментом принято понимать 

участок линии сплайна, ограниченный двумя соседними вершинами, − 

сегменты могут быть как прямо-, так и криволинейными отрезками. 

Вершины сплайна различаются по типу, от которого зависит степень 

кривизны прилегающих к данным вершинам сегментов сплайна. Всего 

выделяют четыре типы вершин (рис. 14): 

Corner (Угловая) − вершина, в которой сплайн имеет излом, а 

примыкающие к ней сегменты лишены кривизны. 

Smooth (Сглаженная) − вершина, через которую кривая сплайна 

проводится с плавным изгибом, а кривизна прилегающих к вершине 

сегментов одинакова с обеих сторон. 

Bezier (Безье) − вершина, напоминающая сглаженную и отличающаяся 

от нее возможностью управления степенью кривизны обоих сегментов. 

Последнее осуществляется благодаря наличию в вершине касательных 

векторов, ограниченных на концах маркерами в виде квадратиков зеленого 

цвета и называемых ручками Безье. Перемещая ручки Безье, можно изменять 

направление, в соответствии с которым сегменты сплайна входят в вершину 

и выходят из нее, а изменяя расстояние от маркеров до вершины — 

регулировать степень кривизны сегментов сплайна. У вершин данного типа 

ручки Безье связаны между собой, и перемещение одной из них 

автоматически вызывает перемещение второй. 

Bezier Corner (Безье угловая) − вершина, имеющая касательные 

векторы, позволяющие управлять степенью кривизны сегментов, однако, в 

отличие от вершин Bezier, у вершин Bezier Corner касательные векторы не 
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связаны друг с другом и перемещение одного из маркеров не зависит от 

перемещения другого (рис.14). 

 

 

 

Corner (Угловая) 

 

 

Smooth (Сглаженная) 

 

 

Bezier (Безье) 

 
 

 

Bezier Corner (Безье угловая) 

Рисунок 14 – Сплайны 

Сплайновые кривые (spline curves) это смоделированные таким образом 

кривые (Безье или NURBS), что они могут служить заготовками для 

построения поверхностей. При отображении на экране и при финальной 

визуализации кривые аппроксимируются линейными отрезками с заданной 

точностью. 

NURBS-кривые (Non-Uniform Rational B-splines surfaces) это наиболее 

универсальный и эффективный способ моделирования неоднородных 

криволинейных поверхностей. NURBS расшифровывается как 
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Неоднородный Рациональный B-сплайн. кривая B-сплайна − кривая, 

полученная после некоторой интерполяции точек − вершин многоугольника. 

Приближение многоугольника к кривой производится по определенной 

схеме. Существует множество различных кривых, которые обладают одним 

свойством − они получены из определительного (направляющего) 

многоугольника (рис.15). 

 

 
Рисунок 15 – NURBS-кривые 

 

Фрактальная графика является на сегодняшний день одним из самых 

быстро развивающихся перспективных видов компьютерной графики. 

Математической основой фрактальной графики является фрактальная 

геометрия. Здесь в основу метода построения изображений положен принцип 

наследования от, так называемых, «родителей» геометрических свойств 

объектов-наследников.  

Понятия фрактал, фрактальная геометрия и фрактальная графика, 

появившиеся в конце 70-х, сегодня прочно вошли в обиход математиков и 

компьютерных художников. Слово фрактал образовано от латинского fractus 

и в переводе означает «состоящий из фрагментов». Оно было предложено 

математиком Бенуа Мандель-Бротом в 1975 году для обозначения 

нерегулярных, но самоподобных структур, которыми он занимался. 

Фракталом называется структура, состоящая из частей, которые в 

каком-то смысле подобны целому. Одним из основных свойств фракталов 

является самоподобие. Объект называют самоподобным, когда увеличенные 

части объекта походят на сам объект и друг на друга. Перефразируя это 
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определение, можно сказать, что в простейшем случае небольшая часть 

фрактала содержит информацию обо всем фрактале.  

Фрактальная компьютерная графика позволяет создавать абстрактные 

композиции, где можно реализовать такие композиционные приѐмы как, 

горизонтали и вертикали, диагональные направления, симметрию и 

асимметрию 

С точки зрения машинной графики фрактальная геометрия незаменима 

при генерации искусственных облаков, гор, поверхности моря. Фактически 

благодаря фрактальной графике найден способ эффективной реализации 

сложных неевклидовых объектов, образы которых весьма похожи на 

природные. Геометрические фракталы на экране компьютера − это узоры, 

построенные самим компьютером по заданной программе (рис. 16). 

Фрактальная графика является вычисляемой. Изображение строится по 

уравнению или системе уравнений. Поэтому в памяти компьютера для 

выполнения всех вычислений, ничего кроме формул хранить не требуется. 

 

 
Рисунок 16 – Фрактальная графика Сильвия Кордедда (Silvia Cordedda) 
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Геометрические фракталы. В 1904 г. математик Хелъге фон Кох 

открыл простейший фрактал − триадную кривую (рис.17). 

 

 
Рисунок 17 – Построение триадной кривой Коха 

 

Кривая Коха является типичным геометрическим фракталом. Процесс 

еѐ построения выглядит следующим образом. В центре фрактальной фигуры 

находится еѐ простейший элемент − равносторонний треугольник, который 

получил название «фрактальный». Затем на среднем отрезке сторон строятся 

равносторонние треугольники со стороной, равной 1/3а от стороны 

исходного фрактального треугольника. В свою очередь, на средних отрезках 

сторон полученных треугольников, являющихся объектами − наследниками 

первого поколения, выстраиваются треугольники − наследники второго 

поколения со стороной 1/9а от стороны исходного треугольника. Таким 

образом, мелкие элементы фрактального объекта повторяют свойства всего 

объекта. Полученный объект носит название «фрактальная фигура». Процесс 

наследования можно продолжать до бесконечности (рис.18). РЕ
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Рисунок 17 – Снежинка Коха 

 

Алгебраические фракталы. Это самая крупная группа фракталов. 

Свое название они получили за то, что их строят на основе алгебраических 

формул, иногда весьма простых. Примером этого вида фракталов является 

множество Мандельброта (рис. 18, 19). 

 

 
Рисунок 18 – Фрактал Мандельброта 
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Рисунок 19 – Множество Мандельброта 

 

Стохастические фракталы. Еще одним известным классом фракталов 

являются стохастические фракталы. Фракталы, при построении которых 

случайным образом изменяются какие-либо параметры, называются 

стохастическими. Термин «стохастичность» происходит от греческого слова, 

обозначающего «предположение» (рис.20). 

Стохастическим природным процессом является броуновское 

движение. С помощью компьютера такие процессы строить достаточно 

просто: надо просто задать последовательности случайных чисел и настроить 

соответствующий алгоритм. При этом получаются объекты, очень похожие 

на природные, − несимметричные деревья, изрезанные береговые линии 

и т. д. Двумерные стохастические фракталы используются при 

моделировании рельефа местности и поверхности моря. 
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Рисунок 20 – Стохастические фракталы 

 

Объекты, обладающие признаками фракталов, воспринимаются 

человеческим глазом как высшее проявление гармонии и красоты. Кроны 

деревьев и горные хребты, уникальные узоры снежинок и «золотые» спирали 

морских раковин и волн, кристаллы и кораллы – мы готовы бесконечно 

созерцать их и в живой природе, и на полотнах художников. Как выяснилось, 

это занятие еще и целительно: согласно многолетним исследованиям 

американских ученых, оно понижает уровень стресса на целых 60 процентов. 

Фракталы давно и прочно обосновались в изобразительном искусстве, 

начиная с канувших в лету цивилизаций ацтеков, инков и майя, 

древнеегипетской и древнеримской. Во-первых, их достаточно сложно 

избежать при изображении живой природы, где фракталоподобные формы 

встречаются сплошь и рядом. 

В 20 веке фрактальные структуры получили наибольшее 

распространение в направлениях оп-арт (оптическое искусство) и имп-арт (от 

слова impossible – невозможный). Первое из них выросло в 1950-е годы из 

абстракционизма, точнее говоря, отпочковалось от геометрической 

абстракции. Одним из первопроходцев оп-арта был Виктор Вазарели – 

французский художник с венгерскими корнями (рис 21). 
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Рисунок 21 – Виктор Вазарели «Клонопин» (слева) и «Гуива» (справа) 

 

А вот на поприще имп-арта, которое выделяют как самостоятельное 

течение внутри оптического искусства, прославился нидерландский 

художник Мауриц Корнелис Эшер. Он применял в создании работ приемы, 

основанные на математических принципах (рис.22). 

 

 
Рисунок 22 – Мауриц Корнелис Эшер «Бабочки» (слева) и «Все меньше и 

меньше» (справа) 

Сегодня создание фрактальных паттернов не составляет особого труда. 

Существует множество компьютерных программ, позволяющих 

синтезировать их в несметном количестве при соответствующей 

художественной ценности. Но все еще есть авторы, трудящиеся на этом 

поприще по старинке, используя не цифровые, а вполне осязаемые средства. 
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Один из достойных внимания – доктор нейробиологии Пенсильванского 

университета Грег Данн (рис.23). 

 

 
Рисунок 22 – Грег Данн «Колонки кортекса», 2014 г. 

 

Для обработки изображений на компьютере используются специальные 

программы – графические редакторы. 

Графический редактор – это программа создания, редактирования и 

просмотра графических изображений. 

Графические редакторы можно разделить на две категории: растровые 

и векторные. 

Программы растровой графики работают с точками экрана 

(пикселями). Точки не знают, какие объекты они представляют — 

окружности, линии, прямоугольники. 

Компьютер запоминает цвет каждой точки, а пользователь из таких 

точек собирает рисунок, как в детской мозаике. 

Достоинства растровой графики: 

Растровые редакторы являются наилучшим средством обработки 
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фотографий и рисунков, т.к. обеспечивают высокую точность передачи 

градаций цветов и полутонов. 

Недостатки растровой графики: 

Изображения, создаваемые в растровых программах, всегда занимают 

много памяти. По этой причине информация в файлах растрового формата 

хранится, как правило, в сжатом виде. 

Растровые изображения невозможно увеличивать для уточнения 

деталей. Так как изображение состоит из точек, то увеличение приводит к 

тому, что точки становятся крупнее, что визуально искажает иллюстрацию. 

Этот эффект называется пикселизацией. 

Применение 

Применяется для обработки фотоизображений, художественной 

графике, реставрационных работ, работ со сканером. 

Графические редакторы, в которых используется растровая 

графика: Paint, PhotoShop. 
 

Программы векторной графики хранят информацию об объектах, 

составляющих изображение в виде графических примитивов: прямых линий, 

дуг окружностей, прямоугольников, закрасок и т.д. 

Достоинства векторной графики: 

Преобразования без искажений. 

Маленький графический файл. 

Рисовать быстро и просто. 

Независимое редактирование частей рисунка. 

Высокая точность прорисовки (до 1 000 000 точек на дюйм). 

Редактор быстро выполняет операции. 

Недостатки векторной графики: 

Векторные изображения выглядят искусственно. 

Ограниченность в живописных средствах. 

Применение 

Применяется в компьютерной полиграфии, системе компьютерного 
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проектирования, компьютерном дизайне и рекламе. 

Графические редакторы, в которых используется векторная 

графика: Corel Draw, Adobe Illustrator. 
 

Adobe Photoshop − многофункциональный графический редактор, 

разработанный и распространяемый фирмой Adobe Systems. В основном 

работает с растровыми изображениями, однако имеет некоторые векторные 

инструменты. Продукт является лидером рынка в области коммерческих 

средств редактирования растровых изображений, и наиболее известным 

продуктом фирмы Adobe. 

Adobe Illustrator − векторный графический редактор, разработанный и 

распространяемый фирмой Adobe Systems. Adobe Illustrator был задуман как 

редактор векторной графики, однако дизайнеры используют его в самых 

разных целях, в том числе и в виде иллюстратора. Он очень удобен для 

быстрой разметки страницы с логотипом и графикой — простого 

одностраничного документа. 

CorelDRAW − векторный графический редактор, разработанный 

канадской корпорацией Corel. Версия продукта − CorelDRAW Graphics Suite 

X5, доступна только для Microsoft Windows. В 2002 году вышла последняя 

11-я версия для Macintosh. 

Работая с 2D-графикой, дизайнер может заниматься как простым 

скетчингом (созданием эскизов), так и профессиональной обработкой с 

использованием масок и фильтров. Однако, даже при работе с 

нетребовательными программами, стоит предусмотреть небольшой «запас» 

на будущее. Самый мощный и предоставляющий максимум функций 

инструмент – Photoshop. По требованиям к этому редактору и стоит собирать 

компьютер, у которого должно быть не меньше 4-8 ГБ оперативной памяти, 

процессор с частотой от 2,9 ГГц. Требований к видеокарте практически нет. 

  

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



Лекция 5 

Тема 5. Цифровое искусство 

Искусство – это способ познания, при помощи которого человек 

осваивает мир и себя в этом мире. 

Искусство познает внешний и внутренний, существующий и 

воображаемый миры или их части, находит и выделяет общие и особенные 

черты, создает образы этих миров. Через созданные образы человек, 

общество и все человечество в целом присваивает, делает своей, близкой и 

понятной ту часть внутреннего и внешнего мира, для которой создан образ. 

Через созданные по заказу общества образы идеального мира человек 

пытается влиять на внешний и внутренний мир, изменяя его так, чтобы он 

приблизился к идеалу. 

Digital Art – цифровое искусство. Появление этого термина связано с 

тем, что любое действие, которое выполняет компьютер или другой гаджет 

есть результат определенных операций, записанных двоичным кодом. Это 

довольно условный термин для определения искусства, совсем не 

исчерпывающий содержания того, что создается при помощи цифровых 

технологий. Этот термин, относится скорее к технической стороне вопроса, 

чем к тому, что именно создает Digital Art. Именно по этой причине следует 

понимать, что рассматривать произведения Digital Art следует не с точки 

зрения их цифрового происхождения, а с точки зрения решаемой 

художественной задачи. Так же, как мы рассматриваем картину, написанную 

маслом не с точки зрения техники, а с точки зрения того, как и что на ней 

изображено. Безусловно, техническая сторона важна, она определяет уровень 

возможностей, но основным критерием является именно наличие 

художественной задачи и ее решения. 

Первоначальным видом цифрового искусства стало, алгоритмическое 

искусство или Mathematical Art. Это изображения или звуки, которые 

генерируются самим компьютером на основе написанного алгоритма. 

Особенностью такого изображения или звука является его неполная 
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предсказуемость. То есть, задать определенный вид изображения или 

мелодии получится, но полностью исключить влияние случайных изменений 

невозможно. Алгоритмическое искусство, особенно искусство создания 

фракталов, способно представить зрителю картины необычайной сложности 

и красоты. 

Алгоритмическое искусство является частью того, что 

называется Science Art и представляет собой визуализацию математических 

моделей. Но союз науки и Digital Art не исчерпывается только этим. Сюда 

входит, например, Data Art (визуализация больших данных), создание 

трехмерных моделей биологических объектов, физических явлений и 

процессов и многое другое. Венгерский цифровой художник Robert Szűcs, к 

примеру, создал художественную карту всех речных систем континентов, 

превратив географические объекты в эффектные живописные 

полотна (рис.23). 

 

 
Рисунок 23 – Роберт Сюч. Реки Азии. / Robert Szűcs. Asian rivers. 

 

Наверное следующим по времени возникновения стало создание 

изображений в простейших растровых графических редакторах. Это 
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направление получило название Pixel Art. Название происходит от того, что 

изображение редактировалось на уровне пикселя, т. е. на уровне точки. 

Решающим тут было разрешение экрана. Оно в ту эпоху было настолько 

маленьким, что каждый пиксель был виден, отчего при увеличении картинка 

становилась похожей на мозаику. В этом была своя прелесть. Ограниченные 

возможности, как по цветам, так и по работе с формами, заставляли 

художников находить интересные решения, делать обобщения, выявлять 

самое характерное. 

Digital Photography – цифровая фотография. Некоторые операции, 

например, вычитание шумов, которые раньше были невыполнимы, теперь 

стали доступными. Переход на цифровые фотоаппараты дал возможность 

делать неограниченное количество кадров и отбирать только самые лучшие. 

Сочетание фотографии с возможностями графических редакторов 

позволило художникам создавать высокохудожественные изображения. 

Изменение цветовой гаммы, трансформирование объектов, применение 

специальных эффектов, введение в фотографию дополнительных 

изображений на этапе редактирования — все это помогает фотохудожнику 

расставить акценты, генерировать дополнительные смыслы, т. е. создать 

произведение искусства. 

Digital Art, представленное в выставочном пространстве называют 

интерактивное и иммерсивное искусство (Immersive Art). Иммерсивное − 

это также интерактивное искусство, но с более полным вовлечением зрителя 

в атмосферу. В каком-то смысле это тоже алгоритмическое искусство, просто 

определенные алгоритмы запускаются в результате действий зрителя. Самая 

последняя новинка в этом направлении − трехмерное рисование (рис.24). 
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Рисунок 24 – Иммерсивная выставка в Музее цифрового искусства в Токио. / 

Museum of Digital Art. Tokyo. 

 

Еще одно крупное направление − цифровая иллюстрация (Digital 

Illustration). Здесь мы с вами перемещаемся уже в ту сферу, где компьютер 

перестает активно участвовать в создании изображения, а становится просто 

инструментом, при помощи которого художник делает работу, так сказать 

«от руки». То есть иллюстратор не вдается в технические подробности того, 

как и чем обеспечена возможность рисования, а просто рисует стилусом на 

планшете или экране, как рисовал бы на листе бумаги. Этим он ничуть не 

отличается от своего традиционного собрата, который не вникает в то, как 

создавался линер, кисть, акварель или гуашь и какие технологические 

цепочки прошла бумага. 

Цифровая иллюстрация, чаще всего, представлена векторной графикой, 

облегчающей полиграфическое воплощение изображения. Однако есть ряд 

художников, которые создают иллюстрации и в растре. 

У иллюстрации, как традиционной, так и цифровой, есть свои законы, 

которые диктуют формат изображения, и, прежде всего, композиционное 

решение. Иллюстрация не столь самостоятельна, как реализация авторского 
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замысла художника, она прочно связана с текстом или событием, но, в 

конечном итоге, она так же решает задачи, которые диктует время. 

Цифровая живопись или Digital Painting в графических редакторах 

художник работает как с утилитарным инструментом. Самые лучшие 

представители этого направления не используют ничего, кроме небольшого 

набора кистей и палитры, работая на планшете или экране по всем канонам 

традиционной живописи − выбор холста, подмалевок, расположение масс, 

грубый эскиз, постепенная доработка деталей. 

3D Art, изображения, созданное с помощью графических редакторов 

трехмерное виртуальное пространство, в которое встраиваются объемные 

формы.  

Видео игры (Video Games Art). Существование способа создания и 

презентации единства изображения, звука и геймплея становится 

сильнейшим стимулом для постановки художественных задач и путей их 

решения. лучшие из видео игр демонстрируют союз великолепных 

визуальных художественных находок, отличной литературной основы, 

прекрасной музыки и увлекательного экшена. 

Видео игры выполняют все функции, присущие искусству. Они 

выступают инструментом познания как существующего мира, так и мира 

воображаемого. Они позволяют игроку осваивать этот познаваемый мир и 

присваивать его через персональное участие в действии. Они формируют 

свою виртуальную среду и через нее оказывают значительное влияние на мир 

реальный. И − самое главное − они выполняют в нашей жизни ту 

глобальную, единую задачу, над которой работали художники всех времен и 

народов. Эта задача состоит в преодолении страха смерти и обеспечении 

бессмертия. Именно этим в конечном итоге занимается любое искусство. 

Видео игры дают нам, пусть эфемерную, но вполне ощутимую возможность 

познать ужас смерти и радость воскрешения. 
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Цифровая музыка (Digital Music), либо сгенерированнуюая 

компьютером, либо написанная человеком с использованием компьютера как 

инструмента. 

В качестве некоторого самостоятельного направления рассматривают 

фанарт (Fan Art) и культуру фанфиков, когда изобразительный ряд и 

литературные произведения создаются по мотивам уже существующих игр, 

фильмов, романов. 

К цифровому искусству относятся также анимационные фильмы и 

фильмы с использованием цифровой графики, работы в дополненной 

реальности (Augmented Reality, AR) и создание виртуальной 

реальности (Virtual Reality), синергетичные направления цифрового 

искусства: демосцена, компьютерный перформанс, 3D-мэпинг. 

Термин «демосцена» («demoscene») мало того, что не переводится на 

русский язык, но даже и в английском языке имеет не вполне очевидный 

смысл. Если со словом «demo» всѐ интуитивно понятно − оно происходит от 

слова «demonstration» («демонстрация»), то со словом «scene» всѐ куда 

сложнее. Своим появлением оно обязано вовсе не театру, как могло бы 

показаться, а возникшей в конце 1970-х практике нелегального 

распространения и взлома программного обеспечения, главным образом − 

компьютерных игр. Демосцена − разновидность творчества на стыке 

компьютерной графики, музыки и, собственно, программирования, а также 

сложившаяся вокруг него субкультура. Первые демоэксперименты относятся 

к 1980-м − времени, когда в Европе и США появилось достаточное 

количество домашних компьютеров, обладатели которых стремились 

заставить машину выполнять несвойственные ей задачи. Главной 

особенностью является выстраивание сюжетного видеоряда, создаваемого в 

реальном времени компьютером, по принципу работы компьютерных игр. 

Демо является симбиозом программирования и искусства. 

Интерактивный компьютерный перформанс − вид визуального 

искусства, произведением в котором являются любые действия художника, 
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наблюдаемые в реальном времени. В основе перфоорманса лежит 

представление об искусстве как об образе жизни, предшествующем созданию 

каких-либо материальных объектов и даже делающей их  излишними. 

Сегодня мир визуальных искусств способен предложить нам нечто 

большее, чем просто созерцание. На базе технологически сложных структур 

создается некая "окружающая среда", которая напоминает театральное 

зрелище, представление, в которое активно вовлекается "зритель" 

(пользователь компьютера). Он может перемещаться в виртуальном 

пространстве, воздействовать на "окружающую среду" и изменять ее. При 

использовании интерактивных систем в концертной практике границы между 

композицией и перформансом часто оказываются размытыми. 

Видео-мэппинг или 3D MAPPING − это направление в аудио-

визуальном искусстве, представляющее собой 3D-проекцию на физический 

объект окружающей среды с учетом его геометрии и местоположения 

в пространстве. 

В отличие от использования 3D-технологий в кино и компьютерных 

играх, видео-мэппинг не требует дополнительных приспособлений для 

зрителей или установку экранов. 

Основное отличие 3D MAPPINGа от обычной подсветки зданий и 

сооружений посредством проекторов − это видео контент. В примере 

с 3D MAPPING, ролик пишется индивидуально под каждое здание, каждый 

его элемент обыгрывается в ролике и соответственно задействован в нем. 

Окна вырезаются, колонны, двери, балконы, арки − все объекты являются 

элементами светового шоу (рис.25). 
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Рисунок 25 – Фестиваль «Круг Света», 3Д проекция на Большом театре 

 

В зависимости от типа поверхности 3Д-мэппинг принято условно 

делить на несколько категорий: 

архитектурный (интерьерный) – проекция выводится на фасад здания. 

В процессе представления различные архитектурные элементы могут 

принимать самые невероятные формы, например, здание может разрушаться 

на глазах изумленных зрителей, статуи оживать, окна подмигивать и пр.; 

интерьерный – проекционной поверхностью в этом случае служит 

стена, пол, потолок внутри помещения; 

объектный или объемный – проекция выводится на небольшие объекты 

или отдельные элементы больших. Картинка может быть выведена на 

различные предметы интерьера, электропроводку, музыкальное 

оборудование и пр. С помощью технологии можно создать иллюзию 

трансформации или движения любого предмета. 

ландшафтный – на природные объекты (скала, дерево, обрыв), сюда 

отнесят трехмерный мэппинг на водных объектах, активно развивающийся в 

последнее время; 

интерактивные – главную роль исполняет человек, при помощи разного 

инструментария зритель напрямую влияет на то, что отображает проекция. 
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High Dynamic Range Imaging, HDRI или просто HDR — технологии 

работы с изображениями и видео, диапазон яркости которых превышает 

возможности стандартных технологий. 

Чаще всего термин HDR употребляется в отношении получения, 

хранения и обработки растровых изображений. 

Наиболее актуальная на сегодняшний день категория HDRI-

изображений − это полноохватные текстуры (environment maps), 

объединяющие виды из заданной точки зрения во всех возможных 

направлениях. Востребованность таких текстур, в свою очередь, 

обуславливается растущей популярностью IML-алгоритмов визуализации. В 

IML-алгоритмах HDRI-изображения используются для моделирования 

освещения виртуальной сцены, что позволяет дизайнерам избежать 

утомительного процесса ручной настройки параметров точечных источников 

света и облегчает задачу «вживления» синтетических объектов в реальный 

антураж. Хотя первые разработки в области IML с использованием HDRI-

текстур появились почти 20 лет назад, высокая ресурсоемкость до недавнего 

времени сдерживала их широкую коммерциализацию. При составлении 

HDRI-библиотек считается неизменность положения Солнца на небосводе во 

всей серии изображений. Это обеспечивает взаимозаменяемость HDRI-

текстур при компоновке сцены и задании свойств материалов. 
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2. ПРАКТИЧЕСКИЙ РАЗДЕЛ 

Практическое занятие 1 

Тема 2 Стиль. Историческая база стилевой классификации 

Цель: научиться выполнять анализ смыслового содержания природного 

объекта для наглядно-образного представления наиболее существенных и 

значимых качеств, свойств, признаков. 

Задание. Стилизация и трансформация природного объекта по 
собственному или заданному свойству в декоративно-прикладном изделии. 

Порядок выполнения 

1. На основе анализа смыслового содержания понятия «магнолия» выявить 

его морфологические, физические, функциональные свойства и признаки, 

затем изобразить графическую композицию цветка, образно подчинив все 

структурные элементы свойству или признаку. 

2. На основе содержательного анализа объекта живой природы и 

декоративно-прикладного изделия выявить для их наглядно-образного 

представления наиболее существенные и значимые качества, свойства, 

признаки и характеристики, определить художественно-композиционные 

средства и принципы для их визуального выражения (рис.26). 

 

    

Рисунок 26 – Этапы стилизации 
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Практическое занятие 2 

Тема 3 Приемы получения изображений в графическом дизайне 

Цель: научиться преобразовывать натуру в графическом дизайне, 

применяя приемы стилизации и трансформации, различать и 

интерпретировать оттенки цвета, рассматривать цвет независимо от 

предметных связей. 

Задание. Создание собственной композиции на основе стилизации и 

трансформации произведения искусства, пример на рисунке 27а и 27б. 

Порядок выполнения 

1. Выбрать произведение искусства 

2. Найти композиционное размещение изображения на рабочей 

плоскости листа, используя цветовые пятна, линии, не разрушающие 

плоскость 

3. Передать характерные формы и их пропорции, линейно-тоновые 

отношения, достичь целостности и выразительности в отображении заданной 

картины, композиционное равновесие.  

Пятна не должны иметь тоновых модуляций внутри. Изображение 

решается в значительной степени заданным повторением цвета бесконечное 

число раз. 

Стилизованная композиция, сознательно выполненная по какому-либо 

образцу и повторяющая до мельчайших подробностей цветовую гамму, 

должна быть связана с учением об эстетическом освоении наследия 

колористической культуры. 

4. На основе стилизованной композиции создать собственную 

композицию, которая может не учитывать авторский стиль художника.  

Гармония цветовой гаммы известных живописных произведений 

используется в целях наиболее полного и всестороннего познания 

эстетической ценности колористических сочетаний и помогает созданию 

новых гармоничных сочетаний. 
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Рисунок 27а – Пример стилизации и трансформации эскиза декорации 

Н. Рериха 

 

   
Рисунок 27б – Пример стилизации и трансформации росписи блюда 

«Садко» М. Врубеля 

 

Практическое занятие 3 

Тема 4 Теоретические основы компьютерной графики и 
геометрического моделирования 

Цель: приобрести навыки создания цветовых гармоний, используя 

программы компьютерной графики. 

Задание 1. Выполните цветовой круг по системе Иттена, открасив его и 

сохранив единую тональность различных цветов (рис. 28), воспользовавшись 

ресурсом компании Adobe − https://color.adobe.com/ru/create/color-wheel   

 
Рисунок 28– Цветовой круг Иттена 
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Порядок выполнения 

1. Создайте три равносторонних треугольника и выкрасите их в 

первичные цвета (красный, желтый, синий).  

2. Добавьте треугольники со смесовыми цветами – вторичные цвета. 

3. Проведя окружности, открасьте этими цветами их части, а затем − 

все остальные, полученные смешением остальных. 

Задание 2. Составьте цветовые гармонии. 

Порядок выполнения 

1. Создайте концентрические окружности для шести сочетаний. 

2. закрасьте окружности цветами по видам цветовых гармоний:1) 

комплементарное сочетание, 2) контрастную триаду, 3) классическую триаду, 

4) аналоговая триада, 5) классическую тетраду, 6) прямоугольную схему. 

Задание 3. Определите цветовое решение выбранной картины 

художника. 

Порядок выполнения 

1. Выберите в интернете и скачайте цифровую репродукцию картины. 

2. Загрузите картину на ресурс Adobe Color 

https://color.adobe.com/ru/create/image 

3. Опишите цветовое решение картины. 

Задание 4. Составьте цветовое решение времен года 

1. Загрузите программу растровой графики. 

2. Создайте файл формата А4, разделите на четыре области. 

3. Изобразите при помощи инструментов Кисть и Выделения цветовое 

настроение времен года. 

Источник информации: «Искусство цвета»: оптические эффекты, 

которые работают в дизайне. Подробный гайд по теории цвета Иоханнеса 

Иттена. // Skillbox Media. Дизайн [Электронный ресурс] 26 июля 2021 
https://skillbox.ru/media/design/iskusstvo-tsveta/#stk-12  
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Практическое занятие 4 

Тема 5. Цифровое искусство. 

Цель: систематизировать данные по цифровому искусству 

Задание 1. Подобрать и прокомментировать визуальный материал по 

направлениям цифрового искусства 

Порядок выполнения 

Создать и заполнить данными таблицу: 

Направление 

Цифрового искусства 

Визуальный пример Пояснения 

   

   

 

Задание 2. Изучить Предметы прикладного искусства, быта и 

этнографии Государственного Эрмитажа, Россия. 

Порядок выполнения 

1. Посетить виртуальный музей Государственный Эрмитаж Россия, 

категорию − Предметы прикладного искусства, быта и этнографии 

http://collections.hermitage.ru/entity/OBJECT?category=2671  

2. Составить таблицу 

Изображение 

предмета 

искусства 

Название 

предмета 

искусства 

Место 

создания 

предмета 

искусства 

Дата 

создания 

предмета 

искусства 

Материал/ 

техника 
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Практическое занятие 5 

Тема 6. Создание композиций 

Цель: выработка навыков создания плоскостных фронтальных 

композиций на основе абстрактных геометрических элементов с 

применением средств композиционной гармонизации. 

Задание 1. Организовать ритм: простыми графическими средствами: 

точка, линия, пятно (рис. 29).  

Порядок выполнения 

1. Загрузить программу векторной графики. 

2. Создать шесть страниц размером 10х10 см. 

3. Создать изображение как показано на рисунке. 

4. Оформить в цветовой гармонии. 

 

 
Рисунок 29 – Создание ритма 

 

Задание 2. Создать фронтальную плоскостную композицию на тему 

«Статика и динамика» 

Порядок выполнения 

1. Загрузить программу векторной графики. 
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2. Для композиции создать простые геометрические фигуры, близкие 

друг другу по размерам (квадрат, прямоугольник, треугольник, и т.д.). 

Количество элементов варьируется от 5 до 7. 

3. Разместить фигуры так, чтобы создать статичные и динамичные 

композиции из геометрических фигур. Основной задачей является 

организация целостной структуры и умение вписать композицию в плоскость 

выбранного формата. Пример на рисунке 30. 

4. Оформить в цветовой гармонии. 

 

 
Рисунок 30 − Статичные и динамичные композиции 
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Лабораторные работы 

Тема 6 Создание композиций 

Лабораторная работа 1 Создание композиции из графических 

объектов 

Цель: Научиться использовать инструменты создания и преобразования 

контуров, комбинировать контуры в программе векторной графики. 

Задание 1. Создать Объекты (рис. 31) 

Line Segment (Линейный сегмент); 

Arc (Дуга); 

Spiral (Спираль); 

Restangle Grid (Прямоугольная сетка); 

Polar Grid (Полярная сетка); 

Restangle (Прямоугольник); 

Rounded Restangle (Скругленный прямоугольник); 

Ellipse (Эллипс); 

Poligon (Многоугольник); 

Star (Звезда) 

 

 
Рисунок 31 – Векторные объекты 

 

Порядок выполнения 

1. Создание отрезка 
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1.1 Выберите инструмент «Отрезок линии» . 

 

1.2 Выполните одно из следующих действий: 

− Поместите указатель в ту точку, где должна начинаться линия, и 

перетащите его в точку ее окончания. 

− Щелкните в том месте, где должна начинаться линия. В диалоговом 

окне укажите значения длины и угла линии. Чтобы окрасить линию в 

текущий цвет заливки, выберите параметр Окрашивать отрезок в цвет 

заливки. Затем нажмите ОК. 

2. Рисование дуг 

2.1 Нажмите и удерживайте инструмент «Отрезок линии» ( ). 

Выберите инструмент «Дуга» . 

2.2 Выполните одно из следующих действий: 

− Поместите указатель в ту точку, где должна начинаться дуга, и 

перетащите его в точку ее окончания. 

− Щелкните в том месте, где должна начинаться дуга. Чтобы 

определить точку, из которой будет нарисована дуга, щелкните в диалоговом 

окне квадратик на локаторе неподвижной точки . После этого задайте 

любые из следующих параметров и нажмите кнопку ОК. 

Длина по оси Х. Определяет ширину дуги. 

Длина по оси Y. Определяет высоту дуги. 

Тип. Определяет, каким контуром будет этот объект: замкнутым или 

открытым. 

Вдоль. Определяет направление дуги. Выберите «Ось X» или «Ось Y» 

в зависимости от того, вдоль какой оси должна располагаться база дуги: 

горизонтальной (x) или вертикальной (y). 

Наклон: определяет направление наклона дуги. Чтобы получить 

вогнутую дугу, введите отрицательное значение. Чтобы получить выгнутую 

дугу, введите положительное значение. При нулевом значении наклона 

получается прямая линия. 
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Окрашивать дугу в цвет заливки. Дуга окрашивается в текущий цвет 

заливки. 

3. Рисование спиралей 

3.1 Нажмите и удерживайте инструмент «Отрезок линии» ( ). 

Выберите инструмент «Спираль» . 

3.2 Выполните одно из следующих действий: 

− Перетащите курсор, пока не получите спираль нужного размера. 

Чтобы повернуть спираль, перетащите указатель в дуге. 

− Щелкните в том месте, где должна начинаться спираль. В диалоговом 

окне задайте любые из следующих параметров и нажмите кнопку ОК. 

Радиус. Определяет расстояние от центра до самой дальней точки 

спирали. 

Рост. Определяет величину, на которую каждый виток спирали будет 

уменьшаться по сравнению с предыдущим витком. 

Число сегментов. Определяет количество сегментов в спирали. 

Каждый полный виток спирали состоит из четырех сегментов. 

Стиль. Определяет направление спирали. 

4. Рисование прямоугольных сеток 

4.1 Нажмите и удерживайте инструмент «Отрезок линии» ( ). 

Выберите инструмент «Прямоугольная сетка» . 

4.2 Выполните одно из следующих действий: 

− Перетащите курсор, пока не получите сетку нужного размера. 

− Щелкните, чтобы задать неподвижную точку сетки. Чтобы 

определить точку, из которой будет нарисована сетка, щелкните в 

диалоговом окне квадратик на локаторе неподвижной точки . После этого 

задайте любые из следующих параметров и нажмите кнопку ОК. 

Размер по умолчанию. Определяет ширину и высоту всей сетки. 

Горизонтальные разделители. Определяет количество 

горизонтальных разделителей между верхним и нижним краями сетки. 

Значение «Асимметрично» позволяет распределять горизонтальные 
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разделители неравномерно с увеличением их частоты в сторону верхнего или 

нижнего края сетки. 

Вертикальные разделители. Определяет количество вертикальных 

разделителей между левым и правым краями сетки. Значение 

«Асимметрично» позволяет распределять вертикальные разделители 

неравномерно с увеличением их частоты в сторону левого или правого края 

сетки. 

Использовать внешний прямоугольник в качестве рамки. Заменяет 

верхний, нижний, левый и правый сегменты отдельным прямоугольным 

объектом. 

Окрашивать сетку в цвет заливки. Сетка окрашивается в текущий 

цвет заливки (в противном случае заливка не задается). 

5. Рисование круговых (полярных) сеток 

5.1 Нажмите и удерживайте инструмент «Отрезок линии» ( ). 

Выберите инструмент «Полярная сетка» . 

5.2 Выполните одно из следующих действий: 

− Перетащите курсор, пока не получите сетку нужного размера. 

− Щелкните, чтобы задать неподвижную точку сетки. Чтобы 

определить точку, из которой будет нарисована сетка, щелкните в 

диалоговом окне квадратик на локаторе неподвижной точки . После этого 

задайте любые из следующих параметров и нажмите кнопку ОК. 

Размер по умолчанию. Определяет ширину и высоту всей сетки. 

Концентрические разделители. Определяет количество круговых 

концентрических разделителей в сетке. Значение «Асимметрично» позволяет 

распределять концентрические разделители неравномерно с увеличением их 

частоты в сторону внутренней или внешней части сетки. 

Радиальные разделители. Определяет количество радиальных 

разделителей между центром и периферической частью сетки. Значение 

«Асимметрично» позволяет распределять радиальные разделители 
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неравномерно с увеличением их частоты по часовой стрелке или против 

часовой стрелки. 

Создать составной контур на основе эллипсов. Преобразует 

концентрические круги в отдельные составные контуры и добавляет в них 

заливку через один. 

Окрашивать сетку в цвет заливки. Сетка окрашивается в текущий 

цвет заливки (в противном случае заливка не задается). 

6. Рисование прямоугольников и квадратов 

6.1 Выберите инструмент «Прямоугольник»  или «Прямоугольник со 

скругленными углами» . 

6.2 Выполните одно из следующих действий: 

− Для рисования прямоугольника, перетащите курсор по диагонали, 

пока не получите прямоугольник нужного размера. 

− Для рисования квадрата, нажмите клавишу Shift и, не отпуская ее, 

перетащите указатель по диагонали, пока не получите квадрат нужного 

размера. 

Чтобы создать квадрат или прямоугольник путем ввода значений, 

щелкните в той точке, где должен находиться левый верхний угол фигуры. 

Укажите ширину и высоту (а также радиус угла для прямоугольника со 

скругленными углами), затем нажмите кнопку ОК. 

7. Рисование эллипсов 

7.1 Нажмите и удерживайте инструмент «Прямоугольник» ( ). 

Выберите инструмент «Эллипс» . 

7.2 Выполните одно из следующих действий: 

− Перетащите курсор по диагонали, пока не получите эллипс нужного 

размера. 

− Щелкните в той точке, где должен находиться левый верхний угол 

ограничительной рамки эллипса. Укажите ширину и высоту эллипса, затем 

нажмите кнопку ОК. 
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Примечание. Чтобы нарисовать круг, удерживайте клавишу Shift при 

перетаскивании. Чтобы указать размеры, после ввода значения ширины 

щелкните слово Высота, чтобы скопировать введенное значение в поле 

Высота. 

8. Рисование многоугольников 

8.1 Нажмите и удерживайте инструмент «Прямоугольник» . 

Выберите инструмент «Многоугольник» . 

Выполните одно из следующих действий: 

Перетащите курсор по диагонали, пока не получите многоугольник 

нужного размера. Чтобы повернуть многоугольник, перетащите указатель в 

дуге. Для добавления и удаления сторон многоугольника нажимайте 

клавиши «Стрелка вверх» и «Стрелка вниз». 

− Щелкните в той точке, где должен находиться центр многоугольника. 

Укажите радиус и количество сторон многоугольника, затем нажмите ОК. 

9. Рисование звезд 

9.1 Нажмите и удерживайте инструмент «Прямоугольник» . 

Выберите инструмент «Звезда» . 

9.2 Выполните одно из следующих действий: 

− Перетащите курсор, пока не получите звезду нужного размера. Чтобы 

повернуть звезду, перетащите указатель в дуге. Для добавления и удаления 

концов звезды нажимайте клавиши «Стрелка вверх» и «Стрелка вниз». 

− Щелкните в той точке, где должен находиться центр звезды. В поле 

«Радиус 1» укажите расстояние от центра звезды до наиболее близких к нему 

точек. В поле «Радиус 2» укажите расстояние от центра звезды до наиболее 

далеких от него точек. В поле «Концы» укажите количество концов звезды. 

Затем нажмите ОК. Рисуя звезду, вы также можете использовать клавиши 

«Стрелка вверх» и «Стрелка вниз» для увеличения или уменьшения 

количества лучей звезды. 
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Задание 2. Создайте изображение из контуров, пример на рисунке 32. 

 

 
Рисунок 32 – Изображение из контуров 

 

Порядок выполнения 

2.1 Создавайте прямоугольники, квадраты и ромбовидные фигуры 

2.1.1 Выберите инструмент Прямоугольник и перед началом работы 

установите цвета заливки и обводки на панели Свойств. 

2.1.2 Перетащите на монтажную панель, чтобы создать 

прямоугольник. Перетаскивайте до тех пор, пока не увидите диагональную 

пурпурную линию, чтобы создать идеальный квадрат. При перетаскивании 

вы заметите всплывающую подсказку на экране рядом с указателем, 

показывающим размеры. 

2.1.3 Переместите указатель немного в сторону от ограничивающей 

рамки, чтобы увидеть изогнутую стрелку. Перетащите, чтобы повернуть 

квадрат на любой угол; нажмите Shift, чтобы ограничить поворот до 45°, 

чтобы создать ромбовидную форму. 

Можно масштабировать фигуру, перетаскивая любую из восьми ручек 

ограничительной рамки, и легко сбросить угол поворота, изменить размеры и 
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внести другие изменения в разделе Преобразование панели свойств (Окно > 

Свойства) (рис.33). 

 

 
Рисунок 33 – Создание и преобразование квадрата 

 

2.2 Создайте треугольник и другие многоугольные фигуры 

2.2.1 Нажмите и удерживайте инструмент Прямоугольник на панели 

инструментов, чтобы просмотреть другие инструменты вложенных фигур, и 

выберите инструмент Полигон. 

2.2.2 Один из способов создать фигуру − просто нажать на монтажную 

панель и ввести количество сторон, например, введите 3, чтобы создать 

треугольник, или 5, чтобы создать пятиугольник. 

2.2.3 Измените размеры фигуры, перетаскивая ручки ограничительной 

рамки; нажмите клавишу Shift во время перетаскивания, чтобы ограничить 

пропорции. 

2.2.4 Щелкните снаружи, чтобы ничего не было выбрано, а затем с 

помощью инструмента Прямой выбор выберите контрольную точку и 

перетащите, чтобы преобразовать фигуру (рис.34). 
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Рисунок 34 – Создание и преобразование многоугольника 

 

2.3 Создайте круг, овал и органические формы 

2.3.1 Выберите инструмент Эллипс в том же наборе вложенных 

инструментов и перетащите, чтобы создать овал любого размера. Поищите 

прицел пурпурного цвета, чтобы создать идеальный круг. В качестве 

альтернативы нажмите клавишу Shift при перетаскивании, чтобы создать 

круг. 

2.3.2 Нажмите кнопку Снаружи, чтобы отменить выбор, а затем 

используйте инструмент Прямой выбор для управления эллиптической 

формой, чтобы создавать органические варианты для использования в 

дизайне (рис. 35). 
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Рисунок 35 – Создание и преобразование эллипса 

 

2.4 Заливка цветом 

2.4.1 Заливка цветом с помощью палитры «Образцы» (Swatches) 

Чтобы закрасить объект, откройте свою палитру «Образцы» 

(Swatches Palette). Выделите объект и нажмите на нужный цвет в 

палитре (рис. 36). 

 

 
Рисунок 36 – Заливка цветом с помощью палитры «Образцы» (Swatches) 

 

2.4.2 Заливка цветом с помощью палитры цветов (Color Picker) 

Нажмите дважды на значок «Заливка» (Fill) в панели инструментов. 

В появившемся окне «Палитра цветов» (Color Picker) выберите нужный 

цвет (рис. 37). 
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Рисунок 37 – Заливка цветом с помощью палитры цветов (Color Picker) 

 

2.5 Заливка градиентом 

2.5.1 На панели инструментов выберите градиентную заливку (Gradient 

Fill) (рис. 38). 

 

 
Рисунок 38 – Градиент на панели инструментов 

 

2.5.2 Откройте палитры «Градиент» (Gradient) и «Цвет» (Color). По 

умолчанию стоит режим цвета «Градации серого» (Grayscale). Нажмите на 

иконку настроек в углу и выберите режим RGB (рис. 39). 
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Рисунок 39 – Настройка цветового режима Градиента 

 

2.5.3 Выберите цвет. После включения режима RGB появится ползунки 

и диаграмма для выбора цвета (рис. 40).  

 

 
Рисунок 40 – Выбор цвета и вида градиента 

 

2.5.4 Изменить направление градиента, для этого выберите инструмент 

«Градиент» (Gradient Tool) на панели инструментов (Tool Palette). Кликните 

на объект и, удерживая левую кнопку мышки, задайте градиенту нужное 

направление (рис. 41). 
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Рисунок 41 – Изменение направления градиента 

 

2.5.5 Измените тип градиента на радиальный, выберите «Радиальный» 

(Radial) вместо «Линейного» (Linear) (рис. 42). 

 

 
Рисунок 42 – Изменение типа градиента 

 

Задание 3 Создание и применение произвольного градиента 

Порядок выполнения 
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Для создания или применения произвольного градиента выполните 

одно из следующих действий: 

3.1 Выберите инструмент «Градиент», затем нажмите объект на холсте. 

На панели управления или панели «Свойства» отображаются кнопки «Тип 

градиента». Выберите объект, затем нажмите Произвольный градиент, 

чтобы применить произвольный градиент к объекту. 

3.2 На панели «Градиент» нажмите Произвольный градиент . 

На панели «Свойства» нажмите Произвольный градиент в 

разделе Градиент. 

После нажатия «Произвольный градиент» будут доступны следующие 

два параметра: 

Точки. Выберите этот параметр, чтобы создать точки цвета в виде 

независимых точек на объекте. 

Линии. Выберите этот параметр, чтобы создать точки цвета на отрезке 

линии на объекте. 

3.3 Чтобы задать распределение точки цвета, выберите точку цвета и 

выполните одно из следующих действий: 

− На панели «Градиент» выберите или введите значение в 

раскрывающемся списке Распределение. 

− Введите значение в раскрывающемся списке Распределение на 

панели управления, панели «Свойства» или панели «Градиент». Можно 

также использовать шкалу, которая отображается при 

нажатии Распределение. 

По умолчанию для распределения точки цвета установлено 

значение 0%. 
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Лабораторная работа 2. Создание композиции при помощи 

инструмента Перо 

 

Цель: Научиться использовать инструмент Перо при создании 

изображения в программе векторной графики. 

 

Задание 1 Создайте прямолинейный и криволинейный контуры с 

преобразованием вершин, замкнутый контур. 

Порядок выполнения 

1. Выберите инструмента Перо и кликните один раз, чтобы добавить 

первую узловую точку. Переместите курсор к следующей позиции и 

кликните опять, чтобы создать вторую точку. Две точки соединятся между 

собой. Продолжайте, чтобы получилась фигура в виде буквы W как на 

рисунке431. Чтобы нарисовать новую линию переключитесь на инструмент 

Выделение и опять на инструмент Перо. 

 

 
Рисунок 43 – Прямолинейный контур 

 

2. Создайте закрытый контур. Чтобы закрыть контур кликнуть снова на 

начальной точке, чтобы получилась фигура рисунок 44. 
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Рисунок 44 – Закрытый контур 

 

3. Нарисуйте изогнутую линию. Кликаем и передвигаем 

направляющие, чтобы создать плавную опорную точку рисунок 45. 

 
Рисунок 45 – Плавный контур 

 

4. Изменить направление контура. Кликните и переместите 

направляющие, чтобы создать плавную опорную точку. Не отпуская клавишу 

мыши, нажмите Alt и переместите направляющие, чтобы изменить 

направление контура рисунок 46. 

 

 
Рисунок 46 – Изменение направления контура 
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5. Нарисовать круговой контур. Кликните и переместите 

направляющие, чтобы создать плавную опорную точку. Продолжайте 

добавлять точки и в конце кликните на начальную точку, чтобы закрыть 

контур рисунок 47.  

 

 
Рисунок 47 – Создание кругового контура пером 

 

6. Добавьте опорные точки. С активным инструментом Перо, подводим 

курсор к контуру, куда планируем добавить точки. Появится значок плюс 

возле иконки инструмента, кликните на контур, чтобы добавить новую 

опорную точку рисунок 48. 

 

 
Рисунок 48 – Добавление опорной точки 
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7. Удалить опорные точки. Чтобы убрать точку, подведите инструмент 

Перо к узлу. Появится значок минуса рядом с пером. Кликните на узловую 

точку, чтобы удалить ее (рис.49). 

 

 
Рисунок 48 – Удаление опорной точки 

 

8. Преобразовать опорные точки. Чтобы преобразовать плавную 

опорную точку в остроконечную, подведите курсор инструмента Перо и 

нажмите Alt. Курсор изменит вид на стрелку. Кликните на плавной опорной 

точке, чтобы преобразовать ее в обычную точку. Кликните и перетащите 

опорную точку, чтобы снова сделать ее плавной рисунок 49. 

 

 
Рисунок 49 – Преобразование опорных точек 

 

9. Переместить опорные точки. Выберите инструмент Прямое 

выделение и выберите точку, которую вы хотите переместить. Кликните и 

перетаскивайте ее, чтобы изменить ее положение рисунок 50. 
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Рисунок 50 – Перемещение опорной точки 

 

10. Измените направление опорных точек. Удерживайте Ctrl чтобы 

быстро изменить инструмент Перо на инструмент Прямого выделения. 

Выберите узловую точку, которую Вы хотите отредактировать. Появится 

направляющая узловой точки. Отпустите Ctrl и нажмите и удерживайте Alt, 

чтобы изменить инструмент на Преобразование опорных точек (Convert 

Anchor Tool). Кликните и перемещайте направляющие, чтобы изменить их 

положение рисунок 51. 

 

 
Рисунок 51 – Изменение направления опорных точек 

 

Задание 2. Нарисуйте машину, используя инструмент Перо, и 

примените градиентную заливку (рис 52).  
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Рисунок 52 – Изображение машины 

 

 

Лабораторная работа 3. Создание композиции методом 

трансформации, перемещения и эффектом перехода в программе 

векторной графики. 

 

Цель: Научиться создавать композицию при помощи инструмента 

трансформации и перемещения и эффектов перехода в программе векторной 

графики. 

 

Порядок выполнения 

1. Изменение размеров объектов 

Метод 1: Выделите объект инструментом Выделение (Selection Tool), 

появится ограничивающая рамка. Потяните за угол рамки левой кнопкой 

мыши, чтобы увеличить объект (удерживайте Shift для сохранения 

пропорций) (рис. 53). 

 

 
Рисунок 53 – Изменение размеров объектов. Метод 1 

 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 

 Метод 2: Для увеличения объекта относительно начальной точки 

(центральной точки объекта) удерживайте Alt + Shift (рис.54). 

 

 
Рисунок 54 – Изменение размеров объектов. Метод 2 

 

2. Поворот объектов 

Метод 1: Выделите объект инструментом Выделение (Selection Tool), 

чтобы появилась ограничивающая рамка. Наведите курсор на угол, появится 

двусторонняя стрелочка. Потяните вправо или влево, чтобы повернуть 

объект (рис. 55). 

 

 
Рисунок 55 – Поворот объектов. Метод 1 

 

Метод 2: Чтобы повернуть объект относительно одного из углов 

выберите инструмент Поворот (Rotate Tool). Кликните на один из углов, 

чтобы установить точку разворота, захватите противоположный угол и 

разворачивайте объект (рис. 56). 
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Рисунок 56 – Поворот объектов. Метод 2 

 

Метод 3: Развернуть объект на определенный угол. Выберите 

инструмент Поворот (Rotate Tool), установите точку разворота, удерживая 

клавишу Alt, выскочит окно с настройками. Введите нужный угол и нажмите 

«OK» (рис.57). 

 

 
Рисунок 57 – Поворот объектов. Метод 3 

 

3. Наклоните объект. Выберите инструмент Наклон (Shear Tool). 

Потяните мышкой объект, чтобы наклонить его. Удерживайте Shift, чтобы 

ограничить изменения горизонтально или вертикально (рис. 58). 
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Рисунок 58 – Наклон объектов 

 

 

4. Отражение объекта. Выберите инструмент 

Зеркальное отражение (Reflect Tool), зажмите Alt и нажмите на одну из 

точек фигуры, чтобы выбрать ось отражения (рис. 59). 

 

 
Рисунок 59 – Отражение объектов 

 

 

В появившемся окне выберите Вертикально (Vertical) и нажмите 

Копировать (Copy).   

5. Трансформация объекта  

Выделите объект, правой кнопкой мышки вызовите меню. Выбираем 

Трансформирование > Трансформировать каждый (Transform > Transform 

Each). В настройках установите случайный поворот квадратов в пределах 

30 градусов и увеличение их в пределах 150%. Поставьте галочку напротив 

Случайно (Random) (рис. 60). 
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Рисунок 60 – Трансформация объекта 

 

6. Повторение последней трансформации. Выделите объект 

инструментом Выделение (Selection Tool), зажмите Alt и перетащите новую 

копию вправо, удерживая Shift. Нажмите Ctrl/Command+D, чтобы создать 

еще больше копий (рис. 61). 

 

 
Рисунок 61 – Повторение трансформации объекта 
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Лабораторная работа 4 Создание композиции с использование 

кистей и символов 

Цель: Научиться создавать композицию при помощи бордюрных 

кистей и символов в программе векторной графики. 

Задание 1. Создание и применение кистей 

Порядок выполнения 

1. Выберите инструмент «Кисть» (Brush Tool) и нарисуйте свой объект. 

2. В палитре «Кисти» (Brushes) выберите угольно-черную кисть, чтобы 

применить эффект (рис.62). 

 

 
Рисунок 62 – Применение кисти 

 

3. Нарисуйте контур и выберите каллиграфическую кисть (верхний ряд 

в палитре кистей) (рис. 63). Увеличивая толщину обводки, можно увеличить 

толщину примененной кисти. 

 

 
Рисунок 63 – Применение каллиграфической кисти 
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4. Видоизменить каллиграфическую кисть. Дважды нажав на нужной 

кисти в палитре, в появившемся окне с параметрами каллиграфической кисти 

изменить угол и диаметр (рис. 64). 

 

 
Рисунок 64 – Изменение параметров каллиграфической кисти 

 

5. Нарисуйте прямоугольник и выберите бордюрную кисть. 

6. Создайте новую бордюрную кисть. Создайте звезду и переместите ее 

на палитру «Кисти» (Brushes), в появившемся окне выберите вариант 

«Бордюрная кисть» (New Pattern Brush) (рис. 65). 

 

 
Рисунок 65 – Создание новой бордюрной кисти 
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7. Нарисуйте круг и примените к нему новую кисть (рис. 66). 

 

 
Рисунок 66 – Применение новой кисти 

 

8. Нарисуйте линейный контур и снова примените кисть. Измените 

параметры кисти в палитре и в настройках выставьте масштаб (Scale) и 

интервалы (Spacing) по 20%, чтобы получить показанный ниже 

эффект (рис. 67). 
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Рисунок 67 – Изменение параметров кисти 

 

Задание 2. Создание и применение символов обводки 

Порядок выполнения 

1. Нарисуйте графический элемент, затем выделите его и перетащите в 

палитру Символы (Symbols Palette) (рис 68). Она вызывается командой 

Окно > Символы (Window > Symbols). Нажмите OK для подтверждения 

операции. 
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Рисунок 68 – Создание символа 

 

2. Примените символ при помощи инструмента Распыление символов 

(Symbol Sprayer Tool). Выберите на (Symbol Sprayer Tool) (рис. 69).  

 

 
Рисунок 69 – Инструмент Распыление символов (Symbol Sprayer Tool) 

 

3. Дважды нажмите на инструмент Распыление символов. В настройках 

измените диаметр и интенсивность распыления (рис.70). 
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Рисунок 70 – Настройки инструмента Распыление символов  

 

4. Инструментом «Распыление символов» (Symbol Sprayer Tool) 

кликните по рабочей области, и распыляйте символы, удерживая правую 

кнопку мышки. 

5. Переключитесь на функцию Вращение символов (Symbol Spinner) в 

настройках инструмента и меняйте направление копий символа. Стрелки 

указывают направление вращения (рис. 71). 

 

 
Рисунок 71 – Применение Вращение символов (Symbol Spinner) 

 

6. Выберите функцию «Размер символов» (Symbol Sizer) и нажмите на 

символ для его увеличения. Для уменьшения размера символа, выполните 

туже операцию, но удерживайте при этом клавишу Alt (рис. 72). 
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Рисунок 72 – Применение Вращение символов (Symbol Spinner) с разными 

размерами 

 

7. Выберите опцию Обесцвечивание символов (Symbol Stainer), укажите 

желтый цвет в качестве заливки. Нажмите на ту область, которую хотите 

обесцветить. Нажмите еще раз, если хотите усилить эффект (рис. 73). 

 

 
Рисунок 73 – Применение Обесцвечивание символов (Symbol Stainer) 

 

8. Разберите символы на объекты, нажав на палитре Символы Удалить 

ссылку на символ (Break Link to Symbol) (рис. 74). 

 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



 
Рисунок 74 – Удаление ссылки на символ 

 

Переместите копию символа на рабочую область. После двойного 

нажатия на символ сделайте нужные изменения, палитра «Символы» 

обновится автоматически 

 

Лабораторная работа 5 Инструменты выделения 

Цель: Научиться использовать инструменты и приемы создания 

выделенных областей, выделять области геометрической формы, цветовые 

области в программе растровой графики. 

 

Задание 1 Создать изображения шарика при помощи областей 

выделения  

Порядок выполнения 

1. Создать новое изображение. Для этого использовать команду 

File>New... (Файл > Новый), в открывшемся диалоговом окне указать: Width 

(Ширина)   10 см, Height (Высота)   10 см, в поле Color Mode (Режим) 

выбрать режим RGB Color (Цветовой режим), в поле Background Contents 

(Заполнение фона) указать White (Белый). 

2. Установить цвета по умолчанию. Для этого нажать кнопку Default 

Foreground and Background Colors (Цвет переднего плана и цвет фона по 

умолчанию). Теперь основным установлен черный цвет, а фоновым     белый. 
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3. Создать овальное выделение для основы шарика. Для этого щелкнуть 

по значку инструмента Marquee Tool (Инструмент выделения), удерживать 

нажатой кнопку мыши. В открывшейся группе инструментов выбрать 

Elliptical Marquee Tool  (Инструмент Эллиптического выделения). 

Поместить указатель на изображение, нажать кнопку мыши и переместить по 

диагонали сверху вниз и слева направо от одного края основной части 

шарика до другого. Если область окажется больше нужной, ее можно 

уменьшить, выполнив команду Select > Modify > Contract... (Выделение > 

Изменить > Уменьшить), и в открывшемся окне указать количество 

пикселей, на которое надо уменьшить выделение. Аналогично можно 

увеличить выделение равномерно во все стороны: Select > Modify > Expand 

(Выделение > Изменить > Увеличить).  

4. Закрасить выделенную область любым цветом. Для этого на палитре 

Swatches (Образцы) выбрать понравившийся цвет. Обратить внимание, что на 

панели инструментов в области изменения цветов произошло переключение 

основного цвета: Foreground color (Цвет-переднего плана). Для заливки 

выделения нажать клавиши Alt+BackSpace. Отменить выделение, для этого 

нажать комбинацию клавиш Ctrl+D. 

5. Создать эллиптическую область выделения для блика на шарике.  

6. Закрасить его белым цветом (в данный момент он является фоновым 

цветом). Для этого нажать клавиши Ctrl+BackSpace. Для смены основного и 

фонового цветов можно также воспользоваться кнопкой Switch Foreground 

and Background Colors (Переключить цвета переднего плана и фона). После 

этого основным цветом станет белый цвет.  

7. Отменить выделение. 

8. Нарисовать шарику хвостик. Для этого сформировать треугольное  

выделение  при  помощи  инструмента Polygonal Lasso Tool (Многоугольное 

лассо), находится внутри группы Lasso (Лассо). 

Щелчками мыши в вершинах треугольника создать область выделения, 

замкнуть сформированную область одним из способов: 
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а) двойным щелчком; 

б) одинарным щелчком — при появлении кружка возле значка 

инструмента. 

9. Закрасить область. 

10. Отменить выделение.  

11. Выбрать инструмент Rectangle Marquee Tool (Прямоуголыюе 

выделение) из группы Marquee Tool (Инструменты выделения). 

На панели параметров инструментов установить Style (Стиль) для 

области выделения как Fixed Size (Фиксированный размер) и установить 

размеры: Width (Ширина)   Зрх (пкс), Height (Высота)   100рх (тсс). 

Нарисовать ниточку. 

12. Закрасить выделенную область любым цветом, отличным от цвета 

шарика. Отменить выделение.  

 

Задание 2 Изменить размер выделенной области 

Порядок выполнения 

Для уменьшения размера выделенной области использовать команду 

Select > Modify > Contract... (Выделение > Изменить > Сжать...) и в 

открывшемся окне указать количество пикселей, на которое надо уменьшить 

выделение. 

Для увеличения размера выделенной области равномерно во все 

стороны использовать команду Select > Modify > Expand (Выделение > 

Изменить > Увеличшпь...). 

 

Задание 3. Создать изображение домика, используя инструменты 

выделения 

Порядок выполнения 

1. Создать новое изображение размером 12x12 см. В поле Color Mode 

(Цветовой режим) выбрать вариант RGB Color (Цветовой режим). 
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2. Включить сетку. Для этого использовать команду View > Show 

(Вид > Показать) и установить флажок Grid (Сетка). Установить параметры 

для сетки. Для этого использовать команду Edit > Preferences > Guides, Grid 

& Slices... (Редактирование > Установки > Направляющие, сетка и 

пластины...). В открывшемся диалоговом окне в группе Grid (Сетка) 

выбрать темно-синий цвет для линий сетки, в поле Gridline every (Частота 

линий): 24 mm, в поле Subdivisions (Подразделения): 3. 

3. Включить линейки. Для этого установить флажок на пункте View 

(Вид > Rules (Направляющие). В данном случае удобнее работать, когда 

документ не развернут на весь экран. 

4. Установить привязку к сетке. Для этого использовать команду View 

> Snap To (Вид Привязка к) и установить флажок Grid (Сетка). 

5. Нарисовать основную часть дома. Для этого сформировать 

прямоугольную область выделения. Залить ее голубым цветом. Отменить 

выделение. 

6. Нарисовать крышу. Для этого сформировать прямоугольную область 

выделения. Преобразовать прямоугольную область в трапецию. Для этого 

использовать команду Select > Transform Selection (Выделение > 

Преобразовать Выделение), вокруг выделенной области появится рамка с 

маркерами. Удерживая клавишу Ctrl, потянуть за верхний левый угол вправо 

на две клетки. Аналогично сместить верхний правый угол влево на две 

клетки. Закончить трансформацию области нажатием клавиши Enter. 

Закрасить полученную область коричневым цветом. Отменить выделение. 

7. Нарисовать трубу и закрасить ее оранжевым цветом. 

8. Нарисовать окно, закрасить его желтым цветом. Не убирать 

выделение. Выбрать инструмент Move Tool (Перемещение) и при нажатой 

клавише Alt переместить выделенную область на место второго окна. При 

этом получается копия окна. 
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9. Нарисовать занавески. Для этого при помощи инструмента Polygonal 

Lasso Tool (Многоугольное Лассо), сформировать соответствующую область. 

Закрасить занавески красным цветом и переместить копию на второе окно. 

10. Отключить привязку к сетке. Для этого использовать команду 

View > Snap To (Вид > Привязка к) и убрать флажок Grid (Сетка). И. 

Отключить видимость сетки. Для этого использовать команду View > Show  

(Вид > Показать) и убрать флажок с пункта Grid (Сетка).  

Справка. Установка начала отсчета линеек. Для установки начала 

координат в левом верхнем углу листа надо выполнить двойной щелчок на 

месте пересечения горизонтальной и вертикальной линеек. 

Задание 4 Создать изображение флага Республики Беларусь 
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Тема 7. Цифровое изображение. Тоновая и цветовая коррекция 

Лабораторная работа 6. Цветовые пространства изображений 

Цель: научиться работать с цветовыми пространствами Bitmap, 

Greyscale, Duotone, Index, RGB, CMYK, HSB, Lab и преобразовать цветовые 

пространства изображений. 

 

Задание 1 Определить цветовую модель изображения. 

Порядок выполнения 

1. Открыть файл. 

2. Найти название документа в заголовке окна изображения, где в 

скобках будет указана модель. 

 

Задание 2 Проконтролировать изменение цветов при переходе от 

модели RGB к модели CMYK. 

Порядок выполнения 

1. Открыть файл. 

2. Установить флажок Gamut Warning (Предупреждение о 

недопустимом цвете) в меню View (Вид). При этом другим цветом 

выделяются те области, которые при печати будут визуально отличаться от 

видимых на экране. 

 

Задание 3 Изменить цвет выделения 

Порядок выполнения 

1. Открыть файл. 

2. Использовать команду Edit > Preferences > Transparency & Gamut... 

(Редактирование > Установки > Прозрачность и Гамма (Цветовой охват). 

3. В появившемся диалоговом окне в группе Gamut Warning 

(Предупреждение о недопустимом цвете) щелкнуть по цвету в поле Color 

(Цвет), выбрать цвет, контрастный со всем изображением. Убедиться, что в 

поле Opacity (Непрозрачность) установлено 100%. 
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4. Отменить предупреждение об изменении цвета. Для этого 

использовать команду View (Вид) и снять флажок Gamut Warning 

(Предупреждение о недопустимом цвете). 

5. Создать копию изображения. Для этого использовать команду 

Image > Duplicate... (Изображение >Дубликат...). Разместить изображения 

рядом. Исходное изображение перевести в цветовую модель CMYK. Для 

этого использовать команду Image > Mode (Изображение > Режим) и 

установить флажок CMYK Color (CMYK цвет). Обратить внимание, что возле 

названия изображения в круглых скобках теперь указана модель CMYK. 

Сравнить два изображения. Обратить внимание, что краски на 

изображении в цветовой модели CMYK более тусклые, чем в модели RGB. 

Изображение готово к печати. 

 

Задание 4 Перевод изображения в градации серого и черно-белого 

цвета 

Порядок выполнения 

1. Открыть файл. 

2. Использовать команду Image > Mode (Изображение > Режим) и 

установить флажок Grayscale (Градации серого). В открывшемся диалоговом 

окне нажать кнопку ОК. Обратить внимание, что возле названия 

изображения в круглых скобках теперь указано Gray (Серый), что означает 

модель Grayscale (Градации серого). 

3. Перевести изображение в черно-белый вариант. Для этого 

использовать команду Image > Mode (Изображение>Режим) и установить 

флажок Bitmap... (Битовое изображение). В открывшемся диалоговом окне 

нажать кнопку ОК. 

Обратить внимание, что возле названия изображения в круглых 

скобках теперь указана модель Bitmap (Битовое изображение). 

Вернуться к исходному изображению. Для этого использовать команду 

File > Revert (Файл Вернуть). 
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Задание 5 Работа с индексированными цветами 

Порядок выполнения 

1. Открыть файл. 

2. Посмотреть размер документа. 

3. Уменьшить количество цветов в изображении. Для этого 

использовать команду Image > Mode (Изображение > Режим) и установить 

флажок Indexed Color... (Индексированные цвета...). 

В окне в поле Colors (Цвета) указано некоторое значение. Посмотреть, 

как изменится качество изображения. Не закрывать диалоговое окно. 

4. Поэкспериментировать с изображением, увеличивая и уменьшая 

количество цветов. Обратить внимание на изменение качества изображения. 

Количество цветов не может превышать 256. Установить количество цветов 

32 и нажать кнопку ОК. 

5. Посмотреть размер файла.  

6. Установить количество индексированных цветов 8. 

7. Изменить оценки цветов. Для этого использовать команду Image > 

Mode > Color Table... (Изображение > Режим > Цветовая таблица...) 

выбрав первый цвет, изменить параметры. Таким же образом изменить 

остальные цвета. 

 

Лабораторная работа 7. Средства тоновой и цветовой коррекции 

Цель: научиться использовать средства тоновой коррекции: 

Brightness/Contrast, Auto Levels, Levels, глобальную цветовую коррекциею, 

команду Color Balance, избирательную цветовую коррекцию, команду 

Hue/Saturation. 

Задание 1 Увеличение резкости и контрастности изображения 

Порядок выполнения 

1. Открыть файл. 
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2. Для увеличения контрастности изображения использовать команду 

Image > Adjustments > Brightness/Contrast... (Изображение > Регулировки > 

Яркость/Контрастность) 

3. Установить параметры в полях Brightness (Яркость), Contrast 

(Контрастность) соответствующие значения. 

 

Задание 2 Коррекция тонового диапазона изображения в 

автоматическом режиме 

Порядок выполнения 

1. Открыть файл. 

Обратить внимание, что исходное изображение тусклое. 

2. Выполнить настройку тонов на изображении. Для этого использовать 

команду Image > Adjustments > Auto Levels (Изображение > Регулировки> 

Автоуровни). 

 

Задание 3 Коррекция тонового диапазона изображения  при помощи 

гистограммы 

Справка: Тоновый диапазон изображения определяется 

распределением пикселов в темных, средних и светлых областях 

изображения. Гистограмма  это визуальное отображение того, как тона 

распределены на изображении. Горизонтальная ось гистограммы показывает 

распределение тонов между темными (слева) и светлыми (справа), а 

вертикальная ось показывает долю изображения в каждом из тонов. 

Порядок выполнения 

1. Открыть файл. 

2. Просмотреть тоновые интервалы изображения. Для этого сделать 

активной палитру Histogram (Гистограмма). Если на гистограмме видно, что 

в изображении отсутствуют самые темные тона, что и придает изображению 

блеклый вид. 
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3. Убрать из изображения область темных тонов, то есть растянуть 

тоновый диапазон. Для этого использовать команду Image > Adjustments > 

Levels... (Изображение > Регулировки > Уровни...). Установить флажок 

Preview (Просмотр) для того, чтобы можно было наблюдать за результатами 

коррекции. Переместить ползунок черного цвета до границы, где уже 

имеются пикселы. Нажать кнопку ОК. 

Обратить внимание, как изменился вид гистограммы. На гистограмме 

видно, что некоторые тона теперь совсем отсутствуют в изображении. Это 

результат растягивания тонового интервала. 

4. В открывшемся диалоговом окне сдвинуть белый ползунок влево до 

пикселов изображения. Нажать кнопку ОК. 

 

Задание 4 Коррекция цвета изображения в автоматическом режиме 

Порядок выполнения 

1. Открыть файл 

2. Откорректировать цвета. Для этого использовать команду Image > 

Adjustments > Auto Color (Изображение > Регулировки > Автоцвет). 

 

Задание 5 Выборочная коррекция цвета в изображении 

Порядок выполнения 

1. Открыть файл. 

2. Увеличить контрастность изображения. Для этого использовать 

команду Image > Adjustments > Auto Contrast (Изображение > Регулировки > 

Автоконтрастность). 

3. Сделать цвета объектов более насыщенными. Для этого использовать 

команду Image > Adjustments > Hue/Saturation... (Изображение > 

Регулировки > Тон/Насыщенность...).  

В открывшемся диалоговом окне в поле Edit (Редактирование) выбрать 

вариант нужного цвета и сдвинуть ползунок Saturation (Насыщенность) 
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вправо. При этом цвет на изображении станет более насыщенным. Выбрать 

следующий вариант цвета и также увеличить насыщенность. Нажать ОК.  

 

Задание 6 Коррекция цвета в изображении командой цветовой баланс 

Порядок выполнения 

1. Открыть файл. 

2. Изменить тоновый диапазон изображения при  команду Image > 

Adjustments > Auto Levels (Изображение > Регулировки  > Автоуровни). 

3. Использовать команду Image > Adjustments > Color Balance... 

(Изображение > Регулировки > Цветовой Баланс...). Изменить ползунки по 

цветам Cyan (Голубой), Green (Зеленый), Yellow (Желтый). 

Нажать кнопку ОК. 

 

Задание 7 Коррекция тонового диапазона неконтрастного изображения 

Порядок выполнения 

1. Открыть файл. 

2. Найти самое темное и самое светлое место на изображении.  

Для этого использовать команду Image > Adjustments > Threshold 

(Изображение > Регулировки > порог. Переместить единственный ползунок 

влево так, чтобы на изображении остались единичные черные точки. 

Запомнить эти места – это самые черные точки на изображении. Затем 

переместить ползунок вправо до того момента когда останутся единичные 

белые точки. Запомнить их. Закрыть окно, нажав на кнопку Cancel, 

3. Откорректировать уровни в изображении. Для этого  

использовать команду Image > Adjustments > Levels... (Изображение > 

Регулировки > уровни..) и в открывшемся диалоговом окне вручную 

установить черную и белую точки на изображения взять черную пипетку на 

нижней правой стороне окна и щелкнуть ею на самой черной точке 

изображения, затем взять белую пипетку и щелкнуть ею на самом белом 

месте изображения. Нажать кнопку ОК. 
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4. Повысить контрастность изображения. Для этого использовать 

команду Image > Adjustments > Brightness/Contrap... (Изображение > 

Регулировки > Яркость/Контрастность...) и установить следующие 

параметры: в поле Brightness (Яркость) и в поле Contrast (Контрастность). 

Нажать кнопку ОК. 

 

Лабораторная работа 8. Создание композиции: фотоколлаж 

Цель: научиться применять маску слоя. 

 

Задание 1. Создать изображение замерзшей реки с использованием 

маски слоя. 

Порядок выполнения 

1. Открыть файлы с зимним пейзажем и осенним пейзажем с рекой. 

2. Поместить изображение снежного пейзажа на изображение 

осеннего (рис. 76). 

3. Создать маску для слоя Layer 1. Для этого: 

а) создать область выделения вокруг реки; для удобства можно сделать 

прозрачность слоя Layer 1 равной 50%. 

 

  

Рисунок 76 – Исходные изображения 

 

б) сделать растушевку выделения, выполнив команду Select > Modify > 

Feather...(Выделение > Растушевать...) и в открывшемся диалоговом окне в 

поле Radius Feather (Радиус растушевки) установив значение 25; 
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в) добавить к осеннему пейзажу выделенный фрагмент зимнего, для 

этого использовать команду Layer > Add Layer Mask > Reveal Selection 

(Слой > Добавить маску слоя > Показать выделение); 

г) вернуть слою Layer 1 непрозрачность (61%). 

4. При необходимости, откорректировать расположение маски или 

рисунка в ней. Для этого разорвать связь между изображением и маской, 

выполнив щелчок на значке связи. После этого выполнить щелчок на 

миниатюре изображения и при помощи инструмента Move Tool 

(перемещение) передвинуть изображение снежного пейзажа внутри маски. 

Если выполнить щелчок на миниатюре маски, то перемещать можно саму 

маску по изображению осеннего леса. После того, как будет достигнут 

оптимальный результат, опять установить связь между маской и 

изображением. 

Для уменьшения размера готового файла маску можно удалить. Для 

этого, разорвав предварительно связь между маской и изображением, 

перетянуть изображение маски на изображение корзины в нижней части 

палитры Layers (Слои). В открывшемся диалоговом окне нажать на кнопку 

Apply (Применить). Обратить внимание, что размер файла при этом 

существенно уменьшился.  

5. Выполнить сведение слоев. Для этого использовать команду Layer > 

Flatten Image (Слой > Выполнить сведение). 

 

Задание 2. Добавить новых посетителей на выставку цветов 

Порядок выполнения 

1. Открыть файл с изображением выставки цветов (рис. 77). 
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Рисунок 77 – Выставка цветов 

 

2. Выделить первый ряд витрин при помощи инструмента Polygonal 

Lasso Tool (Многоугольное лассо). 

3. Подготовить маску для вставки фигур людей. Для этого: 

а) открыть палитру Channels (Каналы); 

б) создать новый канал, для этого вызвать меню нажатием 

треугольника в правом верхнем углу палитры, и использовать команду 

New channel... (Новый канал...), выбрать вариант Selected Areas 

(Выделенные области), нажать кнопку ОК. созданный канал Alpha 1 

сделать видимым, 

в) выполнить заливку выделенной области; 

г) убрать выделение; 

д) инвертировать изображение; для этого использовать команду 

Image > Adjustments > Invert (Изображение >Регулировки > 

Инвертировать) (рис. 78); 

 

  
Рисунок 78 – Каналы выделенных областей 

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



е) сделать активным канал RGB; 

ж) убрать видимость канала Alpha 1; 

4. Вставить изображение мальчика в подготовленную маску. Для этого:  

а) загрузить канал как выделение, перетянуть канал на кнопку 

Load channel as selection (Загрузить канал как выделение) и перейти на 

палитру Layers (Слои) (рис. 79). 

 

 
Рисунок 79 – Загрузка канала как выделение 

 

б) открыть файл (рис. 80). 

 

 
Рисунок 80 – Изображение мальчика 

 

в) выделить изображение мальчика и скопировать выделение в буфер 

обмена; 

г) сделать активным изображение с подготовленной маской; 

д) использовать команду Edit > Paste Into (Редактирование > 

Вставить в); 

е) откорректировать размер и положение изображения. 
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Лабораторная работа 9. Трансформации 

Цель: научиться создавать композицию с учетом перспективных 

сокращений. 

 

Задание 1. Создать арт-галерею 

Порядок выполнения 

1. Открыть файлы с изображением файл галереи с рамами для 

картин (рис 81). 

 

 
Рисунок 81 – Изображение галереи с рамами для картин 

2. Открыть сайт Gallerix.ru, сохранить изображения художников. 

3. Вставить изображения картин по слоям. 

4. Вписать в рамки для картин, используя команду трансформации 

Distort (Искажение). Перемещая каждый угол изображения картины 

совместить их с соответствующими углами рамы. 

 

Задание 2. Создать отражение на поверхности 

Порядок выполнения 

1. Открыть файлы с изображением столика и флакона (рис 82). 
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Рисунок 82 – Изображения столика и флакона 

 

2. Выделить флакон. Для этого волшебной палочкой выделить фон 

вокруг флакона. Для добавления выделения воспользоваться кнопкой на 

панели параметров инструмента Add to selection (Добавить к выделению).  

3. Инвертировать выделение, выбрав команду Select > lnverse 

(Выделение > Инвертировать). Окажется выделенным флакон. 

4. Полученное выделение скопировать в буфер обмена, выполнив 

команду Edit > Copy (Редактирование>Скопировать)  

5. Поместить флакон на стол, использовать команду Edit > Paste 

(Редактирование > Вставить). 

6. Переименовать слой, задав ему имя Флакон.  

7. Изменить размер флакона, выбрав свободную трансформацию 

(комбинация клавиш Ctrl+T).  

8. Разместить флакон по центру стола. 

9. Создать новый слой, в который поместить копию крышки стола. Для 

этого сначала выделить верхнюю крышку стола, а затем выполнить команду 

Layer > New > Layer via Сору (Слой > Новый > Слой через копирование).  

10. Дать название этому слою Крышка. 

11. Создать копию слоя с флаконом. Для этого, удерживая левую 

кнопку мыши на слое Флакон, перетащить его на пиктограмму нового слоя в 

нижней части палитры слоев.  

12. Назвать слой Отражение. 
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13. Отразить изображение по вертикали. 

14. Обрезать изображение флакона по краю крышки стола. Для этого 

выполнить группировку слоев и удерживая клавишу Alt, подвести указатель 

мыши к границе слоев Отражение и Крышка на палитре слоѐв, щелкнуть 

левой кнопкой мыши. 

15. Установить прозрачность слоя равной 40%. 

 

Тема 8. Компьютерная графика в веб-пространстве. 

Лабораторная работа 10. 

Цель: научиться применять онлайн графические редакторы для 

создания графических изображений. 

Задание. Создать рекламный плакат в графическом онлайн редакторе 

Canva. 

Порядок выполнения 

1. Загрузить редактор https://www.canva.com/ и войти в свой аккаунт. 

2. При нажатии СОЗДАТЬ выбрать необходимый шаблон или размер 

документа. 

Для выбора шаблона по тематике в строке поиска написать название 

интересующей тематики. Все изображения в этом онлайнсервисе с 

бесплатных файлообменников, поэтому можно пользоваться ими или 

загрузить свое (или копировать/вставить). 

3. Выбрать нужный шаблон (рис. 83). 
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Рисунок 83 − Шаблон для плаката 

 

 

4. Вставить изображение (критерий поиска ОНЛАЙН) 

5. Вставляем название и логотип кафедры (из файла методом 

перетягивания), затем копируем, вставляем и кадрируем рисунок с текстом 

online-offline (рис. 84). 

 
Рисунок 84 − Добавление изображения 
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6. Добавить и изменить текст из шаблона, логотип университета и т. п. 

При необходимости можно менять прозрачность изображений и 

фона (рис. 85). 

 
 

 
Рисунок 85 − Изменение прозрачности объекта 

 
 
7.  Добавить текст (рис. 86). 
 

 
Рисунок 86 − Добавление текста 

 
8. Скачать изображение в формате PNG. 
 
9. Создать приглашение на выставку своих работ 
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4. РАЗДЕЛ КОНТРОЛЯ ЗНАНИЙ 

4.1 Задания для контролируемой самостоятельной работы 

студентов 

Самостоятельная работа студентов направлена на совершенствование 

их умений и навыков по дисциплине «Дизайн и компьютерные технологии в 

декоративно-прикладном искусстве». Цель самостоятельной работы 

студентов состоит в создании условий для усвоения в полном объеме 

учебного материала дисциплины через систематизацию, планирование и 

контроль собственной деятельности. Преподаватель дает задания для 

самостоятельной работы и регулярно проверяет их исполнение. 

Содержание и формы контролируемой самостоятельной работы 

студентов рекомендуется связывать с использованием метода проектов, что 

позволяет реализовывать индивидуальный подход к обучению. В ходе 

работы над проектами студенты углубляются в предметную область. 

В результате каждый студент создает в процессе самостоятельной работы 

несколько проектов под руководством преподавателя. Такая организация 

работы способствует развитию как информационной, так и 

профессиональной компетенции. 

Задание 1. Создать цифровую модель изделия декоративно-

прикладного искусства. 

Задание 2. Вписать созданную цифровую модель изделия декоративно-

прикладного искусства в интерьер. 

 

Вопросы по темам 

 

Тема 1. Дизайн как художественно-проектная деятельность. 

Научно-культурные направления дизайна. 

Художественное проектирование.  

Виды дизайна.  

История и направления дизайна.  

РЕ
ПО
ЗИ
ТО
РИ
Й БГ

УК
И



Протодизайн и технология.  

Ремесло и функциональные факторы.  

Промышленная революция.  

Авангардное искусство ХХ века.  
 

Тема 2 Стиль. Историческая база стилевой классификации 

Общие признаки стиля.  

Характеристика исторических стилей Древнего Египта. 

Характеристика исторических стилей античности. 

Характеристика исторических стилей в Средние века. 

Характеристика исторических стилей в  эпоху Возрождения. 

Стиль барокко.  

Стили классицизма, историзма, постмодернизма. 

Стили современного искусства. 

 

Тема 3 Приемы получения изображений в графическом дизайне 

Средства визуального языка (точка, линя, пятно).  

Абстрактные композиции на модульной основе.  

Иллюзорное восприятие формы (Вазарелли, Эшер).  

Оптические иллюзии (оп-арт, имп-арт).  

Формообразование, пропорции, цветовые предпочтения.  

Построение орнамента.  

Стилизация.  

Функциональные свойства цвета в графическом дизайне. 

 

Тема 4 Теоретические основы компьютерной графики и 

геометрического моделирования 

Понятие геометрической модели.  

Сплайны. Виды сплайнов: линейный, квадратичный, кубический, 

Безье, NURBS. 
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Фрактальная графика.  

Бенуа Мандельброт.  

Классификация фракталов: геометрические, алгебраические, 

стохастические фракталы.  

Фрактальная живопись. 

Сравнительный анализ подходов к редактированию векторной и 

растровой графики.  
 

Тема 5. Цифровое искусство 

Понятие цифрового искусства.  

История компьютерной графики.  

3D-моделирование и визуализация.  

Цифровой коллаж.  

Цифровая живопись. 

Фрактальная графика.  

Компьютерная анимация.  

Синергетичные направления цифрового искусства: демосцена, 

компьютерный перформанс, 3D-мэпинг. 

Электронная фиксация произведений искусства: особенности и 

технологии.  

Изображения с высоким динамическим диапазоном (HDRI). Форматы 

HDRI. Цифровая иллюстрация.  

История и виды цифровой иллюстрации.  

Сферы применения и специфика цифровой иллюстрации. 

 

Тема 6. Создание композиций 

Инструменты и приемы создания выделенных областей.  

Типы выделенных областей.  

Выделенные области геометрической формы.  

Цветовые выделенные области.  
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Работа в режиме быстрой маски.  

Работа с инструментом Pen.  

Комбинирование контуров и выделенных областей.  

Перемещение каналов и выделенных областей.  

Выделение мелких деталей.  

Типы масок: маска слоя, обтравочная маска, векторная маска. Альфа-

каналы. 

Виды композиции: фронтальная, объемная и пространственная. 

Принципы построения композиции.  

Правила, приемы и средства композиции.  

Типы композиции: сюжетно-изобразительная, декоративно-

тематическая, предметных форм и формальная.  

Фотореалистичные изображения.  

Подготовка элементов изображения.  

Работа с режимами наложения. Режимы смешения слоев. Режим Screen. 

Масштабирование с минимальными потерями.  

 

Тема 7. Цифровое изображение. Тоновая и цветовая коррекция 

Способы получения цифровых изображений.  

Цифровая фотография: студийная и экстерьерная съемка.  

Визуализация цифрового изображения.  

Входные и выходные характеристики изображения: линейный размер, 

входное и выходное разрешение изображения. 

Цветовые простанства Bitmap, Greyscale, Duotone, Index, RGB, CMYK, 

HSB, Lab.  

Преобразование цветовых пространств. 

Предварительный анализ изображения. Гистограмма и цветовая проба 

как средства анализа. 

Уменьшение эффекта цифрового шума. Сглаживание цветовых 

переходов. Устранение эффекта «красных глаз». 
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Корректирующие слои. Глобальная и локальная коррекция 

изображения. 

Тоновая и цветовая коррекция изображения.  

Тоновый диапазон изображения. Команда Histogram. 

Средства тоновой коррекции: Brightness/Contrast, Auto Levels, Levels.  

Коррекция с помощью градационных кривых.  

Команда Curves.  

Команда Hue/Saturation. 

Команда Color Balance.  

Глобальная цветовая коррекция.  

Избирательная цветовая коррекция.  

Многоканальная цветовая коррекция. Ключевой канал в 

цветокоррекции.  

Особенности коррекции в CMYK и в Lab.  

Регулировка цветового баланса фотографий.  

Тонирование изображений цветом. 

Улучшение контраста слиянием каналов.  

Методы повышения резкости. Нерезкое маскирование.  

Проявление и сохранение деталей в тенях в наиболее важных областях 

изображения.  

Приемы восстановления, реставрации и перекомпоновки.  
 

Тема 8. Компьютерная графика в веб-пространстве. 

Ресурсы компьютерной графики в Интернете.  

Веб-графика: особенности и ограничения.  

Виды вебграфики: визуал, фоновая, навигационная, логотип, фовикон, 

банер.  

Форматы графических изображений в Интернете.  

Системы представления цвета в Интернете. 

Веб-анимация.  
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Флэш- и gif-технологии.  

Оптимизация размера графического файла.  

Разрезание изображения. Изображения-карты. 

Поиск графической информации в Интернете. Профессиональные 

ресурсы компьютерной графики в Интернете.  

Ресурсы изобразительного искусства в Интернете.  

Базы репродукций произведений искусства. 

 

Вопросы к итоговому контролю 

1. Научно-культурные направления дизайна. 

2. Художественное проектирование.  

3. Виды дизайна.  

4. История и направления дизайна.  

5. Протодизайн и технология.  

6. Ремесло и функциональные факторы.  

7. Промышленная революция.  

8. Авангардное искусство ХХ века.  

9. Характеристика исторических стилей Древнего Египта. 

10. Характеристика исторических стилей античности. 

11 Характеристика исторических стилей в Средние века. 

12. Характеристика исторических стилей в  эпоху Возрождения. 

13. Стиль барокко.  

14. Стили классицизма, историзма, постмодернизма. 

15. Стили современного искусства. 

16. Средства визуального языка (точка, линя, пятно).  

17. Абстрактные композиции на модульной основе.  

18. Иллюзорное восприятие формы (Вазарелли, Эшер).  

19. Оптические иллюзии (оп-арт, имп-арт).  

20. Формообразование, пропорции, цветовые предпочтения.  

21. Построение орнамента.  
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22. Стилизация.  

23. Функциональные свойства цвета в графическом дизайне. 

24. Понятие геометрической модели.  

25. Сплайны. Виды сплайнов: линейный, квадратичный, кубический, 

Безье, NURBS. 

26. Фрактальная графика.  

27. Бенуа Мандельброт.  

28. Классификация фракталов: геометрические, алгебраические, 

стохастические фракталы.  

29. Фрактальная живопись. 

30.Сравнительный анализ подходов к редактированию векторной и 

растровой графики.  

31. Понятие цифрового искусства.  

32. История компьютерной графики.  

33. 3D-моделирование и визуализация.  

34. Цифровой коллаж.  

35. Цифровая живопись. 

36. Фрактальная графика.  

37. Компьютерная анимация.  

38. Синергетичные направления цифрового искусства: демосцена, 

компьютерный перформанс, 3D-мэпинг. 

39. Электронная фиксация произведений искусства: особенности и 

технологии.  

40. Изображения с высоким динамическим диапазоном (HDRI). 

Форматы HDRI. Цифровая иллюстрация.  

41.История и виды цифровой иллюстрации.  

42. Сферы применения и специфика цифровой иллюстрации. 

43. Инструменты и приемы создания выделенных областей.  

44. Типы выделенных областей.  

45. Выделенные области геометрической формы.  
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46. Цветовые выделенные области.  

47. Работа в режиме быстрой маски.  

48. Комбинирование контуров и выделенных областей.  

49. Перемещение каналов и выделенных областей.  

50. Выделение мелких деталей.  

51. Типы масок: маска слоя, обтравочная маска, векторная маска. 

Альфа-каналы. 

52. Виды композиции: фронтальная, объемная и пространственная. 

53. Принципы построения композиции.  

54. Правила, приемы и средства композиции.  

55. Типы композиции: сюжетно-изобразительная, декоративно-

тематическая, предметных форм и формальная.  

56. Фотореалистичные изображения.  

57. Подготовка элементов изображения.  

58. Режимы смешения слоев. Режим Screen. 

59. Способы получения цифровых изображений.  

60. Цифровая фотография: студийная и экстерьерная съемка.  

61. Визуализация цифрового изображения.  

62. Входные и выходные характеристики изображения: линейный 

размер, входное и выходное разрешение изображения. 

63. Цветовые пространства. 

64. Тоновая и цветовая коррекция изображения.  

65. Методы повышения резкости. Нерезкое маскирование.  

66. Веб-графика: особенности и ограничения.  

67. Виды вебграфики:  

68. Форматы графических изображений в Интернете.  

69. Веб-анимация.  

70. Поиск графической информации в Интернете. 
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5. ВСПОМОГАТЕЛЬНЫЙ РАЗДЕЛ 

5.1 Учебная программа 
 

ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 

Дисциплина «Дизайн и компьютерные технологии в декоративно-

прикладном искусстве» в системе знаний, нужных для обучения будущего 

художника-реставратора, объясняется рядом объективных и субъективных 

факторов. В числе объективных факторов следует отметить: характерный для 

современной школы недостаток проектных знаний. К субъективным 

факторам стоит отнести уникальность профессии художника-реставратора, 

профессиональная область деятельности которого включает в себя вид 

творческой деятельности, объединяющий достижения декоративного 

искусства, конструирования, технологии, в отм числе компьютерных. 

Данный вид творческой деятельности направлен на создание эстетически 

совершенных и высококачественных уникальных предметов и изделий из 

различных материалов. Художник декоративно-прикладного искусства в 

профессиональной деятельности выполняет аналитическую, проектную, 

экспериментально-исследовательскую, производственную, управленческую, 

педагогическую и другие виды профессиональной деятельности, используя 

для автоматизации своего труда компьютерные технологии. Дисциплина 

«Дизайн и компьютерные технологии в декоративно-прикладном искусстве» 

формирует тоеретические основы и практические навыки, которыми должы 

овладеть выпускники в соответствии с образовательным стандартом 

специальности.  

Дисциплина логически связана с дисциплинами «Основы 

информационных технологий», «Введение в специальность и 

информационная культура специалиста», «Перспектива», «Цветоведение», 

«Композиция», «Дизайн», «Проектирование» и другими. 

Цель дисциплины «Дизайн и компьютерные технологии в декоративно-

прикладном искусстве» состоит в освоении инструментария компьютерных 
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технологий в визуализации творческих решений и художественной 

образности мышления. 

Целевая направленность дисциплины обуславливает решение 

следующих задач: 

– формирование базовых знаний в области информационных 

технологий и автоматизированных информационных систем, применяемых в 

дизайне графического продукта; 

– обобщение знаний об использовании компьютерной графики в 

искусстве; 

– формирование умений применять компьютерные программы при 

разработке модели декоративного изделия. 

В результате изучения дисциплины студенты должны знать: 

– актуальные компьютерные средства развития и выражения 

дизайнерского замысла; 

– основные понятия и концепции геометрического моделирования и 

компьютерной графики; 

– особенности использования программных средств обработки 

графической информации в дизайне; 

– виды и особенности компьютерной графики по способам задания 

изображений; 

– специфику работы с растровой и векторной графикой; 

– состав конфигурации персонального компьютера для обработки 

статической и динамической графики; 

– состав, функции и назначение программного обеспечения для 

обработки графической информации; 

– основные характеристики изображения; 

– характеристики цветовых пространств; 

– принципы и этапы тоновой и цветовой коррекции; 

– особенности подготовки графических изображений для сети 

Интернет. 
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Студент должен уметь: 

– анализировать графическое изображение; 

– обрабатывать цифровые фотографии; 

– использовать различные технологии работы в программах растровой 

и векторной графики и уметь интегрировано применять их для решения 

конкретных задач; 

– выполнять тоновую и цветовую коррекцию изображений; 

– работать с периферийным оборудованием; 

– выполнять допечатную подготовку графических изображений; 

– работать с графическими ресурсами локальных и глобальных 

компьютерных сетей, использовать сетевые средства поиска и обмена 

графической информацией. 

Студент должен владеть: 

– техническими и программными средствами создания компьютерной 

графики; 

– методами и инструментами обработки цифровых изображений; 

– технологией ретуши изображений в зависимости от области 

применения. 

Содержание учебной дисциплины согласно требованиям 

образовательного стандарта направлено на формирование компетенций   

Основными методами обучения, отвечающими целям изучения 

дисциплины, являются: элементы проблемного обучения, реализуемые на 

лекционных занятиях; элементы учебно-исследовательской деятельности, 

творческого подхода, реализуемые на практических (или лабораторных) 

занятиях и при самостоятельной работе; коммуникативные технологии 

(дискуссия, учебные дебаты), реализуемые на практических занятиях; 

проектные технологии, используемые при проектировании конкретного 

объекта, реализуемые при выполнении самостоятельной работы. 

При изучении дисциплины используются следующие формы 

самостоятельной работы: контролируемая самостоятельная работа в виде 
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решения индивидуальных задач в аудитории во время проведения 

практических занятий под контролем преподавателя в соответствии с 

расписанием; управляемая самостоятельная работа, в том числе в виде 

выполнения индивидуальных заданий с консультациями преподавателя; 

подготовка презентаций по индивидуальным темам. 

Согласно типовому учебному плану на изучение дисциплины отведено 

всего 68 часов, в том числе – 42 часа аудиторных занятий. Примерное 

распределение аудиторных часов по видам занятий: лекции – 10 часов, 

практические занятия – 10 часов, 20 часов – лабораторные работы. 

Итоговая форма контроля – зачет. 
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СОДЕРЖАНИЕ ДИСЦИПЛИНЫ 
 

Тема 1. Дизайн как художественно-проектная деятельность. 

Научно-культурные направления дизайна: техническая эстетика, 

художественное проектирование, художественное конструирование. 

Сущность художественно-проектной деятельности. Алгоритм дизайна. Виды 

дизайна. История и направления дизайна. Протодизайн и технология. 

Ремесло и функциональные факторы. Промышленная революция. 

Авангардное искусство ХХ века. Конструктивизм. Модернизм. 
 

Тема 2 Стиль. Историческая база стилевой классификации 

Общие признаки стиля. Характеристика исторических стилей: Древний 

Египет, античность, Средние века, Возрождение, барокко, классицизм, 

историзм, постмодернизм, стили современного искусства. 

 

Тема 3 Приемы получения изображений в графическом дизайне 

Средства визуального языка (точка, линя, пятно). Абстрактные 

композиции на модульной основе. Принципы построения, виды (раппорт, 

акцент, контраст, движение, орнамент), применение. Иллюзорное восприятие 

формы (Вазарелли, Эшер). Оптические иллюзии (оп-арт, имп-арт). 

Формообразование, пропорции, цветовые предпочтения. Построение 

объемно-пространственного изображения. Получение изображений на основе 

фотоматериалов (фотоколлаж, фотомонтаж). Орнамент. Стилизация. 

Функциональные свойства цвета в графическом дизайне. 

 

Тема 4 Теоретические основы компьютерной графики и 

геометрического моделирования 

Геометрическое моделирование как основа компьютерной графики. 

Геометрическая модель. Математическая форма представления 
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геометрических элементов: явное задание, неявное задание, параметрическое 

задание, геометрическое и матричное представление. 

Сплайны. Опорные точки сплайна. Типы вершин сплайна: с изломом, 

сглаженная, Безье, Безье с изломом. Виды сплайнов: линейный, 

квадратичный, кубический, Безье, NURBS. 

Фрактальная графика. Бенуа Мандельброт. Самоподобие. 

Классификация фракталов: геометрические, алгебраические, стохастические 

фракталы. Фрактальная живопись. 

Графические редакторы. Сравнительный анализ подходов к 

редактированию векторной и растровой графики. Конфигурация компьютера 

для работы с компьютерной графикой. Видеокарты. Мониторы. Графические 

планшеты. 

 

Тема 5. Цифровое искусство 

Понятие цифрового искусства. История компьютерной графики. 

Направления компьютерной графики: 3D-моделирование и визуализация, 

цифровой коллаж, цифровая живопись, фрактальная графика, компьютерная 

анимация. Синергетичные направления цифрового искусства: демосцена, 

компьютерный перформанс, 3D-мэпинг. 

Компьютерная графика как инструментарий традиционных видов 

искусств (архитектуры и скульптуры, кино и мультипликации, музыки, 

театра и др.). Электронная фиксация произведений искусства: особенности и 

технологии. Изображения с высоким динамическим диапазоном (HDRI). 

Форматы HDRI. Цифровая иллюстрация. История и виды цифровой 

иллюстрации. Сферы применения и специфика цифровой иллюстрации. 

 

Тема 6. Создание композиций 

Инструменты и приемы создания выделенных областей. 

Профессиональные приемы выделения. Типы выделенных областей. 

Выделенные области геометрической формы. Цветовые выделенные области. 
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Работа в режиме быстрой маски. Контуры. Работа с инструментом Pen. 

Комбинирование контуров и выделенных областей. Перемещение каналов и 

выделенных областей. Выделение мелких деталей.  

Маскирование слоев. Типы масок: маска слоя, обтравочная маска, 

векторная маска. Альфа-каналы. 

Теория композиции. Виды композиции: фронтальная, объемная и 

пространственная. Принципы построения композиции. Правила, приемы и 

средства композиции. Типы композиции: сюжетно-изобразительная, 

декоративно-тематическая, предметных форм и формальная. Области 

применения. Фотореалистичные изображения.  

Подготовка элементов изображения. Согласование перспективы. 

Гармонизация света и теней. Согласование цвета. Подчеркивание фокуса и 

атмосферы. 

Основы комбинирования изображений. Работа с режимами наложения. 

Режимы смешения слоев. Режим Screen. 

Масштабирование с минимальными потерями. Автоматизация работы. 

Создание авторского проекта. Разработка целостной эстетической 

концепции, реализуемой инструментарием векторной, растровой графики и 

анимацией. Этапы разработки проекта. 

Освоение традиционных методик живописи и графики и 

транспонирование их в компьютерные творческие технологии. 

Специальные приемы создания и использования векторной 

компьютерной графики. Методы использования преимуществ векторной 

графики в создании модели предмета декоративно-прикладного искусства. 

 

Тема 7. Цифровое изображение. Тоновая и цветовая коррекция 

Природа цифрового изображения. Способы получения цифровых 

изображений. Цифровая фотография: студийная и экстерьерная съемка. 

Визуализация цифрового изображения. Входные и выходные характеристики 
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изображения: линейный размер, входное и выходное разрешение 

изображения. 

Цветовые простанства Bitmap, Greyscale, Duotone, Index, RGB, CMYK, 

HSB, Lab. Их назначение. Преобразование цветовых пространств. Глубина 

цвета.  

Предварительный анализ изображения. Гистограмма и цветовая проба 

как средства анализа. Этапы обработки фотографий. Уменьшение эффекта 

цифрового шума. Сглаживание цветовых переходов. Устранение эффекта 

«красных глаз». 

Понятие коррекции. Корректирующие слои. Глобальная и локальная 

коррекция изображения. 

Тоновая и цветовая коррекция изображения. Тоновый диапазон 

изображения. Команда Histogram. Средства тоновой коррекции: 

Brightness/Contrast, Auto Levels, Levels. Коррекция с помощью градационных 

кривых. Команда Curves. Глобальная цветовая коррекция. Команда Color 

Balance. Избирательная цветовая коррекция. Команда Hue/Saturation. 

Многоканальная цветовая коррекция. Ключевой канал в 

цветокоррекции. Особенности коррекции в CMYK и в Lab. Регулировка 

цветового баланса фотографий. Тонирование изображений цветом. 

Контраст. Улучшение контраста слиянием каналов. Резкость. Методы 

повышения резкости. Нерезкое маскирование. Проявление и сохранение 

деталей в тенях в наиболее важных областях изображения. Ретушь. Приемы 

восстановления, реставрации и перекомпоновки. Ретуширование портретов. 

Работа с изображениями текстур. 

 

Тема 8. Компьютерная графика в веб-пространстве. 

Ресурсы компьютерной графики в Интернете. Веб-графика: 

особенности и ограничения. Виды вебграфики: визуал, фоновая, 

навигационная, логотип, фовикон, банер. Форматы графических 
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изображений в Интернете. Системы представления цвета в Интернете 

(Цветовые модели. Базовые цвета). 

Веб-анимация. Флэш- и gif-технологии. Подготовка графических 

изображений для публикации (размещения) в сети Интернет. Оптимизация 

размера графического файла. Разрезание изображения. Изображения-карты. 

Поиск графической информации в Интернете. Профессиональные 

ресурсы компьютерной графики в Интернете: фасетные базы данных 

графических изображений и 3D-моделей, фотобанки, форумы, веб-сервисы. 

Ресурсы изобразительного искусства в Интернете. Базы репродукций 

произведений искусства. 
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УЧЕБНО-МЕТОДИЧЕСКИЕ КАРТЫ УЧЕБНОЙ 

ДИСЦИПЛИНЫ ДЛЯ ДНЕВНОЙ И ЗАОЧНОЙ ФОРМЫ ПОЛУЧЕНИЯ 

ВЫСШЕГО ОБРАЗОВАНИЯ 

 

Для дневной формы 
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ы
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1.  Тема 1. Дизайн как художественно-
проектная деятельность. 

2     

2.  Тема 2 Стиль. Историческая база 
стилевой классификации 

2 2    

3.  Тема 3 Приемы получения 
изображений в графическом дизайне 

2 2    

4.  Тема 4 Теоретические основы 
компьютерной графики и 
геометрического моделирования 

2 2    

5.  Тема 5. Цифровое искусство. 2 2    
6.  Тема 6. Создание композиций  2 10   
7.  Тема 7. Цифровое изображение. 

Тоновая и цветовая коррекция 
  8 2 проект 

8.  Тема 8. Компьютерная графика в 
веб-пространстве. 

  2 2 проект 

 Итого 10 10 20 4 зачет 
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Для заочной формы 
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9.  Тема 1. Дизайн как художественно-
проектная деятельность. 

2     

10.  Тема 2 Стиль. Историческая база 
стилевой классификации 

     

11.  Тема 3 Приемы получения 
изображений в графическом дизайне 

     

12.  Тема 4 Теоретические основы 
компьютерной графики и 
геометрического моделирования 

2     

13.  Тема 5. Цифровое искусство. 2 1    
14.  Тема 6. Создание композиций  1 2   
15.  Тема 7. Цифровое изображение. 

Тоновая и цветовая коррекция 
  2 2 проект 

16.  Тема 8. Компьютерная графика в 
веб-пространстве. 

  2 2 проект 

 Итого 10 2 6 4 зачет 
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ИНФОРМАЦИОННО-МЕТОДИЧЕСКАЯ ЧАСТЬ 
 

Критерии оценки результатов учебной деятельности студентов.  

Методические рекомендации по организации и выполнению  

самостоятельной работы студентов по учебной дисциплине 

 

При изучении дисциплины «Дизайн и компьютерные технологии в 

декоративно-прикладном искусстве» используются следующие формы 

самостоятельной работы: 

– контролируемая самостоятельная работа в виде решения 

индивидуальных задач в аудитории во время проведения лабораторных 

занятий под контролем преподавателя в соответствии с расписанием; 

– управляемая самостоятельная работа, в том числе в виде выполнения 

индивидуальных заданий с консультациями преподавателя; 

– подготовка рефератов и презентаций по индивидуальным темам. 

Оценка уровня знаний студента производится по десятибалльной системе. 

Для оценки достижений студента рекомендуется использовать следующий 

диагностический инструментарий: 

– устный опрос во время практических занятий; 

– проведение текущих контрольных работ (заданий) по отдельным темам; 

– защита выполненных на практических занятиях индивидуальных 

заданий; 

– защита выполненных в рамках управляемой самостоятельной работы 

индивидуальных заданий; 

– выступление студента на конференции по подготовленному реферату; 

– защита индивидуальной работы; 

– сдача зачета или экзамена по дисциплине. 
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Критерии оценки уровня знаний и умений студентов 

 

10 – самостоятельное, свободное, последовательное раскрытие темы 

(вопроса), подкрепленное ссылками на несколько источников. Широкое 

владение терминологией. Собственный, аргументированный взгляд на 

затронутые проблемы. Предоставление тезисов. Систематизация знаний, 

умений, навыков в сфере обработки информации (своевременное выполнение 

всех заданий практического характера). Проявление интереса к участию в 

коммуникационных мероприятиях образовательного и развивающего 

характера. 

9 – свободное изложение содержания темы (вопроса), основанное на 

привлечении не менее трех источников, комментарии и выводы. 

Последовательность и четкость изложенного материала. Широкое владение 

терминологией. Систематизация знаний, умений, навыков в сфере обработки 

информации (своевременное выполнение всех заданий практического 

характера). Проявление интереса к проектным задачам развивающего 

характера. 

8 – то же, что и выше. Некоторая незавершенность аргументации при 

изложении, которая требует уточнения теоретических позиций. Простое 

выполнение задач высокой сложности, систематическое обновление 

усвоенных знаний, умений, навыков в сфере обработки информации 

(выполнение почти всех заданий практического характера). 

7 – понимание сути темы (вопроса), грамотное, но недостаточно полное 

изложение содержания. Отсутствие собственных оценок. Использование 

терминологии (выполнение большей части заданий практического 

характера). 

6 – понимание сути темы (вопроса), изложение содержания не полное, 

требующее дополнительных пояснений. Отсутствие собственных оценок. 

Неточности в терминологии (выполнение половины заданий практического 

характера). 
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5 – поверхностная проработка темы (вопроса), неумение последовательно 

построить устное сообщение, не владение терминологией. Недостаточная 

активность в приобретении и применении знаний в области обработки 

информации (выполнение некоторых заданий практического характера). 

4 – низкий познавательный интерес к деятельности, связанной с 

обработкой информации, поверхностная проработка темы (вопроса), наличие 

некоторых погрешностей при ответе, пробелы в раскрытии содержания, не 

владение терминологией (выполнение меньшей части заданий практического 

характера). 

3 и 2 – отсутствие знаний по значительной части основного учебно- 

программного материала. Низкий познавательный интерес к деятельности по 

обработке информации. Несознательность в освоении знаний, умений, 

навыков и неготовность к их применению на практике (не выполнение 

заданий практического характера). 

1 балл – нет ответа (отказ от ответа, невыполнение предусмотренных 

заданий практического характера). 

Для выставления зачетной оценки с учетом выполненных лабораторных 

работ и самостоятельных заданий считать достаточным уровни с баллами от 

10 до 4. 
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